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1 Introduction 
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vConverter™ is a powerful software tool that converts a Windows® operating system 
(OS) running on a physical machine to a guest OS running on a virtual machine (VM). 

 

2BVirtualization and VMware Overview 

As companies and industries grow, their technology needs change. These changes are 
often implemented within complex systems running business-critical applications. 
Usually there is an increased demand for shared hardware and software resources. To 
manage this demand, many companies establish virtual environments. Doing so can 
increase an organization’s agility and efficiency while lowering its costs. 

Most companies have a number of specialized physical servers and workstations that are 
underutilized. Virtualizing such an environment increases and balances utilization by 
consolidating the physical machines into a single physical host that runs multiple VMs. 
The VMs share the resources—processor, memory, network cards, and disks—of the 
physical host. The work that the physical machines did previously continues, but with 
greater efficiency. The host runs a layer of virtualization software that manages the 
environment. Each VM’s OS—usually Windows or Linux—functions as if the hardware 
were physical. Guest software can see only x processor, y memory, and so forth. 
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The transition from physical to virtual is seamless. A virtual infrastructure affords 
maximum flexibility, allowing you to treat VMs as if they were physical hardware and 
software. VMs can be moved easily between hosts. They can be run in isolation or in 
groups. Their workloads can be reconfigured as demand requires. This flexibility is 
supported by management tools.  

VMware VirtualCenter (VC) and ESX Server are, respectively, the management server 
and software components that lend order in a virtual environment. VC orchestrates the 
configuring and provisioning. VC’s database stores all of the information shared between 
the physical hosts and the VMs. Without compromising security, VC makes it possible to 
connect to a host remotely from a standard Windows computer. 

As its own host OS, ESX Server allows you to establish VMs, configure and manage 
their shared resources, and make ongoing adjustments to increase performance. Each VM 
is configured with its own virtual hardware—for example, central processing unit (CPU), 
random access memory (RAM), and universal serial bus (USB) ports. The work of the 
VM’s physical counterpart is run in its native OS. Because VMs require neither 
redundant hardware nor physical space, virtualization can mean significant cost savings. 

 

 

3BvConverter Overview 

vConverter is an enterprise-level consolidation/migration application that is task based. It 
allows you to capture a live physical or virtual Windows system and transfer its data 
directly to a Windows shared folder, Xen™, Virtual Iron™, or ESX host. vConverter’s 
physical to virtual (P2V) and virtual to virtual (V2V) approaches ensure consistent 
results: The converted image will mirror the source. There is no additional software to 
install on the source. Nor are any helper components required. You need not be present at 
the source during the conversion process. Both physical and virtual machines can be used 
as the source, but only a VM can be a target.  

With vConverter, configuration is easy—from creating target VMs to controlling services 
on the source. Many processes are automated, including installation of VMware/Xen 
Tools, powering off and on source and target, and registering VMs. 

Use vConverter to complete individual or multiple conversions immediately or to 
schedule them. Run conversion jobs from a client machine or from a Command Line 
Interface (CLI). Resize volumes at the target—to be larger or smaller than they were on 
the source. vConverter automatically limits the resize to accommodate the existing source 
data.  

A single Virtual Machine Disk Format (VMDK) can hold all source volumes or you can 
create individual files to hold each volume. You can configure separate locations for each 
volume. For ESX, VC aligns the partitions on the 64k boundary.  

By specifying alternative folder locations for each volume, you can balance the VMDK 
workload across multiple Virtual Machine File System (VMFS) volumes and multiple 
storage paths.   
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The virtual hard disk drive formats supported in vConverter are VMDK files used by 
VMware, and virtual hard disk (VHD) files used by Microsoft, Xen, and Virtual Iron. 

17BRemote Cold Cloning 
There are two ways to clone a server—hot cloning and cold cloning. During the hot 
cloning process, the server OS continues to run. That is, it is not rebooted during or after 
a conversion. Cold cloning requires a reboot of the source into VC’s boot image. During 
cold cloning, there is less chance of data corruption mainly because no data files are 
opened.  

When you select Remote Cold Cloning (RCC) as the conversion type, VC sends a boot 
loader and its boot image over the network to a source. This source boots at a time that 
you designate, and the conversion begins. RCC is a good option for converting 
transactional systems such as database and email servers.  

18BContinuous Protection 
You can protect datacenter workloads by addressing disaster recovery (DR) through 
virtualization. Taking a P2V approach, vConverter preserves a virtual backup copy of a 
physical machine. When you select Continuous Protection as the conversion type, 
incremental replication is used. During this process, network usage is minimized because 
only changes to source data files are transferred to the target. You define the intervals at 
which these transfers occur. You can change target locations between protection 
intervals. The physical server remains protected while you use its duplicate virtual 
standby copy. Continuous Protection uses a hot cloning method. 

19BSynchronized Cutover  
A cutover is the process of switching from the source VM to the target VM. A cutover 
window is the period of time on a specific date (or span of dates) when it is acceptable to 
perform cutover. Pre-synchronized cutover occurs after the initial copying phase of the 
conversion, when any remaining changes to the source are copied to the target and 
committed.  

Synchronized Cutover allows you to minimize the cutover window by completing a P2V 
conversion and synchronizing changes on the source to the target at specified intervals 
(for example, every 15 minutes). This means that before you initiate a cutover with the 
final synchronization, you can move the majority of data from source to target and test 
the target workload while continuing to run the source. Synchronized Cutover gives you 
complete protection across local area networks (LANs) and wide area networks (WANs). 
Synchronized Cutover uses the hot cloning method for initial and subsequent 
synchronizations. While cold cloning is used for the final synchronization, you can also 
trigger a hot (live) final synchronization.  
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20BDifferent Destinations Cutover  
When your initial and final targets are different, select Different Destinations Cutover 
(DDC) as the conversion type. The initial P2V event will target the first destination. The 
VM can be moved to the second destination. Then, the initial P2V event can be modified 
to allow the final synchronization to retarget the VM. 

21BRaw Device Mapping 
Raw Device Mapping (RDM) is a file in a separate VMFS volume that acts as a proxy for 
a raw physical device. An RDM provides a VM with direct access to a logical unit 
number (LUN) on a fiber channel or iSCSI physical storage system. With P2V to RDM, 
all source volumes to be converted are placed on a single device. Typically, an RDM is 
useful for utilizing Storage Area Network (SAN) software for replication and snapshots. 
Input/Output (I/O) improves because multiple servers need not read and write to a LUN; 
only a VM with access to RDM will do so. 

22BVirtual Appliance for VMware ESXi 3.5 and Xen Embedded 
Virtual Appliance (VA) replaces the console operating system (COS) environment. VA is 
a custom VM that can create and remove virtual disks as well as mount and unmount 
them. It can also create partitions and write data. VA features a preinstalled and pre-
configured environment with all the necessary configurations for conversion. There is no 
need to install an agent on the target server.   

For ESXi 3.5, VA allows you to skip installation of an agent to COS. For Xen Embedded, 
VA can be run in para- or full-virtualization modes. 

23BUser Profiles 
Through the fields on vConverter’s User Profiles tab you can create one set of credentials 
to use with multiple source servers. You can create distinct profiles for each system and 
save them for later use.  

24BTask Profiles 
The fields on the Task Profiles tab help you increase multi-conversion process efficiency 
by allowing you to configure a conversion once and save the settings for future use. 
These profiles are not associated with specific sources or targets; rather, they define only 
general settings. 

25BFiltering 
Use Filtering to locate systems in large networks easily. You can search networks by 
system name or IP address. Search criteria can include wildcards and multiple values.  

26BQuick Convert 
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Use the Quick Convert feature to adapt an existing conversion task profile into a template 
that can be the basis for new conversion jobs.  

27BRight-sized Virtual Disks 
When you select file-based as the transfer mode and change the size of a volume, a target 
virtual disk is created in that size. For example, if sources C (100GB) and D (500GB) 
each have less than 10GB, in file-based transfer mode you can set the target to C=25GB 
and D=25GB. vConverter will pre-create the target virtual disks as 25GB each and 
transfer only data during conversion.  

28BWindows Disk Resizing 
This feature uses a New Technology File System (NTFS) resizing process to increase 
speed and reduce the amount of time it takes for block-based cloning.  

29BIP Migration 
IP Migration allows you to transfer the IP from source physical Network Interface Cards 
(NICs) to target virtual NICs. vConverter provides the default option of retaining the 
source server IP configuration. 

30BVM Installation 
This feature allows you to install vConverter on a VM either as a stand-alone installation 
or against an upstream physical machine. 

31BEmail Notification 
Use Email Notification to configure who receives alerts indicating that a conversion job 
has started, succeeded, or failed. You can configure the alerts to include relevant log files. 
You can also request notification of intermediate synchronization status.   

32BWindows Target Server Agent 
Provides the ability to replicate a Secure File Transfer Protocol (SFTP) agent on 
Windows as a Windows service so that P2VDR jobs complete as they do on an ESX 
Server. Ports a Target Server Agent (TSA) to Windows to speed up writes. 

33BImport/Export Settings 
Use these commands to import or export settings that you have defined previously. Reuse 
these settings across multiple systems and vConverter instances. 
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4BConversion Process Overview 

The vConverter architecture includes the GUI, the Source Quiesce, Drive Capture Tool 
(DCT), Migration Tool, and ESX/Xen Host Daemon.  The Source Quiesce, Capture Tool, 
and Migration Tool are all directed from the GUI onto the source by the Interactive 
Remote Launch Tool (IRLT). Conversion jobs are configured, scheduled, and initiated by 
the GUI component. During conversions, job details are sent to the source, which is 
paused. Data is sent from the source to the target ESX/Xen host. Status messages are 
returned from the Source Server Capture Driver (SSCD) to update the information in the 
GUI. Upon completion of the data transfer, the ESX/Xen Host Daemon can resize the 
partitions and perform the P2V conversion steps. The VM is configured with the proper 
CPU, memory, and network settings, and registered on the ESX host. Then, it is ready to 
be run as a VM.  
 

Note: For Windows XP and Windows Server 2003, the Microsoft Volume Shadow Copy 
Service (MS VSS) is used instead of Consistency Driver to enforce consistency for 
applications. 

   

 
 
What Is Happening on the ESX Host? 
At the ESX host level, the process is extremely fast and flexible with minimal impact to 
the virtual environment. These application components are used: 

• xinetd—The built-in service console method for listening to new traffic and 
starting server components when required by an external request. 

• vzBoost—A controllable VMkernel module that allows data to be written at very 
fast speeds directly through the service console. vzBoost is an optional installation 
component.  

• sftp-over-tcp—The server component that makes data transfer possible. It is based 
on the SFTP, with the secure elements eliminated to make it as fast and 



 

vConverter v4.1  Chapter 1 Introduction 8  

lightweight as possible. The data transfer occurs over TCP port 422 into the 
ESX host. 

 
 

After the job is executed and the DCT starts sending data to ESX, it is detected by the 
xinetd service running. This starts the server component particular to that job.  Multiple 
jobs can run at the same time and each job will use its own server component instance. 

1. To transfer data to the target, a new VMDK file is created. It is the same size as 
the original source volume. The VMDK file is pre-allocated to avoid file growth. 
You can specify a unique VMDK file and datastore for each Windows volume. 

2. The server component receives block-level data from the DCT and places it in the 
VMDK file.  If a block of zeroed data is detected by the DCT, it is ignored. The 
zeroes already exist in the VMDK, so there is no reason to overwrite them. 

3. Within 50 seconds of the server component executing, the vzBoost module 
activates to enable high speed data writes into the VMFS. vzBoost monitors the 
server component and terminates itself upon completion of the data transfer.  

4. (Optional) After all data has been transferred to the VMDK file, the server 
component can resize the files based on job configuration. In this case, the NTFS 
partition is modified as well. 

5. The server component performs the conversion and creates a bootable instance of 
the VM with the proper drivers. This should prevent blue screen errors on system 
startup. 

6. A VM is created and registered on the ESX host based on job configuration 
settings that include assigned memory, VHD, and virtual network assignment. 

7. The server component terminates and enters a wait state—controlled through 
xinetd—to anticipate the next job. 

 

What Is Changing on the ESX Host? 
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The installation of the ESX Host Agent adds these files to the host:  

  

The installation of the ESX Server Daemon makes these changes to the host 
configuration:  

• Adds S79vzloader to the /etc/rc3.d startup script list. 

• Adds S80vzboost to the /etc/rc3.d startup script list. 

• Adds sftp-over-tcp to the /etc/xinetd.d script list. 

• Opens the iptables firewall port 422 to allow incoming communication to the data 
transfer component. 

 

34BHot and Cold Cloning 
vConverter offers two approaches for converting physical or virtual servers to VM 
targets. Hot cloning allows the source OS to continue to run while cold cloning requires a 
source reboot. Whether you use the block- or file-based methods, during cold cloning no 
changes are made in the source’s file system.  

Hot cloning is the process of taking a live source system and creating a complete copy of 
it in the form of a VM. To yield a data-consistent image, Vizioncore Consistency Driver 
(VCD) and MS VSS assist in the process. VCD captures write requests from the file 
system and retains the former state of the updated disk sectors. VCD is unaware of 
running applications on the source and therefore cannot save associated data for backup. 
This is where MS VSS steps in—telling databases, application servers, and so forth to 
flush uncached data to disk so that backup can proceed. 

There are two types of cold conversion—manual and remote. During manual cold 
conversion, the source is manually booted using a VistaPE ISO boot image burned to a 
CD. You manually create and control the conversion.  

There are three types of remote conversion. During RCC, you schedule a conversion. 
When the job starts, a new boot loader and boot image are sent to the source. At a time 
that you designate, the source reboots in Vizioncore’s boot environment. After the boot 
image brings the source onto the network, the conversion monitor component connects to 
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vConverter. The conversion completes. You need not be present at the source machine 
during conversion.  

During the less automated RCC process, you can boot into the source’s PXE 
environment. Then, the PXE connects to vConverter’s PXE Service. (Note: To do this, 
you must start PXE service. PXE is added automatically when you install vConverter.) 
After the source connects to the PXE Service, VC automatically sends its boot image to 
the source. Then, the source boots into the cold cloning boot image. At this point, you 
must confirm that the source is on the network. Then, you must locate the source in VC 
and manually convert it. 

This is how the process works when the conversion type is set to RCC: 

1. vConverter sends a new boot loader to the source. 

2. vConverter sends the VistaPE boot image file directly to the source and initiates a 
reboot. 

3. The source boots into the vConverter boot image and instantiates the network 
stack. 

4. vConverter establishes contact with the conversion monitor and initiates the 
conversion process. 

5. Once conversion is complete, the source restarts and boots into its previous boot 
environment with the previous boot loader intact. 
 

There are a few options for using a boot image based on the Windows Vista OS.  

• Download Vista PE .ISO image from the Vizioncore website and burn it to a CD. 
From the CD, boot the system to be converted. When booting completes, the 
source will display in vConverter’s Network Browsers pane. This is called manual 
cold conversion. 

• Use Vista PE boot .wim and PXE service for machines that support PXE. From a 
remote system, reboot the source and use F12 to boot from the network. The 
source server will display in vConverter’s Network Browser pane under an object 
named Cold cloning ready (under VistaPE). This is called RCC. 

• Use Vista PE boot .wim and RCC. The boot image is transferred to a working 
source system. This requires 300MB of free space on each active partition. The 
boot loader code is replaced. The source is rebooted remotely into the boot image. 
The F12 sequence runs automatically. As Vista PE loads, the original boot area is 
restored. When loading is complete, the boot image is removed from the source. 
 

Note: If you have any trouble loading Vista PE, see the Manually Install a NIC Device to 
Work with VistaPE section in the Appendix. Also, confirm driver compatibility by 
checking your drivers against the list provided in Drivers section of the Appendix. 
 

35BFile-based and Block-based Cloning 
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Cloning can be block- or file-based. Only data is transferred during these processes; 
whitespace is not. File-based cloning of a source occurs on the file system level. The 
target is mounted to the source and a full file synchronization occurs—directory structure 
from the source and all file content are updated to the target. File-based cloning is ideal 
for capturing large source volumes to a target with limited storage capacity. To ensure 
consistency during hot cloning, use the file-based method with MS VSS.  

Block-based cloning uses an Application Programming Interface (API) from the source 
OS that allows you to skip unused sectors. This is the default transfer mode, yielding an 
exact binary copy of a source volume. This mode requires that the source and target disks 
be the same size. After conversion, you can resize down the target volume.  

The IRLT is used during block-based cloning and is removed when the conversion 
completes. It gives you full mounting, capture, migration, and restore capability on any 
remote system. It allows you to run an application on any Windows 2000 or 2003 system. 
You do not need to install any agents to use IRLT, but you must have administrative 
credentials on the source. Two run-time drivers on the source are used as well—VCD and 
Disk Image Driver (DID).  

This is how IRLT works: 

1. It connects to the source—to default shares ADMIN$ and IPC$—using 
administrative credentials. 

2. It creates a new folder within ADMIN$ share and copies necessary tools (vcct.exe 
[Vizioncore Capture Tool] and others) to launch. 

3. It installs its proxy service on the source using the Win32 Service Manager API. 

4. It runs the service that launches the target application, redirects input and output 
streams (if necessary), and awaits completion of the launched application. 

5.  It uninstalls the service and removes all of the files (CT, VCD, and DID) written 
to the source. 

The target is mounted to the source and a full file synchronization occurs—directory 
structure from the source and all file content are updated to the target.  

Notes: You can only complete a cold conversion of Windows NT SP6a or Windows 
2000 using the file-based method. Although resizing down is a more complex process 
than increasing the size of a volume, both options are available in file- and block-based 
cloning.  

36BConversion Types 
When you create a conversion job manually (rather than through the vConverter Wizard) 
and define its properties, you must select a conversion type. These conversion types are 
available: 

• Manual—Select this method if you want to run a conversion job immediately 
rather than scheduling it.  
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• Single Conversion—This method allows you to create and run a one-time 
scheduled conversion job.  

• Remote Cold Cloning—Minimizes the risk of data corruption because no files are 
opened during the process.  

• Synchronized Cutover—The first synchronization is block-based, followed by a 
file-based synchronization without MS VSS.  

• Continuous Protection—This mode requires MS VSS, so it cannot be used to 
convert Windows 2000 systems.  

• Different Destinations Cutover—This method allows synchronized cutover to 
initialize to a specific target. 

For instructions on using each conversion type, see Chapter 4. 



 

vConverter v4.1  Chapter 1 Introduction 13  

5BUsing this Manual 

37BTerms and Acronyms 
This is a list of terms and acronyms that are used in this manual. 

Term or 
Acronym 

Definition 

API Application Programming Interface 

CLI Command Line Interface 

CLI Tool Use as an executable or as DLLs to run conversions without the 
vConverter GUI. 

Client Machine The machine on which vConverter is installed. Acts like a dispatcher 
initiating conversion jobs. The client uses the IRLT, protocol, and 
network credentials to launch the software on the source.  

Cold Cloning 
Ready 

The name of the tree in the Network Browser pane that contains the 
servers available for RCC. 

COS Console Operating System 

CPU Central Processing Unit 

Cutover The process of switching from the source to the converted target VM. 

Cutover 
Window 

A period of time on a specific date (or span of dates) when it is 
acceptable to begin cutover.  

DCT Drive Capture Tool—Runs on the source and features Consistency 
Driver. Reads disk data and tracks changes, which are transferred to 
the target. 

DDC Different Destinations Cutover  

DHCP Dynamic Host Configuration Protocol 

DID Disk Image Driver 

DNS Domain Name System 

DR Disaster Recovery 

Drive Image 
Mount Tool 

Shows drive image file content as a separate disk with read-only and 
read/write. Uses the Virtual Disk Driver for mounting the image. 

ESX 2.x Version 2.x of ESX Server 

FQDN Fully Qualified Domain Name 

GB Gigabyte 

Guest A VM that runs on an ESX Server. 
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Term or 
Acronym 

Definition 

HAL Hardware Abstraction Layer 

Host A physical ESX Server that runs VMs. 

iSCSI Small Computer System Interface 

I/O Input/Output 

IRLT Interactive Remote Launch Tool—Use to run an executable on a 
remote Windows system. 

IP address Internet Protocol (address) 

LAN Local Area Network 

Licensing 
Service 

A vConverter unit that maintains license and time restriction 
information as well as a list of systems to convert. Must be run on a 
physical machine. 

LUN Logical Unit Number 

MAC address Media Access Control (address) 

MAPI Messaging Application Programming Interface 

MB Megabyte 

Mb Megabit 

Migration Tool Runs on the client machine. Updates the Windows registry on the 
mounted file system to ensure that the system is bootable and 
functioning after moving to the target virtual platform. In post-
conversion, installs VMware Tools for the target; runs scripts in the 
migrated system at first boot; and uninstalls software from the 
migrated system. 

MS VSS Microsoft Volume Shadow Copy Service makes remote API call 
communication possible. Works to freeze and thaw application writes 
during conversions. 

NIC Network Interface Card 

NTFS New Technology File System 

OS Operating System 

P2V Physical to Virtual 

PXE  Preboot Execution Environment—Delivers boot image files to 
remote systems via TFTP. 

PXE Service Uses the network to transfer the Vista PE image to targets. 

RAM Random Access Memory 
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Term or 
Acronym 

Definition 

RCC Remote Cold Cloning 

RDM Raw Device Mapping—A file that resides on a datastore (vmfs 
volume). Using RDM, all source volumes to be converted are placed 
in a single device. RDM file has a .vmdk extension.  

RPC/DCOM Remote Procedure Call/Distributed Component Object Model 

SAN Storage Area Network 

SSCD Source Server Capture Driver 

SFTP Secure File Transfer Protocol 

SMP Symmetrical Multi-Processing 

SMTP Simple Mail Transfer Protocol 

Source 
Machine 

The machine to be captured and converted to the target. 

Source Server Refers to the physical system with the host OS that is to be converted 
to a VM. The source server is dynamically converted into a guest OS. 

SSH Secure Shell Access; a network protocol used to exchange data 
between CPUs across a secure channel.  

su switch user 

Target 
Machine 

The machine to which the source’s conversion is written directly. 

Target Server Refers to disk space on a physical server, where the host OS from the 
source server is sent and stored.  

Target Server 
Agent for ESX 
Server 

An application that manages incoming requests such as reading and 
writing data and creating and resizing disk images; It is run on the 
COS of an ESX Server by xinetd daemon. 

Target Server 
Agent for 
Windows 

Runs on a target system and increases performance in writing disk 
image. Especially effective for capturing images in flat format, where 
initial allocation of disk space can take significant time when done 
over the network. Also the agent allows for basic data compression to 
reduce traffic usage. 

Target Server 
Agent for 
XenServer or 
ESX Server 

Runs either in “ring 0” level in XenServer or in VA deployed on ESX 
Server/XenServer. The only way to store images on VMware ESX 3i 
servers is to use VA and TSA. All TSAs use a simplified version of 
SFTP protocol to transfer the data. The simplification removes the 
underlying SSH connection to speed data transfer, and adds its own 
authentication to prevent unauthorized access. 

TFTP Trivial File Transfer Protocol 



 

vConverter v4.1  Chapter 1 Introduction 16  

Term or 
Acronym 

Definition 

TSA Target Server Agent 

UI User Interface 

UNC 
Connection 

Even though vConverter uses a UNC to point to the target server, you 
may select a target drive letter path (e.g., D:\TEMP) instead. To 
allow capturing to a local path, vConverter automatically creates a 
share with strict permissions to allow the source to access the target. 
This share is removed once capturing is complete. If you do not want 
to use a share, you must use a UNC. 

USB Universal Serial Bus 

UUID Universally Unique Identifier 

V2V Virtual to Virtual 

VA Virtual Appliance—For ESX Server or XenServer, VA is a VM 
template that replaces the COS. It can mount and unmount and create 
and remove virtual disks. It can also create partitions. 

VC VMware VirtualCenter; a management server within a virtualized 
environment. 

VCB VMware Consolidated Backup 

VCD Vizioncore Consistency Driver 

VDD Virtual Disk Driver 

VHD Virtual Hard Disk 

VIC Virtual Infrastructure Client 

VI3 VMware Infrastructure 3 (including ESX Server v3.x) 

VM Virtual Machine 

VMDK Virtual Machine Disk Format; a disk file that stores a VM’s hard 
drive contents. 

VMFS Virtual Machine File System; VMware’s cluster file system, which 
stores VM disk images. 

VMX VMware Virtual Machine Configuration 

VMXNET A driver that increases networking performance. 

vzBoost An optional driver installed on the target ESX host; improves write 
speeds to the VMFS. This module will only manage traffic within the 
Service Console and will not impact I/O operations for running VMs. 

WAN Wide Area Network 

Windows Vista An image based on the Windows Vista installation; includes network 
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Term or 
Acronym 

Definition 

PE and disk adapter drivers. 

WMI Windows Management Instrumentation 

 

Note: Within the application, click this icon  to access balloon help text for the topic 
adjacent to the icon. 
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6BvConverter Licensing 

Each vConverter license allows for one P2V conversion. After each successful 
conversion, the number of available conversions is decremented from the license. 
Unsuccessful or cancelled conversions do not decrement licensing. 

vConverter’s upstream licensing method allows for centralized use and management of 
just one serial number. That is, if you have 1,000 servers to convert you can purchase a 
single serial number and distribute the vConverter executable to a large number of 
workstations. These downstream workstations can activate their installation using the 
central system that was activated originally. 

If you do not have a permanent license, a trial license will be generated for you 
automatically. Each trial license allows for three conversion jobs; the license expires after 
14 days. 

There are two types of vConverter licenses—Server Consolidation and DR Enabled. For 
information on both, refer to the Licensing Model Guide in the Documentation area of 
the Vizioncore website. 
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7BContacting Dell 

Note: If you do not have an active Internet connection, you can find contact information on your 
purchase invoice, packing slip, bill, or Dell product catalog.  
Dell provides several online and telephone-based support and service options. Availability varies 
by country and product, and some services may not be available in your area. To contact Dell for 
sales, technical support, or customer service issues:  

1. Visit 101Hhttp://support.dell.com.  
2. Verify your country or region in the Choose A Country/Region drop-down menu at the 

bottom of the page.  
3. Click Contact Us on the left side of the page.Note: Toll-free numbers are for use within 

the country for which they are listed.  
4. Select the appropriate service or support link based on your need.  

5. Choose the method of contacting Dell that is convenient for you. 

Country (City) 
International Access 
Code 
Country Code 
City Code 

Service Type Area Codes,
Local Numbers, and

Toll-Free Numbers
Web and E-Mail 

Addresses
Anguilla Web Address 

E-Mail Address 
Technical Support., Customer Service, Sales 

102Hwww.Dell.com/ai
103Hla-

techsupport@dell.com
toll-free: 800-335-0031

Antigua and 
Barbuda 

Web Address 
E-Mail Address 
Technical Support., Customer Service, Sales 

104Hwww.Dell.com.ag
105Hla-

techsupport@dell.com
1-800-805-5924

Aomen Technical Support
Dell™ Dimension™, Dell Inspirion™, Dell Optiplex™, Dell 
Lattitude™, and Dell Precision™ 
Servers and Storage 

0800-105

0800-105
Argentina (Buenos 
Aires) 
International Access 
Code: 00 
Country Code: 54 
City Code: 11 
 

Web Address 
E-Mail Address for Desktop and Portable Computers 
E-Mail Address for Servers and EMC® Storage Products 
Customer Service 
Technical Support 
Technical Support Services 
Sales 

106Hwww.dell.com.ar
107Hla-

techsupport@dell.com
108Hla_enterprise@dell.com

toll-free: 0-800-444-0730
toll-free: 0-800-444-0733
toll-free: 0-800-444-0724

        0-800-444-3355
Aruba Web Address 

E-Mail Address 
Technical Support., Customer Service, Sales 

109Hwww.Dell.com/aw
110Hla-

techsupport@dell.com
toll-free: 800-1578

Australia (Sydney) 
International Access 
Code: 0011 
Country Code: 61 

Web Address 
Contact Dell Web Address 
 
Technical Support., Customer Service, Sales 

support.ap.dell.com
support.ap.dell.com/cont

actus
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City Code: 2 13DELL-133355
Austria (Vienna) 
International Access 
Code: 900 
Country Code: 43 
City Code: 1 

Web Address 
E-Mail Address 
Home/Small Business Sales 
Home/Small Business Fax 
Home/Small Business Customer Service 
Home/Small Business Support 
Preferred Accounts/Corporate Customer 
Service Preferred Accounts/Corporate Customer 
Switchboard 

Support.euro.dell.com
111HTech_support_central_europe@dell

.com 
0820 240 530 00
0820 240 530 49
0820 240 530 14
0820 240 530 17
0820 240 530 16
0820 240 530 17
0820 240 530 00

Bahamas Web Address 
E-Mail Address 
Technical Support., Customer Service, Sales 

112Hwww.dell.com/bs
113Hla-

techsupport@dell.com
toll-free: 1-866-874-3038

Barbados Web Address 
E-Mail Address 
Technical Support., Customer Service, Sales 

114Hwww.dell.com/bb
115Hla-

techsupport@dell.com
1-800-534-3142

Belgium (Brussels) Web Address 
General Support 
General Support Fax 
Customer Service 
Corporate Sales 
Fax 
Switchboard 

Support.euro.dell.com
02 481 92 88
02 481 92 95
02 713 15 65 
02 481 91 00
02 481 91 99
02 481 91 00

Bolivia Web Address 
E-Mail Address 
Technical Support., Customer Service, Sales 

116Hwww.dell.com/bo
117Hla_techsupport@dell.co

m
toll-free: 800-10-0238

Brazil 
International Access 
Code: 00 
Country Code: 55 
City Code: 51 

Web Address 
E-Mail Address 
Customer Service and Tech Support 
Technical Support Fax 
Customer Service Fax 
Sales 

118Hwww.dell.com/br
119HBR_TechSupport@dell

.com
0800 970 3355
51 2104 5470
51 2104 5480

0800 722 3498
British Virgin 
Islands 

Technical Support, Customer Service, Sales toll-free: 1-866-278-6820

Brunei 
Country Code: 673 

Technical Support (Penang, Malaysia)
Customer Service (Penang, Malaysia) 
Transaction Sales (Penang, Malaysia) 

604 633 4966
604 633 4888
604 633 4955

Canada (North 
York, Ontario) 
International Access 
Code: 011 

Online Order Status Web Address
AutoTech (automated Hardware and Warranty Support) 
Customer Service 
Home/Home Office 
Small Business 
Medium/Large Business, Government, Education 
Hardware Warranty Phone Support 
Computers for Home/Home Office 

120Hwww.dell.ca/ostatus
support.ca.dell.com

toll-free:1-800-247-9362
toll-free:1-800-847-4096
toll-free:1-800-906-3355
toll-free:1-800-387-5757

toll-free:1-800-847-4096



 

vConverter v4.1  Chapter 1 Introduction 21  

Computers for Small/Medium/Large Business
Government 
Printers, Projectors, Televisions, Handheld, Digital 
Jukebox, and Wireless Sales 
 
Home and Home Office Sales 
Small Business 
Medium/Large Business, Government 
Spare Parts and Extended Service 

toll-free:1-800-387-5757

1-877-335-5767

toll-free:1-800-999-3355
toll-free:1-800-387-5752
toll-free:1-800-387-5755

1 866 440 3355

Cayman Islands E-Mail Address
Technical Support, Customer Service, Sales 

121Hla-
techsupport@dell.com

1-877-262-5415
Chile (Santiago) 
Country Code: 56 
City Code: 2 

Web Address 
E-Mail Address 
Sales and Customer Support 

122Hwww.dell.com/cl
123Hla-

techsupport@dell.com
toll-free: 1230-020-4823

China (Xiamen) 
Country Code: 86 
City Code: 592 

Technical Support Web Address
Technical Support E-Mail Address 
Customer Service E-Mail Address 
Technical Support Fax 
Technical Support – Dimension and Inspiron 
Technical Support – OptiPlex, Lattitude and Dell  
Precision 
Technical Support – Servers and Storage 
Technical Support – Projectors, PDAs, Switches, Routers, 
etc 
Technical Support – Printers 
Customer Service 
Customer Service Fax 
Home and Small Business 
Preferred Accounts Division 
Large Corporate Accounts GCP 
Large Corporate Accounts Key Accounts 
Large Corporate Accounts North 
Large Corporate Accounts North Government and 
Education 
Large Corporate Accounts East 
Large Corporate Accounts East Government and 
 Education 
Large Corporate Accounts Queue Team 
Large Corporate Accounts South 
Large Corporate Accounts West 
Large Corporate Accounts Spare Parts 

support.dell.com.cn
support.dell.com.cn/ema

il
124Hcustomer_cn@dell.com

592 818 14350
toll-free: 800 858 2969
toll-free: 800 858 0950

toll-free: 800 858 0960
toll-free: 800 858 2920

toll-free: 800 858 2311
toll-free: 800 858 2060

592 818 1308
toll-free: 800 858 2222
toll-free: 800 858 2557
toll-free: 800 858 2055
toll-free: 800 858 2628
toll-free: 800 858 2999
toll-free: 800 858 2955

toll-free: 800 858 2020
toll-free: 800 858 2669

toll-free: 800 858 2572
toll-free: 800 858 2355
toll-free: 800 858 2811
toll-free: 800 858 2621

Columbia Web Address 
E-Mail Address 
Technical Support, Customer Service, Sales 

125Hwww.dell.com/co
126Hla-

techsupport@dell.com
01-800-915-4755

Costa Rica Web Address 
E-Mail Address 

127Hwww.dell.com/cr
128Hla-
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Technical Support, Customer Service, Sales techsupport@dell.com
0800-012-0231

Czech Republic 
(Prague) 
International Access 
Code: 00 
Country Code: 420  

Web Address 
E-Mail Address 
Technical Support 
Customer Service 
Fax 
Technical Fax 
Switchboard 

support.euro.dell.com
129Hczech_dell@dell.com

22537 2727
22537 2707
22537 2714
22537 2728
22537 2711

Denmark 
(Copenhagen) 
International Access 
Code: 00 
Country Code: 45 

Web Address 
 
Technical Support 
Customer Service – Relational 
Home/Small Business Customer Service 
Switchboard – Relational 
Switchboard Fax – Relational 
Switchboard – Home/Small Business 
Switchboard Fax – Home/Small Business 

Support.euro.dell.com

7023 0182
7023 0184
3287 5505
3287 1200
3287 1201
3287 5000
3287 5001

Dominica Web Address 
E-Mail Address 
Technical Support, Customer Service, Sales 

130Hwww.dell.com/dm
131Hla-

techsupport@dell.com
toll-free: 1-866-278-6821

Dominican 
Republic 

Web Address 
E-Mail Address 
Technical Support, Customer Service, Sales 

132Hwww.dell.com/do
133Hla-

techsupport@dell.com
1-800-156-1588

Ecuador Web Address 
E-Mail Address 
Technical Support, Customer Service, Sales (Calling from 
Quito) 
Technical Support, Customer Service, Sales (Calling from 
Guayaquil) 

134Hwww.dell.com/ec
135Hla-

techsupport@dell.com
toll-free: 999-119-877-655-

3355

toll-free: 1800-999-119-
877-655-3355

El Salvador Web Address 
E-Mail Address 
Technical Support, Customer Service, Sales 

136Hwww.dell.com/sv
137Hla-

techsupport@dell.com
800-6132

Finland (Helsinki) 
International Access 
Code: 990 
Country Code: 358 
City Code: 9 

Web Address 
E-Mail Address 
Technical Support 
Customer Service 
Switchboard 
Sales under 500 employees 
Fax 
Sales over 500 employees 
Fax 

138Hsupport@euro.dell.com
139Hfi_support@dell.com

0207 533 555
0207 533 538
0207 533 533
0207 533 540
0207 533 530
0207 533 533
0207 533 530

France (Paris) 
(Montpellier) 
International Access 

Web Address 
Home and Small Business 
Technical Support 

Support.euro.dell.com
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Code: 00 
Country Code: 33 
City Codes: (1) (4) 

Customer Service
Switchboard 
Switchboard (calls from outside of France) 
Sales 
Fax 
Fax (calls from outside of France) 
Corporate 
Technical Support 
Customer Service 
Switchboard 
Sales 

0825 387 270
0825 832 833
0825 004 700

04 99 75 40 00
0825 004 700
0825 004 701

04 99 75 40 01

0825 004 719
0825 338 339

01 55 94 71 00
01 55 94 71 00

Germany 
(Frankfurt) 
International Access 
Code: 00 
Country Code: 49 
City Code: 69 

Web Address 
E-mail Address 
Technical Support 
Home/Small Business Customer Service 
Global Segment Customer Service 
Preferred Accounts Customer Service 
Large Accounts Customer Service 
Public Accounts Customer Service 
Switchboard 

support.euro.dell.com
140Htech_support_central_europe@d

ell.com 
069 9792-7200
0180-5-224400
069 9792-7320
069 9792-7320
069 9792-7320
069 9792-7320
069 9792-7000

Greece 
International Access 
Code: 00 
Country Code: 49 

Web Address 
Technical Support 
Gold Service Technical Support 
Switchboard 
Gold Service Switchboard 
Sales 
Fax 

Support.euro.dell.com
00800-44 14 95 18
00800-44 14 00 83

2108129810
2108129811
2108129800
2108129812

Grenada Web Address 
E-Mail Address 
Technical Support, Customer Service, Sales 

141Hwww.dell.com/gd
142Hla-techsuppo@dell.com

toll-free: 1-866-540-3355
Guatemala Web Address 

E-Mail Address 
Technical Support, Customer Service, Sales 

143Hwww.dell.com/gt
144Hla-

techsupport@dell.com
1-800-999-0136

Guyana E-Mail Address
Technical Support, Customer Service, Sales 

145Hla-
techsupport@dell.com
toll-free: 1-877-270-4609

Hong Kong 
International Access 
Code: 001 
Country Code: 852 

Web Address 
Technical Support E-mail Address 
Technical Support - Dimension and Inspiron 
Technical Support - OptiPlex, Latitude, and Dell 
Precision 
Technical Support - Servers and Storage 
Technical Support - Projectors, PDAs, Switches, Routers, 
etc . 
Customer Service 
Large Corporate Accounts 
Global Customer Programs 
Medium Business Division 

support.ap.dell.com
support.dell.com.cn/ema

il
00852-2969 3188
00852-2969 3191

00852-2969 3196
00852-3416 0906

00852-3416 0910
00852-3416 0907
00852-3416 0908
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Home and Small Business Division 00852-3416 0912
00852-2969 3105

India Dell Support Website
Portable and Desktop Support 
Desktop Support E-mail Address 
Portable Support E-mail Address 
Phone Numbers 
 
 
 
Server Support 
E-mail Address 
Phone Numbers 
 
 
 
Gold Support Only 
E-mail Address 
Phone Numbers 
 
 
 
Customer Service 
Home and Small Business 
 
 
Large Corporate Accounts 
 
Sales 
Large Corporate Accounts 
Home and Small Business 

support.ap.dell.com

146Hindia_support_desktop
@dell.com

147Hindia_support_noteboo
k@dell.com

080-25068032 or 080-
25068034 or

your city STD code + 
60003355 or

toll-free: 1-800-425-8045

148Hindia_support_Server@
dell.com

080-25068032 or 080-
25068034 or

your city STD code + 
60003355 or

toll-free: 1-800-425-8045

149Heec_ap@dell.com
080-25068033 or your city 

STD code + 60003355 or
 toll-free: 1-800-425-9045

150HIndia_care_HSB@dell.
com

 toll-free : 1800-4254051

151HIndia_care_REL@dell.
com

toll free : 1800-4252067

1600 33 8044
1600 33 8046

Ireland 
(Cherrywood) 
International Access 
Code: 00 
Country Code: 353 
City Code: 1 

Web Address 
 
Technical Support 
E-mail Address 
Business computers 
Home computers 
At Home Support 
Sales 
Home 
Small Business 

Support.euro.dell.com

152Hdell_direct_support@
dell.com

1850 543 543
1850 543 543
1850 200 889

1850 333 200
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Medium Business
Large Business 
E-mail Address 
Customer Service 
Home and Small Business 
Business (greater than 200 employees) 
General 
Fax/Sales fax 
Switchboard 
U.K. Customer Service (dealing with U.K.only) 
Corporate Customer Service (dial within U.K. only) 
U.K. Sales (dial within U.K. only) 

1850 664 656
1850 200 646
1850 200 646

153HDell_IRL_Outlet@del
l.com

01 204 4014
1850 200 982

01 204 0103
01 204 4444

0870 906 0010
0870 907 4499
0870 907 4000

Italy (Milan) 
International Access 
Code: 00 
Country Code: 39 
City Code: 02 

Web Address 
Home and Small Business 
Technical Support 
Customer Service 
Fax 
Switchboard 
Corporate 
Technical Support 
Customer Service 
Fax 
Switchboard 

Support.euro.dell.com

02 577 826 90
02 696 821 14
02 696 821 13

 02 696 821 12

02 577 826 90
02 577 825 55
02 575 035 30

02 577 821
Jamaica E-mail Address

Technical Support, Customer Service, Sales  
(dial from within Jamaica only) 

154Hla-
techsupport@dell.co

m
1-800-440-9205

Japan (Kawasaki) 
International Access 
Code: 001 
Country Code: 81 
City Code: 44 

Web Address 
Technical Support - Dimension and Inspiron  
Technical Support outside of Japan - Dimension and 
Inspiron 
Technical Support - Dell Precision, OptiPlex, and 
Latitude 
Technical Support outside of Japan - Dell Precision, 
OptiPlex, and Latitude 
Technical Support - Dell PowerApp™, Dell 
PowerEdge™, Dell PowerConnect™, and Dell 
PowerVault™, 
Technical Support outside of Japan - PowerApp, 
PowerEdge, PowerConnect, and PowerVault 
Technical Support - Projectors, PDAs, Printers, Routers 
Technical Support outside of Japan - Projectors, PDAs, 
Printers, Routers 
Faxbox Service 
24-Hour Automated Order Status Service 
Customer Service 
Business Sales Division - up to 400 employees 
Preferred Accounts Division Sales - over 400 employees 

support.jp.de
ll.com

toll-free: 
0120-198-26 

81-44-520-
1435

toll-free: 
0120-198-433

81-44-556-3894

toll-free: 0120-198-498

81-44-556-4162

toll-free: 0120-981-690
81-44-556-3468

044-556-3490
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Public Sales - government agencies, educational 
institutions, and medical institutions 
Global Segment Japan 
Individual User 
Individual User Online Sales  
Individual User Real Site Sales 
Switchboard 

044-556-3801
044-556-4240
044-556-1465
044-556-3433
044-556-5963

044-556-3469
044-556-1657
044-556-2203
044-556-4649
044-556-4300

Korea (Seoul) 
International Access 
Code: 001 
Country Code: 82 
City Code: 2 

Web Address 
Technical Support, Customer Service 
Technical Support - Dimension, PDA, Electronics, and 
Accessories 
Sales 
Fax 
Switchboard 

Support.ap.dell.com
toll-free: 080-200-3800
toll-free: 080-200-3801

toll-free: 080-200-3600
2194-6202
2194-6000

Latin America Customer Technical Support (Austin, Texas, U.S.A.)
Customer Service (Austin, Texas, U.S.A.) 
Fax (Technical Support and Customer Service) (Austin, 
Texas, U.S.A.)  
Sales (Austin, Texas, U.S.A.) 
SalesFax (Austin, Texas, U.S.A.) 

512 728-4093
512 728-3619
512 728-3883

512 728-4397
512 728-4600 or 512 728-

3772
Luxemborg 
International Access 
Code: 00 
Country Code: 352 

Web Address 
Support 
Home/Small Business Sales 
Corporate Sales 
Customer Service 
Fax 

Support.euro.dell.com
3420808075

+32 (0)2 713 15 96
26 25 77 81

+32 (0)2 481 91 19
26 25 77 82

Macao 
Country Code: 83 

Technical Support
Customer Service (Xiamen, China) 
Transaction Sales (Xiamen, China) 

toll-free: 0800 105
34 160 910
29 693 115

Malaysia (Penang) 
International Access 
Code: 00 
Country Code: 60 
City Code: 4 

Web Address 
Technical Support - Dell Precision, OptiPlex, and 
Latitude 
Technical Support - Dimension, Inspiron, and Electronics 
and Accessories 
Technical Support - PowerApp, PowerEdge, 
PowerConnect, and PowerVault 
Customer Service 
Transaction Sales 
Corporate Sales 

Support.ap.dell.com
toll-free: 1800 880 193

toll-free: 1800 881 306

toll-free: 1800 881 386

toll-free: 1800 881 306 
(option 6)

toll-free: 1800 888 202 
toll-free: 1800 888 213

Mexico 
International Access 
Code: 00 
Country Code: 52 

Web Address 
E-mail Address 
Customer Technical Support 
Sales 
Customer Service 
Main 

155Hwww.dell.com/mx
156Hla-

techsupport@dell.com
001-877-384-8979 or 001-877-

269-3383 
50-81-8800 or 01-800-888-

3355 
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001-877-384-8979 or 001-877-
269-3383 

50-81-8800 or 01-800-888-
3355

Montserrat E-mail Address
Technical Support, Customer Service, Sales 

157Hla-
techsupport@dell.com
Toll-free: 1-866-278-6822

Netherlands 
Antilles 
Netherlands 
(Amsterdam) 
International Access 
Code: 00 
Country Code: 31 
City Code: 20 

E-mail Address
Web Address 
Technical Support 
Technical Support Fax 
Home/Small Business Customer Service 
Relational Customer Service 
Home/Small Business Sales 
Relational Sales 
Home/Small Business Sales Fax 
Relational Sales Fax 
Switchboard  
Switchboard Fax 

158Hla-
techsupport@dell.com

support.euro.dell.com 
020 674 45 00 
020 674 47 66 
020 674 42 00 
020 674 43 25 
020 674 55 00 
020 674 50 00 
020 674 47 75 
020 674 47 50 
020 674 47 75 
020 674 47 50 
020 674 50 00 
020 674 47 50

New Zealand 
International Access 
Code: 00 
Country Code: 64 

Web Address 
E-mail Address 
Technical Support, Customer Service, Sales 

Support.ap.dell.com
Support.ap.dell.com/cont

actus
0800 441 567

Nicaragua Web Address 
E-mail Address 
Technical Support, Customer Service, Sales 

159Hwww.dell.com/ni
160Hla-

techsupport@dell.com
001-800-220-1377

Norway (Lysaker) 
International Access 
Code: 00 
Country Code: 47 

Web Address 
Technical Support 
Relational Customer Service 
Home/Small Business Customer Service 
Switchboard 
Fax Switchboard 

Support.euro.dell.com
671 16882
671 17575
231 62298
671 16800
671 16865

Panama Web Address 
E-mail Address 
Technical Support, Customer Service, Sales 

161Hwww.dell.com/pa
162Hla-

techsupport@dell.com
011-800-507-1264

Peru Web Address 
E-mail Address 
Technical Support, Customer Service, Sales 

163Hwww.dell.com/pe
164Hla-

techsupport@dell.com
0800-50-669

Poland (Warsaw) 
International Access 
Code: 011 
Country Code: 48 
City Code: 22 

Web Address 
E-mail Address 
Customer Service Phone 
Customer Service 
Sales  
Customer Service Fax 
Reception Desk Fax 
Switchboard 

support.euro.dell.com
165Hpl_support_tech@dell.c

om
57 95 700
57 95 999
57 95 999
57 95 806
57 95 998
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57 95 999
Portugal 
International Access 
Code: 00 
Country Code: 351 
 
 

Web Address 
Technical Support 
Customer Service 
Sales 
 
Fax 

Support.euro.dell.com
707200149

800 300 413
800-300-410 or 800-300 -411 

or 
800-300-412 or 21-422-07-10 

21-424-01-12
Puerto Rico Web Address 

E-mail Address 
Technical Support, Customer Service, Sales 

www.dell.com/pr
la-

techsupport@dell.com
1-877-537-3355

St. Kitts and Nevis Web Address 
E-mail Address 
Technical Support, Customer Service, Sales 

www.dell.com/kn
la-

techsupport@dell.com
toll-free: 1-866-540-3355

St. Lucia Web Address 
E-mail Address 
Technical Support, Customer Service, Sales 

www.dell.com/lc
la-

techsupport@dell.com
toll-free: 1-866-464-4352

St. Vincent and the 
Grenadines 

Web Address 
E-mail Address 
Technical Support, Customer Service, Sales 

www.dell.com/vc
la-

techsupport@dell.com
toll-free: 1-866-464-4353

Singapore 
International Access 
Code: 005 
Country Code: 65 

NOTE: The phone numbers in this section should be 
called from within Singapore or Malaysia only. 
 
Web Address 
Technical Support - Dimension, Inspiron, and  
Electronics and Accessories 
Technical Support - OptiPlex, Latitude, 
 and Dell Precision 
Technical Support - PowerApp, PowerEdge, 
PowerConnect, and PowerVault 
Customer Service 
Transaction Sales 
Corporate Sales 

support.ap.dell.com
toll-free: 1 800 394 7430

toll-free: 1 800 394 7488

toll-free: 1 800 394 7478

toll-free: 1 800 394 7430 
(option 6)

toll-free: 1 800 394 7412
toll-free: 1 800 394 7419

Slovakia (Prague) 
International Access 
Code: 00 
Country Code: 421 

Web Address 
E-mail Address 
Technical Support 
Customer Service 
Fax 
Tech Fax 
Switchboard (Sales)  

support.euro.dell.com
czech_dell@dell.com

02 5441 5727
420 22537 2707

02 5441 8328
02 5441 8328
02 5441 8328
02 5441 7585

South Africa 
(Johannesburg) 
International Access 
Code: 09/091 
Country Code: 27 

Web Address 
E-mail Address 
Gold Queue 
Technical Support 
Customer Service 

support.euro.dell.com
166Hdell_za_suppor@dell.c

om
011 709 7713
011 709 7710
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City Code: 11 Sales 011 709 7707
011 709 7700

Spain (Madrid) 
International Access 
Code: 00 
Country Code: 34 
City Code: 91 

Web Address 
Home and Small Business 
Technical Support 
Customer Service 
Sales 
Switchboard 
Fax 
Corporate 
Technical Support 
Customer Service 
Switchboard 
Fax 

Support.euro.com
 

902 100 130
902 118 540
902 118 541
902 118 541
902 118 539

902 100 130
902 115 236

91 722 92 00
91 722 95 83

Sweden (Upplands 
Vasby) 
International Access 
Code: 00 
Country Code: 46 
City Code: 8 

Web Address 
Technical Support 
Relational Customer Service 
Home/Small Business Customer Service 
Employee Purchase Program (EPP) Support 
Technical Support Fax 

support.euro.dell.com
08 590 05 199
08 590 05 642
08 587 70 527
020 140 14 44
08 590 05 594 

Switzerland 
(Geneva) 
International Access 
Code: 00 
Country Code: 41 
City Code: 22 

Web Address 
E-mail Address 
Technical Support – Home and Small Business 
Technical Support – Corporate 
Customer Service – Home and Small Business 
Customer Service – Corporate 
Fax 
Switchboard 

Support.euro.dell.com
167HTech_support_central_Europe@

dell.com 
0844 811 411
0844 822 844
0848 802 202
0848 821 721
022 799 01 90
022 799 01 01

Taiwan 
International Access 
Code: 002 
Country Code: 886 
 

Web Address 
E-mail Address 
Technical Support - OptiPlex, Latitude, Inspiron, 
Dimension, and Electronics and Accessories 
Technical Support - Servers and Storage 
Customer Service 
Transaction Sales 
Corporate Sales 

support.ap.dell.com
support.dell.com.cn/ema

il
toll-free: 0080 186 1011

toll-free: 0080 160 1256
toll-free: 0080 160 1250 

(option 5)
toll-free: 0080 165 1228
toll-free: 0080 165 1227

Thailand 
International Access 
Code: 001 
Country Code: 66 
 

Web Address 
Technical Support (OptiPlex, Latitude, and Dell 
Precision) 
Technical Support (PowerApp, PowerEdge, 
PowerConnect, and PowerVault) 
Customer Service 
Corporate Sales 
Transaction Sales 

Support.ap.dell.com
toll-free: 1800 0060 07

toll-free: 1800 0600 09

toll-free: 1800 006 007 
(option 7)

toll-free: 1800 006 009
toll-free: 1800 006 006

Trinidad/Tobago 
 
 

Web Address 
E-mail Address 
Technical Support, Customer Service, Sales 

168Hwww.dell.com/tt
169Hla-

techsupport@dell.com
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toll-free: 1-888-799-5908
Turks and Caicos 
Islands 

Web Address 
E-mail Address 
Technical Support, Customer Service, Sales 

170Hwww.dell.com/tc
171Hla-

techsupport@dell.com
toll-free: 1-877-441-4735

U.K.(Bracknell) 
International Access 
Code: 00 
Country Code: 44 
City Code: 1344 
 

Web Address 
E-mail Address  
Customer Service Website 
 
Sales 
Home and Small Business Sales 
Corporate/Public Sector Sales 
Customer Service 
Home and Small Business 
Corporate 
Preferred Accounts (500-5000 employees) 
Global Accounts 
Central Government 
Local Government & Education 
Health 
Technical Support 
Corporate/Preferred Accounts/PCA (1000+ employees) 
Other Dell Products 
General 
Home and Small Business Fax  

upport.euro.dell.com
172Hdell_direct_support@d

ell.com
support.euro.dell.com/u

k/en/ECare/form/home
.asp

0870 907 4000
01344 860 456

0870 906 0010
01344 373 185
0870 906 0010
01344 373 186
01344 373 196
01344 373 199
01344 373 194

0870 908 0500
0870 353 0800

0870 907 4006
Uruguay Web Address 

E-mail Address 
Technical Support, Customer Service, Sales 

173Hwww.dell.com/uy
174Hla-

techsupport@dell.com
toll-free: 000-413-598-2521

U.S.A. (Austin, 
Texas) 
International 
Access Code: 011 
Country Code: 1 

Automated Order-Status Service
AutoTech (portable and desktop computers) 
Hardware and Warranty Support (Dell TV, Printers, and 
Projectors ) for Relationship customers 
Consumer (Home and Home Office) Support for Dell 
products 
Customer Service 
Employee Purchase Program (EPP) Customers  
Financial Services Web Address 
Financial Services (lease/loans) 
Financial Services (Dell Preferred Accounts [DPA]) 
Business 
Customer Service 
Employee Purchase Program (EPP) 
Customer s Support for printers, projectors, PDAs, and 
MP3 players 
Public (government, education, and healthcare) 
Customer Service and Support 
Employee Purchase Program (EPP) Customers 
Dell Sales 

toll-free: 1-800-433-9014
toll-free: 1-800-247-9362
toll-free: 1-877-459-7298

toll-free: 1-800-624-9896

toll-free: 1-800-624-9897
toll-free: 1-800-695-8133

175Hwww.dellfinancialservice
s.com

toll-free: 1-877-577-3355
toll-free: 1-800-283-2210

toll-free: 1-800-624-9897
toll-free: 1-800-695-8133
toll-free: 1-877-459-7298

toll-free: 1-800-456-3355
toll-free: 1-800-695-8133
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Dell Outlet Store (Dell refurbished computers) 
Software and Peripherals Sales 
Spare Parts Sales 
Extended Service and Warranty Sales 
Fax 
Dell Services for the Deaf, Hard-of-Hearing, or Speech-
Impaired 

toll-free: 1-800-289-3355 
or

 toll-free: 1-800-879-3355
toll-free: 1-888-798-7561
toll-free: 1-800-671-3355
toll-free: 1-800-357-3355
toll-free: 1-800-247-4618
toll-free: 1-800-727-8320

toll-free: 1-877-DELLTTY
(1-877-335-5889)

U.S. Virgin Islands Web Address 
E-mail Address 
Technical Support, Customer Service, Sales 

176Hwww.dell.com/vi
177Hla-

techsupport@dell.com
toll-free: 1-877-702-4360

Venezuela Web Address 
E-mail Address 
Technical Support, Customer Service, Sales 

178Hwww.dell.com/ve
179Hla-

techsupport@dell.com
0800-100-4752
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2 Installation 
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In order for vConverter to function properly, there are some general security 
configurations that need to be set: 

• You must have administrator access to the client machine on which vConverter 
will be installed. 

• You need an account with full administrative rights for each source and target 
server to be configured. 

• Windows Management Instrumentation (WMI) and Remote Procedure 
Call/Distributed Component Object Model (RPC/DCOM) must be enabled on the 
network. Confirm that WMI has not been disabled through Active Directory 
security policies. 

• Port 135 must be open. (WMI relies on RPC/DCOM, which communicates over 
port 135.) 

 
Warnings: If a source and target are not in the same domain and there is not a bilateral 
trust set up between the two domains, conversions will fail. If the client and source 
cannot contact each other, conversions will fail. 

 

System Requirements 

This section describes the hardware and software requirements for vConverter 
installation. 
 

38BLocation Requirements 
You can install the software on a physical or virtual machine. If you install vConverter on 
a physical machine, make sure that it is running a supported OS.  

You must have .NET Framework 2.0 installed on the physical machine. You can confirm 
this by accessing Start→Add or Remove Programs. You can install it through Internet 
Explorer→Tools→Windows Update or you can download it from the Microsoft website. 

The client machine must also meet the following criteria: 

• Pentium III class CPU or greater 
• 256MB RAM (512MB recommended) 
• 2GB free hard disk space (4GB or greater recommended) 
• 1024x768 video resolution (1280x1024 or greater recommended) 
• 100Mb/sec or greater network adapter 
• Windows Installer 3.1 is needed for installation. 
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109BSpecial Notes on Features 
• To use any of these features—Continuous Protection, Synchronized Cutover, or 

Right-Sized Virtual Disks—the source server must be running Windows XP or 
Windows Server 2003. These features will not work if the source is running 
Windows NT4 SP6a or Windows 2000. 

• To use the Synchronized Cutover or Continuous Protection features, you must 
have MS VSS installed. 

• To use VA, which is stored in zip/rar format, you must import it from outside the 
application and configure it. See Chapter 3 for instructions.  
 

 
 

• To use RDM, you must enable the option in the software. This is possible only if, 
on the target server, you have available devices that are not being used by another 
VM. The P2V to RDM feature will not be accessible in the software if an RDM is 
not available.   

• To use RCC, the source server must have at least 512MB of RAM.  

• If the boot volume on the source server is compressed, VistaPE will not load. 
When the source boots, you will be prompted to restart. The system will remain in 
the non-bootable state and will need to be reset manually. Before selecting RCC 
as the conversion type, cancel compression for boot volumes.  
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110BOS Requirements 
The vConverter executable (setup.exe) works with both 32- and 64-bit OSs.  
 

The following are supported:  

OS Service Pack Bit Level 

Windows Vista Business  N/A 32 and 64 

Windows Vista Ultimate N/A 32 and 64 

Windows XP Professional SP1 and SP2 32 and 64 

Windows Server 2003 SP1 and SP2 32 and 64 

 
 
The following are not supported: 

OS Service Pack Bit Level 

Windows 2003 R2 SP1 and SP2 64 

Windows 2008 N/A 32 and 64 
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39BVirtualization Platform Compatibility 
vConverter is compatible with these virtualization platforms: 

• VMware Workstation—any version 
• VMware Server  
• VMware ESX Server 3.x  
• VMware ACE  
• XenServer 4.1 and 5.0 
• Virtual Iron—any version 
• Microsoft Virtual PC 2004 
• Microsoft Virtual PC 2007 
• Microsoft Virtual Server 2005 
• Microsoft Virtual Server 2005 R2 

 

40BHost Compatibility 
vConverter is compatible with these 32-bit OSs (for conversion source): 

• Microsoft Windows NT 4.0 SP6a (for RCC only) 
• Microsoft Windows 2000 Professional—Base OS, SP1, SP2, SP3, SP4 
• Microsoft Windows Server 2000—Base OS, SP1, SP2, SP3, SP4 
• Microsoft Windows Server 2003—Base OS, SP1, SP2 
• Microsoft Small Business Server—any version 
• Windows XP Professional—Base OS, SP1, SP2 

 
vConverter is compatible with these 64-bit OSs (for conversion source): 

• Windows Server 2003—Base OS, SP1, SP2 
• Small Business Server—any version 
• Windows XP Professional—Base OS, SP1, SP2 

 
vConverter is not compatible with these 32-bit OSs (for conversion source): 

• Windows Vista Business and Ultimate 
• Windows 2008 
 

vConverter is not compatible with these 64-bit OSs (for conversion source): 

• Windows Vista Business and Ultimate 
• Windows 2008 
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111BPort Requirements  
If your environment includes any component (e.g., a firewall) that might restrict 
communication between the machines to be used in conversion, confirm that these ports 
allow for unimpeded access before you install the software. 
 
You will need UDP port 422 to enable data transfers directly to the target. Access over 
secure shell (SSH) TCP 22 and over the VMware SDK (433) to properly communicate 
with the target are required. From source to target, error checking and reconnect 
capabilities are in place to assist with troublesome communication links. There are no 
bandwidth control mechanisms, so conversions will complete only as fast as your 
available bandwidth allows.  

Note: Root SSH access is disabled by default in VI3. Setting up a non-root account and 
providing vConverter with the root password allows for conversions with root disabled 
over SSH. Otherwise, enable root over SSH by editing the PermitRootLogin value in 
sshd_config on the VI3 host: vi /etc/ssh/sshd_config.  
 

41BUse with Windows Firewall 
vConverter uses WMI, which requires RPC. Windows XP SP2 and Windows Server 
2003 SP1 install a Windows Firewall, which is turned on by default. This firewall 
disables RPC (port 135). If vConverter is installed on a machine with Windows Firewall, 
disable it or enable DCOM for the firewall. To disable it, access Control 
Panel→Windows Firewall. Do not leave Windows Firewall enabled and select 
vConverter as an exception. Doing so can impact usability. During conversions, make 
sure that you turn off the firewall on the source system. 
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112BUser Accounts and Passwords 
For each source and target, you must use a login with appropriate permissions. When 
inputting administrative credentials, use these formats: 

• If machines are part of a domain—Username: Domain\User 

• If machines are part of a workgroup—Username: Machine\User 

 
144BSwitch User/Root Access 
vConverter requires root access. For security reasons, many ESX Servers are configured 
so that a root user cannot log in directly from another computer. To gain root access, 
vConverter must connect with a non-root user ID and then switch user (su) to the root 
account. For the non-root ID and password, it is best to use the same ID and password 
that you selected for VC. 
 
145BPassword Security Setting Policy 
Weak passwords compromise system security. When you create and update passwords in 
vConverter, follow as many of these guidelines as your environment allows: 

• A password should not include a significant portion of a user or account name. 

•  Each password should be at least six characters long.  

• Passwords should contain characters from several of these categories: 

-Uppercase letters in English (A-Z) 

-Lowercase letters in English (a-z) 

-Digits 0-9 

-Non-alphabetic characters (for example, $, !, #, %) 

 

113BVizioncore Support Policy 
Vizioncore attempts to support all .dot versions of ESX Server within 60-90 days of 
release. However, changes to the platform can create unforeseen circumstances, causing 
an unexpected delay in providing support.  

Support for all major versions of ESX Server is to be determined. Vizioncore has the 
right to change this policy without prior notice or notification. 
 
GSX and ESX 2.x Support 
GSX and ESX 2.x are neither tested nor supported for vConverter.  
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8BInstalling vConverter 

Follow the instructions below to install vConverter on a workstation or server. PXE will 
install automatically. Later, you will have to start PXE service and activate the 
vConverter license. Since network latency can compromise performance, the software 
should not be installed on a network drive.  

Pre-requisites:  

• You must have administrator privileges on the workstation or server on which you 
install the software.  

• You must have access to setup.exe.  

Note: If .NET Framework 2.0 is not installed on your machine, you will be prompted to 
install it during this process.   

42BUpgrade to New Version of vConverter 
To upgrade to a new version of vConverter, there is no need to uninstall any previous 
version of the software. It will be removed automatically during upgrade installation. 

 

43BInstall vConverter and PXE 
1. From the desktop, double-click setup.exe.  

The WinZip Self-Extractor dialog displays. 
 

 
 

2. Click Unzip. 
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3. Click OK. 
 

 
 

The vConverter Setup Wizard dialog displays. 
 

 
 
 

4. Click Next. 
The License Agreement dialog displays. 
 

5. Read the license agreement. If you agree to its terms, select I Agree. 
Then, click Next. 
The Select Installation Folder dialog displays. 
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6. In the Folder field, specify the location where vConverter should be installed. The 
default is C:\Program Files\Vizioncore\vConverter\. 
 
If you want to change the location, edit the path directly. Or, click Browse to 
select a path. Click to highlight the location and then click OK. 
 
Warning: Do not install vConverter on a network drive. 
 

To view available disk space for all locations, click Disk Cost. Then, click OK. 
 

 
 
Click Next. 
The Confirm Installation dialog displays. 
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7. On the Confirm Installation dialog, click Next. 
The installation process begins. 
 
When the process is complete, the Installation Complete dialog displays. 
 

 
 
 

8. Click Finish. 
vConverter online help and First Run dialogs display unless you deselected these 
options. 
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9. On the First Run dialog, click Close. 
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44BPXE Service 
PXE delivers boot image files to remote systems through the Trivial File Transfer 
Protocol (TFTP). You can start or stop PXE service through the Program 
Preferences dialog.  
 

 
 

45BStart PXE Service 
1. First, confirm that PXE service is not running. To do this, you can: 

 
Access the setting on the General tab of the Program Preferences dialog. 
 

 
 
OR  
 
Right-click My Computer→Manage→Services and Applications→Services. 
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2. From the General tab of the Program Preferences dialog, click Start PXE service. 
 

 
 
The PXE service control status changes to Running. 
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9BAccount License Activation 

Before using vConverter for the first time, you must activate a license. This process 
requires a serial number, which was emailed to you. If you have not received this email, 
contact Customer Support for assistance. 

There are several activation methods: 

• Online activation 

• Offline via email 

• Online to an activated upstream system 
Warning: Once you have activated a licensed copy of vConverter, you will not be able to 
reactivate it.  

 
If you need to add additional conversions to an existing vConverter installation, refer to 
the Update Current License procedures below. 

 
Until you activate licensing, this error message will display when you attempt to use 
vConverter. Click Activate to open the Activation Wizard and start the license  
activation process. 

46B  
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47BOnline Activation—Register New License 
Completing the online activation process requires a live Internet connection.  

1. From the vConverter window, select Help→Activation. 

 
2. On the Activation Wizard, select Register New License. Click Next. 

 

 
 

3. Select Local and then click Next. 

OR 

Select Upstream, then populate the Server name field and then click Next.  

 

 
 

4. Select Activate online with Vizioncore and then click Next. 
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5. If you access the Internet through a proxy server, click Proxy settings. Populate 
the fields on the Activation Proxy Settings dialog and click OK. Then, click Next 
on the Activation Wizard. 
 
 

 
 

6. Populate the Serial number field. Then, click Next. 
 

 
 

7. When the activation process has completed, a confirmation dialog displays. Click 
Finish to launch vConverter. 
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48BOnline Activation—Update Current License 
Completing the online license update process requires a live Internet connection.  

1. From the vConverter window, select Help→Activation. 

 
2. On the Activation Wizard, select Update Current License. Click Next. 

 

 
 

3. On the Activation Wizard, click Next. 
 

 
 

4. Select Local and then click Next. 

OR 

Select Upstream, then populate the Server name field and then click Next. 
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5. Select Activate online with Vizioncore and then click Next. 
 
If you access the Internet through a proxy server, click Proxy settings. Populate 
the fields on the Activation Proxy Settings dialog and click OK. Then, click Next 
on the Activation Wizard. 
 

 
 

8. Populate the Serial number field. Then, click Next. 

6. 49BWhen the activation process has completed, a confirmation dialog displays. Click 
Finish to update vConverter. 
 

50BOffline Activation via Email—Register New License 
You can activate the vConverter license offline via email.  

1. From the vConverter window, select Help→Activation. 

 
2. On the Activation Wizard, select Register New License. Click Next. 
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3. Select Local and then click Next. 

OR 

Select Upstream, then populate the Server name field and then click Next. 
 

4. Select Activate offline with Vizioncore through email and then click Next. 
 

 
 

5. Populate the Serial number field. Then, click Next. 

6. Enter an activation request path and filename (e.g., c:\request). 
The file will be created automatically. An .areq suffix will be appended to the 
filename (e.g., c:\request.areq). 
 
Note: For future reference, it is a good idea to note the path that you selected. 
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9. Email the file as an attachment to 180Hactivate@vizioncore.com. No need to specify a 
subject or provide details in the email. Vizioncore will validate the serial number 
and reply with an activation response file (.aresp), activating vConverter.  

10. Save the .aresp file to a folder on the computer where vConverter is installed. 

11. In the Open response file window, click the browse ellipsis (…) adjacent to the 
Path to file field. Navigate to the .aresp file and double-click it.  
File information displays in the Path to file field. 

12. When the activation process has completed, a confirmation dialog displays. Click 
Finish to launch vConverter. 
 

51BOffline Activation via Email—Update Current License 
You can update the vConverter license offline via email.  

 
1. From the vConverter window, select Help→Activation. 
 
2. On the Activation Wizard, select Update Current License. Click Next. 

 

 
 

3. Select Local. Populate the Server name field and click Next. 
 



 

vConverter v4.1  Chapter 2 Installation  54  

4. Select Activate offline with Vizioncore through email and then click Next. 
 

 
 

5. Populate the Serial number field. Then, click Next. 

6. Enter an activation request path and filename (e.g., c:\request). 
The file will be created automatically. An .areq suffix will be appended to the 
filename (e.g., c:\request.areq). 
 
Note: For future reference, it is a good idea to note the path that you selected. 
 

 
 

13. Email the file as an attachment to 181Hactivate@vizioncore.com. No need to specify a 
subject or provide details in the email. Vizioncore will validate the serial number 
and reply with an activation response file (.aresp), activating vConverter.  

14. Save the .aresp file to a folder on the computer where vConverter is installed. 

15. In the Open response file window, click the browse ellipsis (…) adjacent to the 
Path to file field. Navigate to the .aresp file and double-click it.  
File information displays in the Path to file field. 

16. When the activation process has completed, a confirmation dialog displays. Click 
Finish to launch vConverter. 
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52BOnline Activation to Upstream System 
Using the upstream approach, you can manage vConverter licensing easily and decrement 
usage centrally. Upstream activation is particularly useful if you have a large number of 
conversions to perform with many clients using a single license. You must have 
RPC/DCOM (port 135) enabled on your network. 
 

• First, plan and activate a central system that can be accessed easily by other 
systems. By doing this, you make your central system the master license server. 
You can activate this system online or offline via email.  

• Next, distribute both the software for clients to install and the serial number to use 
during activation.  
 

1. Create the vConverter upstream license server by running the installation and by 
obtaining a serial number that enables downstream licensing. 

2. Activate the serial number using one of the methods described above.  

3. Record the license server’s IP address and/or Domain Name System (DNS) name. 
You will be prompted for that information when installing vConverter on 
downstream computers that are allocated to perform conversions. The license 
server tracks the number of source systems to be converted.  

4. From a downstream computer where you are installing vConverter, point to the 
upstream license server that has been activated. Start the application. 

5. Select Upstream (for downstream installations). Enter the computer name or IP 
address.  

6. Once the vConverter computer connects to the upstream license server, the 
Activation information window will display. On it, enter the serial number and 
click Next.  

7. Upon successful activation, click Finish to launch the application. 
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3 Configuration 
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10BConfigurations 

Now that vConverter  is installed, you can launch it by double-clicking the desktop icon 
or by accessing it through the Start menu. The software requires a number of application 
and environment configurations to ensure that it functions properly. They are described in 
detail below.  

53BvConverter and ESX VA 
 
VA can be used to help vConverter capture physical hosts. Before you can use ESX VA 
or Xen VA, you must import it into the virtualization platform and properly configure it. 
You can use ESX VA with ESX versions 3.5-3i. Earlier versions of ESX do not support 
virtual disk hot plugging/unplugging. 
 
VA has the Vizioncore SFTP agent running and other specific software to facilitate 
connectivity for conversion purposes. VA is based on Linux RedHat 5 OS and uses two 
virtual disks—the first is for the root file system (/) and the second for its environment 
(/tmp,/var and swap). 

 
ESX VA’s configuration is slightly different than Xen’s. It also consists of two disks—
plugged into different SCSI controllers (LSI logic and Bus logic). This is necessary 
because there are different virtual disk types in an ESX environment. If you need to 
create and work with an LSI or Bus logic disk, then it will connect to a corresponding 
SCSI adapter in a VA. All other stages in the process are similar to what is described for 
Xen below. Note that virtual disks connected to VA look like /dev/sdc, /dev/sdd because 
they are connected to a SCSI adapter (emulation). 

Before you begin this process confirm that you have access to the following: 

• A VC via Virtual Infrastructure Client (VIC). 

• The Internet. 

• A supported version of ESX Server—ESX 3.5, including Updates 1 and 2; ESXi 
3.5, including Updates 1 and 2. 

• A supported version of VC—version 2.5, including Updates 1 and 2. 
 

54BConfigure VA to Boot First 
You must confirm that the VA disk is placed first in boot priority.  

1. Power on the VA. 

2. Press F2 to access the VM BIOS. 
 
If there is no boot screen delay (where you can press F2 to enter Bios), access 
Virtual Machine settings. Use Options→Boot Options parameter to set an 
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appropriate boot delay time (Power-on boot delay). Then, you will be able to see 
the boot screen. 

3. Go to the Boot menu and select Hard Drive.  

4. Using the plus (+) or minus (–) signs, move the Seagate Disk (0:0) to the top of 
the list. Press F10—Save and Exit. 

55BInstalling VA on ESX Server 
First, you must import the VA from file or from a URL. You can download the VA from 
the vConverter Add Ons page on the Vizioncore website: 
182Hhttp://www.vizioncore.com/vConverter/addons/.  Once you are on the page, select VA for 
VMware ESX Server download link. Then, save the file. 

You have two options for importing VA—from file or from a URL. If you have already 
downloaded the VA package and know the .ovf file, it is best to import from file. If your 
VC is connected to the Internet, you can easily import from a URL. 
 

1. Connect to VC. 

2. From the VI Client menu, select File. 
 

 
3. Access File→Virtual Appliance→Import.  
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Continue to step 4 to import from file. Skip to step 8 to import from URL. 
Whether you are importing from file or URL, you will resume the sequence at 
step 11. 

4. In the Import VA Wizard, select Import from File. 

5. Click Browse, and navigate to the location of the VA for ESX files. 
Note: While browsing, you must select the ESX VA<version>.ovf. 
 

 
6. Click Next. 

 
Note: The VA for ESX requires 1.5GB of storage space on the target volume. 
 

 
 

7. On the VA Details dialog, click Next. Skip to step 12. 
 

8. To import from URL: On the Import VA Wizard, select Import from URL. 
Enter the URL that points to the .ovf file of the VA for ESX. 
 

 
9. Click Next. 

 
Note: The VA for ESX requires 1.5GB of storage space on the target volume. 
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10. Click Next. 
 

11. Whether you are importing from file or URL, continue at this step. Select a 
location for the VA. Click Next.  
 

 
 

12. Select a storage volume on which to install the VA for ESX. 
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13. Click Next. 
 

14. On the Network Mapping dialog, select a network from the dropdown. 
Click Next. 
 

 
 

15. On the Ready to Complete dialog, confirm your selections. Click Next to import 
the VA. This process can take several minutes. 

16. In the VIC, locate the VA that you created. Click to highlight it. 
 

 
 

17. Power on the VA by clicking the Power On icon  or through the Getting 
Started tab by clicking Power on the virtual machine. 
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18. Once the machine is powered on, click the Console tab of the VIC. To shift 
keyboard focus to the VA, click anywhere on the console screen. (To retrieve 
focus, use the Ctrl+Alt keys.) 
 

 
 

19. At the localhost and Password login prompts, respectively, enter these values: 
Login: root 
Password: root123 
 
You should see a Last Login time followed by the root prompt: 
 

 
 

20. To change the root password, enter passwd at the root prompt. You will be 
prompted for a New UNIX password. 
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Warning: Because of the importance of the root account, certain limitations exist 
for root passwords. Use a combination of uppercase and lowercase letters, 
numbers, punctuation, and other characters. Do not use a word or name. 
Obscuring the word or name with substitute characters is not effective. Do not use 
the same password for more than one system. These are examples of good 
passwords:  f9*@1Ls99A and HL8$391%%rb. 
 

21. The VA for ESX comes configured for DHCP. If you wish to use DHCP, then no 
configuration is necessary. To view the IP configuration, type ifconfig at the root 
prompt. The configurations for all configured network links display. 
 

 
 

22. Configure a static IP. At the root prompt, enter system-config-network-
tui. 
 

 
 

23.  On the Network Setup utility, use the arrow keys to navigate to the device. Click 
Enter. On the Devernet Configuration dialog, confirm that Use DHCP is selected. 
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24. Navigate down to Use DHCP. Press the spacebar to deselect it. The Static IP, 
Netmask, and Default gateway IP options will enable. 

25. In the Static IP field, enter an IP address. 

26. In the Netmask field, enter the subnet mask for this IP address. 

27. In the Default gateway IP field, enter the IP of the default gateway. 
 

 
 

28. Navigate down to OK and click Enter. 

29. On the Select A Device dialog, use the tab key to select Quit. Then, click Enter. 

30. Restart the VM. The settings will take effect. 
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56BConnect vConverter to ESX Server 
Without proper credentials, conversions will fail. It is critical to test your connections 
before starting a conversion directly to ESX. Also, confirm that there is a DNS entry in 
place for the IP address that you intend to use. Otherwise, this message will display at 
step 8: 
 

 
 

1. Select Tools→Preferences→ESX Server. 
 

 
2. Click Add. 

3. Enter the IP address of the ESX Server. 

4. With non-root credentials, populate the Password and Verify password fields. By 
default, vConverter populates the Username field. 

5. Populate the Root password and Verify root password fields.   
 
Note: VMware does not allow remote root connections.   

6. Select the Enable VA feature checkbox. The Enable vzBoost and Create a User 
if doesn’t exist checkboxes are selected by default.  
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7. Click Advanced. Make any necessary changes on the Advanced properties dialog 
and click OK. 
 

 
 
Note: These settings should only be changed if the port numbers are incorrect for 
your network. If this is the case, vConverter will not be able to communicate with 
the ESX Server. 
 

8. To configure vConverter to use VA to write to the ESX Server, click VA Config.  
 

9. Populate the fields on the VA Configuration dialog and click OK. 
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10. On the ESX Server tab, click Install. 
vConverter will attempt to configure your server. The status message will indicate 
if configuration was successful.  
 

 
 
Note: If the configuration was unsuccessful, verify the username, password, and 
port numbers listed on the Advanced properties dialog. 
 

11. On the Configuring dialog, click Close.  
The server address is listed in the Servers area of the ESX Server tab. 
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12. Click Test to confirm the connection. 
 

 
 

13. If the test is successful, close the window and click OK on the Program 
Preferences dialog. You can begin your first conversion. 
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57BvConverter and Xen VA 
 

• vConverter prepares an SFTP agent in a VA, confirms that it is running, and 
accepts all connections. This can be done through Preferences→Xen Server. 

• After you have selected source and destination hosts and set all options, click 
Start to initiate capturing. 

• vConverter selects partitions to capture one-by-one and starts DCT on a Source 
host. 

• DCT creates a new virtual disk on XenServer (VDI) with the correct size and 
plugs it to a VA (under /dev/xvdc,/dev/xvdd,… names). It uses the SFTP agent to 
write to that block device and performs other related operations (e.g., resize, 
truncate) with it.  

• When DCT exits vConverter, all virtual disks involved in the capturing process 
are unplugged. 

• On the migrating stage, vConverter plugs all disks into a VA and mounts them to 
a host where it runs. 

• When migration is compete, all disks are unmounted from the Windows host, and 
then unplugged from VA. 

 

58BConfigure VA to Boot First 
You must confirm that the VA disk is placed first in boot priority.  

1. Power on the VA. 

2. Press F2 to access the VM BIOS. 
 
If there is no boot screen delay (where you can press F2 to enter Bios), access 
Virtual Machine settings. Use Options→Boot Options parameter to set an 
appropriate boot delay time (Power-on boot delay).  
Then, you will be able to see the boot screen. 

3. Go to the Boot menu and select Hard Drive.  

4. Using the plus (+) or minus (–) signs, move the Seagate Disk (0:0) to the top of 
the list. Press F10—Save and Exit. 
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59BInstalling VA on XenServer 
1. Obtain a VA package and unpack it into any directory. It should contain at least 

one *.xva file. 

2. Run the XenCenter Management utility and verify free space in any Xen storage 
repositories. You will need approximately 1.2GB. 

3. Access Templates→Import Template and select Exported template.  

4. Click Browse and select the Xen VA file (*.xva). 

5. After import completes, confirm that the new template displays on the XenServer. 

6. Create a VM using the template by selecting VM→New.  
 
Notes: You will not need more than 256MB RAM. Except for the VM name, it is 
best to use the default parameters. This process can take several minutes. 
 

 
7. Start the VA VM by entering these credentials: 

Login: root 
Password: xen123 

8. Obtain the VM’s IP address. 
 
Warning: To ensure that the VA works correctly, set it to the correct physical 
network. Edit the VA settings to include the correct virtual switch/network from 
within XenCenter. Click the VM’s Network tab and click Edit. 
 
-If there is a DHCP server in the network, then the VA already has an 
automatically assigned IP address. To get it running, use the ifconfig eth0 
command; locate an IP address after inet addr. 
 
-If the IP addresses in the network are assigned statically, then assign an address 
to VA manually. To do this, run the setup command in the console window. The 
setup utility uses <Tab> and <Enter> keys to navigate in menus and <Space> for 
changing values. Enter static IP, mask, and default gateway values for the VA. 
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9. After the network address is configured, enter service network restart 
to instantiate it. 
 
At the end of this process, you will have the following: 
-VA name on Xen 
-VA IP address 
-Login credentials (root/xen123) 
-Two virtual disks that VA uses 
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60BConnect vConverter to XenServer 
In the first part of this process, you configure vConverter to connect to XenServer. In the 
second part, you configure VA to help vConverter write to the Xen host. It is critical that 
you test your connection before beginning a conversion to XenServer. Without proper 
credentials, conversions will fail. 

1. Select Tools→Preferences→Xen Server. 
 

 
2. Click Add. 

3. Enter the IP address of the XenServer. 

4. With non-root credentials, populate the Root password and Verify root password 
fields. By default, vConverter populates the Username field. 
 
Note: VMware does not allow remote root connections.   

5. Select the Enable VA feature checkbox.  

6. Click Advanced. Make any necessary changes on the Advanced properties dialog 
and click OK. 
 

 
 
Note: These settings should only be changed if the port numbers are incorrect for 
your network. If this is the case, vConverter will not be able to communicate with 
the Xen Server. 
 

7. To configure vConverter to use VA to write to the XenServer, click VA Config.  
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8. Populate the fields on the VA Configuration dialog and click OK. 

9. On the Xen Server tab, click Install. 
vConverter will attempt to configure your server. The status message will indicate 
if configuration was successful.  
 

 
 
Note: If the configuration was unsuccessful, verify the username, password, and 
port numbers listed on the Advanced properties dialog. 

10. On the Configuring dialog, click Close.  
The server address is listed in the Servers area of the Xen Server tab. 
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11. Click Test to confirm the connection. 
 

 
 

12. If the test is successful, close the window and click OK on the Program 
Preferences dialog. You can begin the first conversion. 
 
 

Convert Using TSA 

TSA is an application that serves these types of incoming requests: 

• Create new disk image. 

• Resize (both shrink and expand) existing disk image. 

• Write new data to the disk image at specified offset. 

• Read data from the disk image at specified offset. 

TSA is run by xinetd daemon when a new incoming request arrives to TCP port. Then, if 
necessary, it calls the vmkfstools utility for doing operations with disk images—creating 
disk images and resizing. TSA uses SFTP protocol to exchange the disk data with the 
remote program—DCT or VDD.  

61BConfigure Email Notification 
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You can configure vConverter to send email alerts when conversion jobs have started, 
succeeded, and failed. In addition, you can request that notifications are sent during 
intermediate synchronizations. 
 

1. Select Tools→Preferences. 

2. Click the Email Notifications tab. 

3. To be alerted when a conversion job completes, select Enable in the Email 
Notification of Conversion Completion area.  
 
-Enter the email addresses of those you want to notify. 
-Populate the Email subject field. 
-Select the checkboxes to request that logs and/or HTML reports be attached to 
the emails in the event of conversion success or failure. 
 

 
4. To be alerted when a conversion job completes, select Enable in the Email 

Notification of Conversion Start field.  
 
-Enter the email addresses of those you want to notify. 
-Populate the Email subject field.  

5. In the Email Sending Options area, select a radio button—use MAPI or 
use SMTP.  
 
If you select the latter, the Configure button will be enabled.  
-Click it to access the Configure SMTP Preferences dialog. 
-Populate the fields on the dialog and click OK.  
-To test the server connection you just configured, click Test Server Connection. 
-Then, click OK. 
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6. Select the Send Messages on Intermediate Synchronizations checkbox if you 
want to receive status notifications between the start and end of a conversion job. 
Click OK.  
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62BChange Login Credentials 
You can change the login for the source server manually or by using an existing profile. 
You can save a user profile on the Set Credentials dialog to make this login information 
available for future use. 

1. Navigate to the All Systems tab on the Network Browser pane. 

2. Click to highlight the server for which you want to change the login credentials. 

3. Right-click to select Change login. 
The Set Credentials dialog displays. 
 

 
 

4. Select a radio button—Use credentials from the profile or Specify credentials 
manually. 
 
Note: The appropriate fields will be enabled based on the selection that you make. 

5. If you are changing the login using a profile, make a selection from the Profile 
name dropdown.  
 
If you are completing the process manually, populate the Username field and then 
enter a password. To retain the profile for future use, select the Save as a new 
user profile checkbox. 
 

6. Click OK. 
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63BAdd User Profile 
1. Select Tools→Preferences. 

2. Click the User Profiles tab. 
 

 
 

3. Click Add. 

4. On the User Profile Settings dialog, populate the Name, Login, and Password 
fields. Click OK. 
 

 
 
The user profile is added. 
 

 
 

5. If you would like the system to prompt for a login always, leave the Always 
query for credentials radio button selected and click OK. 
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64BSet User Default 
1. Select Tools→Preferences. 

2. Click the User Profiles tab. 

3. Click to highlight the user profile that you want to set as the default. 
Click Set Default. 
The profile that you set as the default displays in boldface. 
 

 
 

4. Select the Use default user profile radio button. Click OK. 
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65BEdit User Profile 
1. Select Tools→Preferences. 

2. Click the User Profiles tab. 

3. Click to highlight the user profile that you want to edit. Click Edit. 
 

 
 

4. On the User Profile Settings dialog, make the updates. Click OK. 

 
66BAdd Task Profile 
The tabs of the Task Profile Properties dialog are almost identical to those of the 
Advanced Properties dialog, except that the former does not include properties specific to 
source systems. 

1. Select Tools→Preferences. 

2. Click the Task Profiles tab. 
 

 
 

3. Click Add. 
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4. On the Task Profile Properties dialog, populate the Name field in the Task 
profile info area.  
 
Note: If you do not populate this field, an error message will display later in 
this process. 
 

 
 

5. On the Disks tab, configure the task. 

6. Click the VM tab. Configure the task. 
 

 
 
To configure a VM, click Configure VM. Populate the fields on the VM Options 
dialog and click OK. 
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To set a login, click Set Login. Populate the fields on the Login for Auto Logon 
dialog and click OK. 
 

 
 

7. Click the Migration tab. Configure the task. 
 

 
 
Click Script Settings. Make any file or folder configurations and click OK. 
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8. Click Add File to locate a file to add.  

OR 

9. Click Add Folder to browse for a folder that contains the script that you want to 
add. If the selected folder contains more than one executable file, you will be 
prompted to select the correct file from the List of files. 
 
After you add a file to the executables list, the Add File button in the Added files 
section is enabled. You can now add it as a dependent file. 
 

 
 
Once you download an executable, the Set file to Run button will activate. Click 
it and then click OK. 
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10. Click the Login tab. Configure the task. 
 

 
 

11. Click OK to save all changes.  
The task is available on the Task Profiles tab. 
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Set Task Default 

1. Select Tools→Preferences. 

2. Click the Task Profiles tab. 
 

 
 

3. Click to select the task profile that you want to set as the default. Click Set 
Default. 
The profile that you selected displays in boldface in the Task Profiles section. It 
also displays in the Default profile field. 
 

 
 

4. Click OK. 
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67BEdit Task Profile 
1. Select Tools→Preferences. 

2. Click the Task Profiles tab. 

3. Click to highlight the task profile that you want to edit. Click Edit. 
 

 
 

4. On the tabs of the Task Profile Properties dialog, make the updates. Click OK. 

5. On the Program Preferences dialog, click OK. 
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68BUse P2V to RDM 
Before you begin this process, confirm that the devices are available on the target and 
that they are not being used by another VM. This feature is not accessible if an RDM is 
not available.  

1. In the Conversion Tasks pane, click Browse. 

2. Click to select a location where the mapping file can be stored. Then, select Use 
RDM.  

3. Select a radio button—physical or virtual. 
 
Note: Physical mode allows the VM to access the device directly. Virtual allows 
you to enjoy the benefits of the .VMDK file (such as snapshots) on the mapped 
device. 

4. From the dropdown, select a device. Click OK.  
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69BConfigure Source Servers for RPC 
Source servers must be configured to allow RPC calls.  

1. Add this key below to the registry of the source server: 
HKEY_LOCAL_MACHINE\Software\Microsoft\Rpc\Internet 

2. Add these parameters to it: 
-Ports (REG_MULTI_SZ). Specify a range of ports used for RPC connections 
(e.g., 5000-5100). 

3. Add these ports to the firewall exception list:  
PortsInternetAvailable (REG SZ). Value: Y 
UseInternetPorts (REG SZ). Value: Y 

4. Add this port to your firewall exception list: 
Enable port 135  

 

70BUsing a Setup File Location 
To convert a Windows system vConverter requires access to certain files from the 
Windows installation. In most cases, you will find these files in one of these locations: 

• %windir%\Driver Cache  

• %windir%\ServicePackFiles 

Occasionally, an administrator will have to remove the files from these locations 
manually or programmatically by running the SFC /PURGECACHE command. If this 
becomes necessary, a message displays. 

 
 

When system files required for conversion are not found in the system being converted, 
those files and service pack source files must be extracted and made available in the setup 
file location. 

If you are converting a system that has a service pack installed, obtain the original service 
pack and extract it to a location that you specify in the setup file location. If there is no 
service pack installed on your source server, configure the Setup File Location as the 
i386 directory from your original installation media.  
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If these files are not found, vConverter will not be able to complete a conversion if it is 
the first of this OS type. If this OS type has been converted previously, the files have 
been cached and vConverter will not need to capture them from the source. There are two 
workaround options that will allow you to continue.  

1. Access Setup Files Location through Tools→Preferences→Conversion. 
 

 
 

2. To use the Setup Files Location feature, do one of the following: 

• Insert the %windir%\Driver Cache from another server, which is accessible from 
the workstation where vConverter is running (e.g., 183H\\server\c$\windows\Driver 
Cache\i386) 

OR 

• Enter the location where the files are extracted and located centrally. 

Note:  vConverter Cache contains the files required to convert a system. If you want to 
convert a Windows 2000 Server SP4 but the required files are missing, vConverter will 
use the files from the cache, which is located at C:\Documents and 
Settings\<profile>\Local Settings\Application Data\Vizioncore\vConverter\Cache.  

 

114BPrepare Setup Folder for Windows NT SP6a 
To prevent unwanted conversion failures due to missing setup folder files, you can 
provide a location for all setup folders using the Program Preferences dialog. To prepare 
for converting Windows XP SP2: 

• Add a new record into this grid. 
• Specify OS and SP.  
• Then, point to location of the raw SP2 files, or installation of Windows XP with 

applied SP2 (\i386 folder). 
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Note: You must complete this sequence to prepare a setup folder for Windows 
NT SP6a. 

1. Download the NT4SP6a SP from the Microsoft website. 

2. On any Windows system, run the executable. 

3. When you are prompted for a folder to extract files, select or create one and 
continue the installation process. 

Warning: If an error displays, do not close the form.  

4. Go to folder with the extracted files and copy all files to a new location. Now, you 
can use this location for the setup folder. 

5. Target disk adapters for NT4 can be SCSI or IDE.  

• You do not need to confirm anything to migrate to IDE. 

• If you migrate to SCSI, you will need a buslogic.sys driver, which is in the 
distribution of NT4; not in the SP. Manually copy the driver from NT4 
distribution to the setup folder or copy the setup folder to the  
distribution location. 

 

115BSPs and OS Source Files 
Successful conversions require OS source files and extracted SP source files. If you are 
converting a base installation of any Windows OS, vConverter will require access to the 
server source files (e.g., installation CD or files from the CD on an accessible share).  

If you are converting a Windows OS that contains an SP, vConverter will require access 
to the extracted SP source files but not the base OS source files (e.g., CD or files from the 
SP extracted onto an accessible share). If you are converting a large number of servers 
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you should extract SP files onto a file server for easy access. First, download the SPs for 
Windows XP, Windows 2000, and Windows 2003. Then, extract them to a folder that 
you can locate easily using the Conversion tab. 
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4 Using vConverter 
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11BvConverter User Interface 

The vConverter window is the central navigational area of the software. This is where 
you can view the main components of the system. Through this window you can access 
the commands that allow you to configure and execute conversion jobs.  

Now that the software is installed, launch it through its desktop icon or the Start menu. 
The vConverter window features these areas: 

• Menu Bar 

• Toolbar 

• Network Browser Pane 

• Conversion Tasks Pane 

• Server Information Area 
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71BMenu Bar 
The Menu Bar contains the following options: 

 
 
File Menu 

Export 
settings 

Displays the Save as dialog from which you can export the settings 
that you defined through Tools→Preferences. This command allows 
you to maintain the same preferences on multiple systems and 
instances of vConverter. 

Import 
settings 

Displays the Open dialog through which you can import the settings 
that you configured previously. This command allows you to maintain 
the same preferences on multiple systems and instances of the 
software.  

Exit Closes the vConverter window and exits the software. 

 

View Menu 

Show/Hide 
Network Browser 

Toggles off and on to display or hide the Network Browser pane. 

 

Tools Menu 

Preferences Opens the Program Preferences dialog, which you can use to 
define preferences that are all saved permanently in:  
<user profile location>\ Local Settings\Application 
Data\Vizioncore\vConverter\Settings 
These settings can be imported or exported for use in other 
systems. Features these tabs:  

General—Define network settings, naming conventions, PXE 
service availability, and quick tip display. 

Conversion—Create setup folders with kernel and driver files. 
Prevent conversion job failures that result from missing setup 
folders. Enable advanced incremental file system transfer based on 
block and file size. 

Email Notifications—Select a notification method: Messaging 
Application Programming Interface (MAPI) or Simple Mail 
Transfer Protocol (SMTP). Enable or disable notification at 
start/finish of conversion jobs. Trigger email notifications for 
intermediate synchronization status. Enter email addresses to 
configure notification. 

ESX Server—Lists all ESX Servers that have been added to the 
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system. Test connectivity and verify credentials. Enable vzBoost 
and VA. Create a user profile for future use. 

Xen Server—Lists all XenServers that have been added to the 
system. Test connectivity and verify credentials. Enable VA. 

User Profiles—Allows you to enter credentials for individual 
source servers. Specify whether you want to use a default profile 
or have the system prompt for credentials. 

Task Profiles—List all task profiles for conversion jobs. Not tied 
to a particular source or target; task profile property tabs contain 
only general settings that are not based on server type. 
 
For additional information on the settings on this dialog, see the 
Program Preferences Dialog section later in this chapter. 

 

Conversion Menu 

Conversion 
Wizard 

Opens the Conversion Wizard dialog, which you can use to 
configure a conversion job. 

 

Help Menu 

Activation→Acti-
vation Wizard 

Opens the Activation Wizard dialog, which you can use to activate 
a vConverter license. You can complete activation online, through 
email, or by using the supplemental upstream method after initial 
activation. 

Help Opens online help, which includes general information about 
vConverter as well as instructions on how to configure the 
software, create and run conversion jobs, and so forth. 

User Manual Opens the PDF version of the vConverter User Manual that is 
packaged with the application.   

Support Opens the vConverter Technical Support Assistance window from 
which you can send support requests and capture log files. 

Clear Logs Deletes all application logs.   

Caution: Deleted logs will not be available for Support.  Use this 
feature selectively. 

About Displays information about vConverter, including: 

• software version 
• name of the user to whom the software is registered 
• serial number 
• number of conversions remaining 
• license expiration date 
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72BToolbar 
The Toolbar of the vConverter window features these icons: 

 Hide/Show Network Browser View 

 
Open Preferences 

 Run Conversion Wizard 

 
Create New Task 

 
Remove Task 

 
Edit Task 

 
Save Task 

 
Cancel Task Editing 

 
Start Task 

 
Stop Task 

 
Open Conversion Monitor 

 Open the About Window 

 

73BNetwork Browser Pane 
The Network Browser pane displays the domains and workgroups that include all servers 
available for conversion. This pane features two views—All Systems and Systems to 
Convert. 

116BAll Systems View  
The All Systems view displays a tree containing all of the network domains and systems 
available. From this view, you can copy a server to Systems to Convert so that you can 
use it as a source or target. When vConverter first starts, all network objects undergo 
background scanning. There is a limited number of scan threads (20). Each top level 
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domain runs its own thread. In addition to a domain/workgroup tree, the All Systems 
view contains two icons—Filter on and Refresh. When you right-click any object in the 
tree, a shortcut menu displays. These icons and commands are available: 
 

 
 

 Refresh 

 Filter On 

 
 

Refresh Refreshes the tree in the All Systems view of the Network Browser 
pane and launches scanning of a specified domain. 

Change 
Login 

Opens the Set Credentials dialog, where you can define the credentials 
for a source. You can create an administrator profile for each source, 
store the data, and then select it for reuse. 

Note: Select the Save as a new user profile checkbox to retain the 
credentials that you enter on the Set Credentials dialog. 

Add to 
Systems to 
Convert 

Automatically copies the selected server to the Systems to Convert 
view. From there, you can select any server as source or target. 

Create 
Conversion 
Task 

When you right-click a server and select this command, you will be 
prompted to save the task that you are about to define. Then, the 
system will confirm sufficient free space on the target and prompt you 
to select disk volumes. After you configure the task, you can run the 
conversion job. 

Note: If you have not configured the default task profile through the 
Program Preferences dialog, an error message to this effect will 
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display when you select this command.  

Add to 
Source 

When you right-click a server and select this command, the server 
name will be copied to the VM name field on the Conversion Tasks 
pane and will be available as a target. This command is available only 
for new blank tasks after you click the editing icon in the Conversion 
Tasks pane. Add to Source is not available for existing tasks—in this 
case, the command either displays disabled or it will not display at all. 

 

 

117BSystems to Convert View  
The Systems to Convert view features all of the servers that were copied from the All 
Systems tree. You can designate any of the servers as source or target. This view features 
several icons and a shortcut menu with commands. When you first access this view, only 
the Import systems to convert icon is enabled. The other icons will be enabled as soon as 
you copy a server into the view.  
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 Refresh 

 
Export systems to convert—Use this icon to remove any servers that 
you imported. 

 
Import systems to convert—Use this icon to add servers to the 
Systems to Convert view. 

 

Filter On—Use this icon to locate a system within even a large 
network. Search by system or IP address, one or multiple values, or 
wildcards. 

 
 

Quick Convert! Use this command to create a new conversion task based on an 
existing profile. All of the items listed in the Task Description text 
box of the Quick Convert dialog will be reconfigured based on the 
profile. Then, all of the items will be removed from the list.  

Create 
Conversion Task 

For every item in the Task Description text box, you can use this 
command to create a blank conversion task. The task will be based 
on a default template and the target server that you select. The task 
will remain on the Task Description list. 

Explore This command opens a source server through Windows Explorer. 

Remove When you select this command, the highlighted server is deleted 
from the Systems to Convert view.  
 
Note: You will not receive a confirmation prompt before the 
server is removed. 

Add to Source When you right-click a server and select this command, the server 
name will be copied to the source server hotspot on the 
Conversion Tasks pane and will be available as a source. This 
command is available only for new blank tasks after you click the 
editing icon in the Conversion Tasks pane. Add to Source is not 
available for existing tasks—in this case, the command either 
displays disabled or it will not display at all.  

 

 

118BQuick Convert 
You can use the Quick Convert command to run a conversion job based on an existing 
task profile. This command is only available by right-clicking a server in the Systems to 
Convert view of the Network Browser pane. For instructions on using the Quick Convert 
feature, see the Run a Quick Conversion section later in this chapter.  
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From the Quick Convert dialog you can view details about the profile. When you 
highlight a task on the list, the View Task Details button is enabled. Click this button to 
open the Task Details dialog. 
 

 
 
 

 

74BConversion Tasks Pane 
In this area of the vConverter window, you can access the commands that allow you to 
create and delete conversion tasks as well as run and schedule jobs. Defining basic 
properties for a job is discussed below. For information on advanced properties, see the 
section of the same name later in this chapter.  
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To enable the fields in the Conversion Tasks pane, click the Edit   icon. Just above 
the area where you define basic properties, there is a group of columns within the Source 
Drives field. 
 

 
 

Volume Identifies source volume and location. Select a checkbox for the 
volume you want to use in a conversion.  

Note: You must assign a drive letter. Otherwise, the disk will not 
display in the Volume field. 

File System Identifies file system type. 

Size, GB Identifies size of volume. 

Free, GB Indicates disk space free on the target. 

Resize GB Use the arrows in this field to enter a new size for a volume. You 
cannot make a partition smaller than the amount of data used in 
the volume.  

Notes: To secure an accurate value, you must make the change 
using the arrows. To decrease the size of a volume, you must 
enable the Create flat disk image option through Task Profile 
Properties→Disks. You can confirm that it is enabled on the 
Advanced Properties dialog. 

Folder Identifies the folder name for the target. 
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Basic Properties 

Virtual Machine 
type 

Refers to the type of target VM: 

• VMware ESX Server (ESX 3.x)* 

• VMware (VMware Workstation, VMware Server) 

• Microsoft Virtual PC (all Versions) 

• Legacy VMware (ESX 2.x)* 

• Microsoft Virtual Server (All versions) 

• Virtual Iron (All versions) 

• XenServer (4.0.1 and above)* 

*These VM types require that you enable Create flat disk image 
through Task Profile Properties→Disks.  

The Target dropdown is populated based on the value that you 
select in the Virtual Machine type field. 

VM name Name of VM. The default value is the name of source server. 
Volumes configured for alternate locations are created in a 
subdirectory that matches the value specified by the VM name 
field.   

Transfer Mode Select transfer mode—Block-Based or File-Based.  

Block-Based is the default. It allows you to skip unused sectors 
but it requires that the source and target disks are the same size.  

File-Based involves full file synchronization, a method most 
suited to large source volumes. 

Conversion type Specifies scheduled conversion type: 
• Manual 
• Single Conversion 
• Remote Cold Cloning 
• Synchronized Cutover 
• Continuous Protection 
• Different Destinations Cutover 

 
If you select any other conversion type but Manual, additional 
fields display. For instructions on using all of these conversion 
types, see the Create and Run Conversion Jobs section later in 
this chapter. 

Run at Specifies the date and time to start the scheduled conversion for 
Single and Remote Cold Cloning conversion types.  

Initial For Synchronized Cutover, Continuous Protection, and Different 
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Synchronization 
At 

Destinations Cutover, this field indicates the date and time of 
initial synchronization. 

Synchronization 
Interval 

For Synchronized Cutover, Continuous Protection, and Different 
Destinations Cutover, this field indicates the number of times 
within a particular timeframe (hours….) that synchronization will 
occur. 

Final 
Synchronization 
At 

For Synchronized Cutover, this field indicates the date and time of 
final synchronization. 

Current Activity This dropdown displays when you select Different Destinations 
Cutover as the conversion type. The values in this field include: 

• Initial Conversion—active 

• Changing Destination—paused 

• Final Synchronization—active 

Target Destination of conversion. This field is populated based on the 
value that you select in the Virtual Machine type field. If you 
select conversion to ESX Server or Xen, this is a network shared 
folder or explicit server address. 

Target Folder Location of the VM on the target server. If you do not specify a 
folder value during job configuration, the VMDK file location 
defaults to the same location as the VM configuration files in the 
Target Folder field. 

Note: If you select a folder that begins or ends with a whitespace, 
an error message will display.  

Use Profile for 
Conversion 

Populates with data based on profiles created earlier. Default is 
(none). After you select a profile from the dropdown, the Apply 
button adjacent to the field becomes enabled. It remains disabled if 
the value is (none). 

Advanced Opens the Advanced Properties window, which features general 
information about altering the virtual disk type and Hardware 
Abstraction Layer (HAL) type. When you close that window, the 
Advanced Properties dialog displays with several tabs—Disks, 
VM, Migration, and Login. For additional information the fields 
on these tabs, see the Advanced Properties section in this chapter. 

Cutover Now This button displays when you select Synchronized Cutover as the 
conversion type. 

 

 

There are several buttons and icons on the Conversion Tasks pane. 
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New Task Opens the New Task Editing window that contains general 
instructions on creating a new task. 

Remove Task Click this button to delete the selected task from the Task 
Description list. 

Start All Tasks Click this button to initiate all conversion jobs.  
 
Note: Using this command will override all existing schedules for 
conversion jobs. 

Scheduler Opens the Conversion Tasks Scheduler window, where you can 
view the dates and times for all scheduled conversions. From this 
window, you can reschedule a conversion job through the 
Appointment dialog. 

Note: For a task to display in this dialog, first it must be 
configured and saved. 

 

 
 
119B

 
 

<undefined> 
<undefined> 

 

After you select a source and target, the server 
names display from left to right, respectively, in 
place of <undefined>. 

 

 
 

Edit conversion task properties:  Use this command 
to make changes to an existing task. 

 

 
 

Open the Conversion Monitor window for this task: 
Access this window to check on the progress of a 
conversion job. The window features several 
columns—Status, Action, and Progress. 

 

 
 

Start conversion:  Click this icon to launch a 
conversion job immediately. Doing so will override 
any previously scheduled jobs. If this icon displays, 
then the job has not yet been run. 

 

 
 

Stop conversion: This icon displays while the job is 
running. Click it to stop the conversion. 
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To the left of the source listed in this pane, several status icons display.  
 

 

 
 

Conversion job running 

 

 
 

Conversion job finished successfully 

 

 
 

Conversion job failed  

 

 
 

Conversion job stopped 

 

 
 

 Conversion job paused or not yet started 

 
 

120BConversion Monitor Window 
This window provides progress information about conversion jobs that are running or 
have completed. The steps that display in the Action column are not necessarily in 
precise sequential order. That is, if multiple conversions are running simultaneously, the 
“Capture running” step will advance to 100.0% for the first volume and then reset to 
begin progress toward 100.0% for the second volume.  
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Several status icons and a button are available on the Conversion Monitor window.  

 

 
 

Conversion step not started or paused 

 
 

 

Conversion step running now 

 
 

 

Conversion step completed successfully 

 
 

 

Conversion step failed 

 
 

 

Conversion step stopped by user 

 
 

 

Click this button to display a log.  

121BConversion Tasks Scheduler Window 
This window displays all scheduled conversion jobs in a calendar format. You can 
reschedule a conversion job by editing it. If you double-click on a conversion job within 
the window, the Appointment dialog displays. Use this dialog to reschedule a job to run 
on another date at another time. 
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122BProgram Preferences Dialog 
You can access the Program Preferences dialog through Tools→Preferences. 
Descriptions of all of the fields on this dialog’s tabs are below.  
 
General Tab 
 

 
 

Network Settings Limitation of total simultaneous conversions: 
The value you enter in this field will restrict the number of 
conversions that you can run simultaneously. 

Limitation of simultaneous conversions to the same target server: 
The value you enter in this field will restrict the number of 
conversions that you can run simultaneously to each target server.  

Note: The values that you enter in these fields will depend on your 
environment’s capacity in several areas—for example, host 
memory, network bandwidth, and CPU availability. 

Naming 
Conventions 
Settings 

vConverter default—Software appends an underscore and drive 
letter to the server name (e.g., ABC.c.vmdk). 

VMware® default— Software appends an underscore and number 
to the server name (e.g., ABC.vmdk, ABC_1.vmdk, 
ABC_2.vmdk) for multiple VMDKs. 

PXE service 
control 

PXE Service is used to transfer the Vista PE image to target 
systems via the network. Refers to current PXE service status. 
Two statuses are available:  

• Start 
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• Stop PXE service 

Tips Select this option to display tips throughout the application—
Show quick tips. 

 

Conversion Tab 
 

 
 
Operating System The name of the OS that you intend to migrate. 

Bit Select either a 32-bit or 64-bit source. 

SP Refers to the service pack of the OS to be migrated. 

Location for 
Windows® setup 
or Service Pack 
files 

Indicates the location for storing the kernel and driver files 
required for OS migration. 

Advanced 
Incremental File 
System Transfer 

Allows you to enable incremental file system transfer based on 
block and file size. 

Remote Cold 
Cloning Timeout 
Countdown 

Allows you to configure the amount of time that passess between 
rebooting a source server and the actual conversion process. 

Add/Remove Use these buttons to add or remove setup folders within 
the system. 
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Email Notifications Tab 
If you enable these fields, you will receive notifications of conversion jobs that succeed 
or fail. You can trigger emails at job initiation as well as intermediate synchronization.  
 

 
 

Email 
Notification of 
Conversion 
Completion 

Select the Enable checkbox to activate these fields: 

Email addresses to send—Use this field to enter email addresses 
for those who should receive alerts when conversion jobs start or 
complete. 

Email subject—Populate this field with the text that you want to 
display in the Subject line of the alerts sent to the recipients listed 
in the Email addresses to send field.  

Attach logs if conversion succeeded—Select this checkbox to 
attach relevant log files if a job succeeds. 

Attach logs if conversion failed—Select this checkbox to attach 
relevant log files if a job fails. 

Attach HTML report—Select this checkbox to attach an HTML 
report to the notification email. 

Email 
Notification of 
Conversion Start 

Select the Enable checkbox to activate these fields: 

Email addresses to send—Use this field to enter email addresses 
for those who should receive alerts when conversion jobs are 
initiated. 

Email subject—Populate this field with the text that you want to 
display in the Subject line of the alerts sent to the recipients listed 
in the Email addresses to send field. 
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Email Sending 
Options 

The options available in this field are: 

• use MAPI 

• use SMTP 

Use the Configure button to access the Configure SMTP 
Preferences dialog. From this dialog, you can test the server 
connection that you configure. The button becomes enabled when 
you select SMTP. 

Send Messages on Intermediate Synchronizations: If you select 
this checkbox, you will receive email notifications on intermediate 
as well as initial and final synchronizations. 

 
 
123BConfigure SMTP Preferences Dialog 
If you select SMTP on the Email Notifications tab of the Program Preferences window, 
the Configure button is enabled. When you click this button, the Configure SMTP 
Preferences dialog displays.  

 
 

Server Name or 
IP 

The name of the SMTP server or its IP address. 

Server Port 
(default is 25) 

The port for the SMTP server.  

Email Address This is the address to which email notifications about this server 
will be sent.  

Email Username 

 

This is the user to whom email notifications about this server will 
be sent.  

Email Password 

 

This is the password of the user to whom email notifications about 
this server will be sent.  

Repeat Email This is the password of the user to whom email notifications about 
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Password this server will be sent.  

Test Server 
Connection 

Use this button to test the connection to the SMTP server that you 
configured. 

 

ESX Server Tab 
 

 
 
Servers Lists all of the ESX Servers—by IP address and name—that are 

available for conversion. Allows you to add, delete, and test 
connectivity. 

Server info The fields on this tab include general properties for the ESX 
Servers in the system: 

• Host name or IP 

• Username 

• Password 

• Verify password 

• Root password 

• Verify root password 

Use these options to configure individual ESX Servers: Enable 
vzBoost, Create User if doesn’t exist, and Enable VA feature 
checkboxes. 

Click the Install button to install an ESX Server and the Uninstall 
button to remove it from the system. Note: The installation will 
fail if the credentials you enter are invalid. 

For information on the Advanced and VA Config buttons, 
see the sections below. 
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124BAdvanced Properties Dialog 

125BIf you click the Advanced button on the ESX Server tab, the Advanced properties dialog 
displays. Although you can adjust port settings through this dialog, it is best to leave the 
defaults in place.  
 

 
 
 
 
 
VA Configuration Dialog 
 
If you click the VA Config button on the ESX Server tab, the VA Configuration dialog 
displays. On this dialog, you can configure VA, including the number of disks it has. 
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Xen Server Tab 

 
 

Servers Lists all of the XenServers—by IP address and name—that are 
available for conversion. Allows you to add, delete, and test 
connectivity. 

Server info The fields on this tab include general properties for the 
XenServers in the system: 

• Host name or IP 

• Username 

• Password 

• Verify password 

• Root password 

• Verify root password 

Select the Enable VA feature checkbox to configure individual 
XenServers. 

Click the Install button to install a XenServer and the Uninstall 
button to remove it from the system. Note: The installation will 
fail if the credentials you enter are invalid. 

If you click the Advanced button, the Advanced properties dialog 
displays. You can adjust port settings through this dialog, but it is 
best to use the defaults.  

If you click the VA Config button, the VA Configuration dialog 
displays. On this dialog, you can configure VA, including the 
number of disks it has. 
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User Profiles Tab 
You can add, delete, and edit user profiles through this tab. If you create a profile that 
you want to use for the entire network, you can set it as the default. Then, select the Use 
default user profile radio button to activate it. The profile that you set as the default 
displays in boldface. You can also configure the system to prompt for credentials. To 
access the User Profile Settings dialog, select Tools→Preferences→User Profiles→Add. 
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Task Profiles Tab 
You can create profiles associated with conversion jobs. If you set a default profile, this 
will be applied to all new conversion jobs that you create, except for those added through 
Quick Convert. When you set a task profile as the default, it displays in boldface in the 
main dialog area; it also displays in the Default profile field. 

 
 

126BTask Profile Properties 
Access this dialog through Tools→Preferences→Task Profiles→Add. The settings that 
are used to build these profiles are not tied to specific source or target server types.  

Note: The Name field in the Task profile info area is a required field. 

127B  
 

Disks Tab 
 

Lists several options—Create Flat Disk Image (Non Growable), 
Create Separate File for Each Volume, and Skip Bad Sectors 
where Possible. 

Notes: You must enable the Create Flat Disk Image (Non 
Growable) option to resize a volume through the vConverter 
Wizard. The flat format is required for ESX Servers and Xen. If 
you do not enable the Create Separate File for Each Volume 
option, vConverter will group all volumes in a single image file.  

The Adapter type dropdown contains a list of virtual disk adapter 
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types for VMs and captured disks. If a target VM platform 
supports a particular adapter type, it will be listed in this field. 
Available types include: 

• IDE 

• LSI Logic 

• Bus Logic 

Note: For Windows 2000, select Bus Logic. For Windows 2003 
and XP, select LSI Logic.  

 
 
 

VM Tab 
 

This tab features these settings: 

Create Virtual Machine—Enabled by default, this option allows 
vConverter to create a VM. This minimizes the need for manual 
processing. 

Enable Autologon on First Boot—Enabled by default. Allows 
automatic login to a converted VM on first boot. 
 
Power Source Server Off—After a conversion completes, if 
enabled this option automatically powers off the source server. 

Power Virtual Machine On—Enabled by default. After a 
conversion completes, enabling this option automatically powers 
on the VM (for ESX Servers and Xen only). 

Install VMware Tools (Requires one logon after conversion to 
complete)—Enabled by default.  If enabled, adds VMware 
Tools/Xen Tools to the applicable server and then powers on 
the VM. 

Configure VM: If you click this button, the VM Options dialog 
displays. Through it, you can create floppies and CD/DVD drives 
as well as configure RAM. 
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Set Login: Clicking this button accesses the Login for Auto Logon 
dialog. From here, you can set a separate login for the source 
server.  

128B  
 
 
 
Migration Tab 

Sometimes Microsoft releases a hotfix with an updated HAL.DLL 
that supersedes the file of the source format included in the current 
SP. This can cause a VM not to boot. To prevent this, keep the 
Uninstall Conflicting Hotfixes option enabled. This uninstalls 
hotfixes that could otherwise impact kernel files during system 
migration. This option is enabled by default.  

Select the Use Live Final Sync if Possible checkbox to allow for a 
live final synchronization. 

Click Service Manager to access a dialog that allows you to 
configure services for the source and target. In addition, set 
Capture Status (Paused, Running, and Stopped) and VM Startup 
Type (Disabled, Manual, and Auto). 

Click the Script Settings button to access a dialog that allows you 
to insert scripts and applications to a target VM. These will run on 
first boot. 
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Login Tab 

The Use Login to Access Target Server option allows you to set 
credentials for logging into the target server. When you select this 
checkbox, the Username and Password fields will be enabled. 
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129BAdvanced Properties 
When you click the Advanced button on the Conversion Tasks pane, the Advanced 
Properties window displays. Then, the Advanced Properties dialog displays. On its tabs, 
you can define disk configurations and set VM parameters. You can access dialogs that 
allow you to uninstall hotfixes and software as well as specify script settings and setup 
folder locations. Lastly, on the Login tab you can set credentials for a target.  

To activate the fields on the tabs of the Advanced Properties dialog, first click the edit 
icon on the Conversion Tasks pane. 

Note: You can disable quick tips by accessing the setting through 
Tools→Preferences→General. 
 

 
 
 
Disks Tab 
 

 
 

Create Flat Disk 
Image 

(Non Growable) 

Indicates that a flat format type should be used for conversion. Flat 
format is required for ESX Server and Xen, but enabling this 
option can slow the conversion process. 

Note: This option must be enabled to allow resizing a volume 
through the Conversion Wizard. 

Create Separate 
Files for Each 

Writes each volume into a separate image file. Otherwise, one 
image file is created for all converted source volumes. The first 
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Volume volume is put into a primary partition; all the other volumes are 
written into logical volumes within an extended partition. 

Skip Bad Sectors 
where Possible 

Turns on/off ignoring disk read errors on the Capture Tool. If this 
option is off, conversions will fail if a bad sector is found in the 
source hard drive during capture. 

Adapter type Adapter type for created VM and captured disks. Affects the VM 
configuration file and set of drivers added to converted the OS 
during migration. 
 
The Adapter type dropdown contains a list of virtual disk adapter 
types for VMs and captured disks. If a target VM platform 
supports a particular adapter type, it will be listed in this field. 
Available types include:  

• IDE  

• LSI Logic 

• Bus Logic 

Notes: For Windows 2000, select Bus Logic. For Windows 2003 
and XP, select LSI Logic.  

 

VM Tab 

130B  
 
Create Virtual 
Machine 

Instructs vConverter to create a VM descriptor file and registers 
the VM in the target environment (ESX Server/Xen). Otherwise, 
only a set of disk image files is created, which you must attach to 
the VM manually. 

Enable Autologin 
on First Boot 

Enables automatic login of specified user in converted VM during 
first boot. Selecting this option allows you to automatically install 
VMware Tools and Xen Tools; uninstall programs configured 
previously; and executes post-conversion tasks. 
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Power Source 
Server OFF 

Instructs source server to shut down after completing a successful 
conversion.  

Power Virtual 
Machine ON 

Runs the VM after the conversion is complete. Applicable only for 
ESX Server and Xen targets.  

Install VMware 
Tools (Requires 
one logon after 
conversion to 
complete) 

Adds VMware Tools/Xen Tools package to a VM on ESX 
Server/Xen. vConverter will automatically power on the VM. 
When you select this setting for ESX Server, vConverter instructs 
the VM to boot and to acquire VMware Tools from the host on 
which the VM is installed. For example, if a VM is running on 
ESX 3.0.1, it will get VMware Tools from 3.0.1. 

Configure VM Opens the VM Options dialog, whose fields are described in detail 
below. 

Set Login Opens the Login dialog for autologon feature. You can enter 
alternate credentials for autologon, different than those stored for 
the source server. 

 
131BVM Options Dialog 
To access the VM Options dialog, click the Configure VM button on the VM tab of the 
Advanced Properties dialog. 
 

 
 

Create Floppy 
Drive 

Select this option to configure the target to feature a floppy drive. 

Create CD/DVD 
Drive 

Select this option to create a CD/DVD drive on the target. 

RAM, MB Configure RAM on the target through this field. 

Notes 
(text box) 

This field is auto-populated with this text: 

Created by vConverter 4.1.x 
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You can alter this and include additional text. 

NIC1-4 
(tabs) 

These tabs allow you to create and configure up to four NICs. 
These fields are available on the tabs: 

• Create Net adapter 

• Connect Net at Power On 

• Take IP from Source Server 

Clicking the Change IP button accesses the IP Settings dialog, 
where you can update IP addresses and DNS settings. 

 

132BLogin for Auto Logon Dialog 

133BTo access the Login for Auto Logon dialog, click the Set Login button on the VM tab of 
the Advanced Properties dialog.  
 

 
 
IP Settings Dialog 
To access the IP Settings dialog, click the Change IP button on the NIC tabs of the VM 
Options dialog. To enable the fields on the IP Settings dialog, you must click the Use the 
following IP address radio button. 
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Migration Tab 
 

 
 
Uninstall 
Conflicting 
Hotfixes 

If selected (default value), it instructs vConverter to uninstall 
hotfixes that impact kernel files during system migration. The 
system will have a consistent set of kernel files after moving to 
HAL and will boot without blue screen. 
 

Note: It is possible to convert the system without uninstalling 
conflicting hotfixes. This takes less time. 

Use Live Final 
Sync if Possible 

Select this checkbox to allow for a live final synchronization. 

Uninstall 
Software 

Opens the Uninstall Software dialog. Click this button to uninstall 
software from the target VM. Enabling this option does not 
uninstall from the source.  

Service Manager Opens the Service Control dialog. Use this dialog to pause or stop 
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Windows services on the source server or target VM. This is 
useful for transactional systems. Set Windows services on the 
target to different states—e.g., Manual, Disabled. This is useful for 
services that control hardware, especially those that might cause a 
VM to hang. In addition, set Capture Status (Paused, Running, and 
Stopped) and VM Startup Type (Disabled, Manual, and Auto). 

Scripts Settings Opens the Scripts Settings dialog. Use this dialog to insert scripts 
(.cmd, .bat) and dependent applications (.exe, .dll) into a target 
VM to run on the first boot. 

Volume Refers to the volume to be used in conversions.  

HAL type Select a HAL type—AACPI (uniprocessor) or MACPI 
(multiprocessor).  

Setup Files 
Location 

Use this field to set a location for files required during conversion 
that are not on the source.  

 
 
134BUninstall Software Dialog 
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135BService Manager Dialog 
 

 
 

 
Login Tab 
Allows users to specify credentials to log into a target server. This can be useful if a 
target shared folder is inaccessible for the currently configured user credentials. When 
you select the Use Login to Access Target Server checkbox, the Username and Password 
fields are enabled. 
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75BServer Information Area 
This area at the bottom of the vConverter window displays statistics about the source 
system currently selected in the Network Browser pane. The data displayed in this area is 
captured and refreshed by WMI, which requires TCP port 135 to be available. If no data 
displays in the Server Information area, this means that either no credentials have been 
associated with the source or WMI is not accessible.  

If WMI is available on the source and enabled through the network and Active Directory 
security policies, a view similar to this will display: 
 

 
 
If WMI is not available on the source or has been disabled through the network or Active 
Directory, a view similar to this will display: 
 

 

 
76BExport Settings 
Use this feature to export previously configured vConverter settings and make these 
configurations available for other installations. This is the general process: 
 

1. Configure vConverter by setting it up for ESX Server and/or Xen. Create task and 
user profiles.  
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2. On the vConverter window, select File→Export settings. 
 

3. On the Save As dialog, click to select the settings to export. Click Open.  
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77BImport Settings 
Use this feature to import settings that you have defined previously. After you configure 
vConverter for ESX Server, Xen, tasks, and users, you can store the settings and export 
them for use in downstream installations. You can then import the settings. This is the 
general process: 

1. Configure vConverter by setting it up for ESX Server and/or Xen. Create task and 
user profiles. Save and store all settings.  

2. On the vConverter window, select File→Import settings. 
 

 
 

3. On the Open dialog, select the setting to import and click Open.  

 

78BSearch with Filtering 
In the Network Browser pane there is a Filter off/on button that is the gateway to 
searching for hosts on a system level. Use wildcards to search for any character or IP 
address. To search for multiple values simultaneously, enter the values separated by 
semicolons (;). 

1. In the Network Browser pane, click a tab—All Systems or Systems to Convert. 

2. Click the Filter on icon. 
The tab clears. 

3. Enter a search criterion in the field adjacent to the icon. 
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Note: Enter multiple criteria separated by semicolons (;) or enter wildcards. 
 

4. Click Apply. 
Search results display. 
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79BAdd System to Convert 
1. In the Network Browser pane, click the All Systems tab. 

2. Right-click the server and select Add to Systems to Convert. 
The server that you selected displays in the Systems to Convert tab. 
 

 
 

3. Click the Systems to Convert tab. 
The server has been copied to this tab. 
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80BImport System to Convert 
Follow these steps to import a CSV file into the Systems to Convert tab. Before starting 
this process, make sure that you: 

• Confirm that the CSV file is available. 

• Confirm that the CSV file contents include three columns similar to those below, 
with no column labels. 
 

Machinename Credentials password 

 

SERVER1 Domain\user pass@word1 

 

1. In the Network Browser pane, click the Systems to Convert tab. 

2. Click the Import systems to convert icon. 

3. On the Windows dialog, click to select the CSV file that you want to import. 
Then, click Open. 
 
A confirmation message displays. The hosts that you imported display in the 
Systems to Convert tab. 
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81BAdd New Task 
To create a new conversion task, follow the instructions below.  

1. On the Conversion Tasks pane, click New Task. 
The New Task Editing window displays. 
 

 
 

2. You can deselect the Show this tip again checkbox. Click Close.  
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3. From the Systems to Convert view, drag a server to the source server hotspot. 
After a brief delay, the Server Information area refreshes. 
 

 
 

4. Use the fields on the Conversion Tasks pane to define the task. Click Save. 
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12BCreate and Run Conversion Jobs 

82BManual Conversion Type 
1. From the Systems to Convert view on the Network Browser pane, drag a source 

to the source server hotspot. 

2. Select a volume from the Sources Drives list. 

3. Select a value from the Virtual Machine type dropdown.  

4. Select a Transfer Mode—Block-Based or File-Based. 

5. Select Manual from the Conversion Type dropdown. 
 

 
 
If the Set Credentials dialog displays, select a radio button and populate the 
appropriate fields. Click OK. 
 

 
 

6. From the Target dropdown, select a value. 

7. In the Target Folder field, select a location for storing the new disk and 
configuration files. 
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Notes: VM configuration files include the .vmx file, log files, and other files 
necessary to operate a VM. vConverter will automatically create the proper 
subdirectory structure for a VM, based on the specified VM Name value.  For 
direct to ESX conversions, point at the root of the VMFS volume that you want to 
use. If you select a folder that begins or ends with a whitespace, an error message 
will display. 

8. Click Advanced. Close the Advanced Properties opening window.  

9. On the Disks tab, select the checkboxes for the settings that you want to 
configure. Select an adapter type.  

10. Click the VM tab. Configure the VM. 
 

 
 
Create Virtual Machine is selected. It registers the VM automatically on the ESX 
Server and in VC. Enable Autologon on First Boot is selected, so that the VM will 
automatically reboot. Install VMware Tools is selected. 

For direct to ESX only, click Configure VM and make configurations on the VM 
Options dialog. Click OK. 

Note: You can create a network adapter but leave it disconnected until the final 
Windows configuration is complete. 

11. Click the Migration tab. The Uninstall Conflicting Hotfixes checkbox is selected. 
 
Click Uninstall Software to complete an uninstall on the source servers on first 
boot of the target VM. 
 
Click Service Manager to control services on the source server and target VM. 
Warning: You must stop transactional services such as databases and email 
before the conversion process begins. You can also set services that control the 
target VM’s hardware (e.g., Insight Manager) to configure a different startup state 
(e.g., manual, disabled). 
 
Click the Scripts Settings button to insert scripts and dependent applications into 
the target VM on the first boot.  
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Note: This is useful for post-conversion tasks. 

12. Click the Login tab. To enable the Username and Password fields and enter 
values for both, select the Use Login to Access Target Server checkbox. 
 

13. Click OK. 
 

14. On the Conversion Tasks pane, click Save. 
 

15. Click the Start icon. 
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83BSingle Conversion Type 
Before beginning this process, confirm that the DNS servers have been set through 
Control Panel→Network Connections. For instructions, see the Troubleshooting section 
of the Appendix. 
 

 
 

1. On the vConverter window, select Tools→Preferences. 
The Program Preferences dialog displays. 
 

2. On the ESX Server tab, click Add. Populate all of the fields in the Server Info 
area and then click Install. 
 

 
 

3. When the Status message text box on the Configuring window displays 
Configuring successful, click Close. Then, click OK on Program Preferences 
dialog.  
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4. Drag the source to the source server hotspot on the Conversion Tasks pane. Enter 
administrator credentials for the source. Select the Save as a new user profile 
checkbox. Click OK. 
 

 
 

5. When you are prompted to save the user profile, populate the Name field and 
click OK. 
 

 
 

6. Set the volume to be converted by selecting the appropriate checkbox below the 
source server hotspot. Then, select a value from the Virtual Machine type 
dropdown. 
 

7. Select a Transfer Mode—Block-Based or File-Based. 
 

8. Select Single Conversion from the Conversion Type dropdown. 
A Run At dropdown and spinbox display.  
 

9. Select a date and time, respectively, from the dropdown and spinbox. 
 

10. Select a value from the Target dropdown. 
 

11. In the Target Folder field, select a location for storing the new disk and 
configuration files.  
 
Note: If you select a folder that begins or ends with a whitespace, an error 
message will display. 
 

12. If you want to base this job on an existing task profile, select it from the Use 
Profile for Conversion dropdown. Click Apply. 
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13. Click Save. 
 
Note: vConverter confirms that the necessary disk space is available on the target. 
If there is insufficient space, this message will display. You can save the job or 
configure another target.  
 

 
 

14. To run the conversion job now, click the green arrow icon  above the target 
server hotspot. 
 

 
 

15. Close the Conversion Control Tip window.  
 

 
 

16. To check the progress of the job on the Conversion Monitor window, click the 

magnifying lens icon  above the target server hotspot.  
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17. After the conversion is successful, click Close. 
 
 

 
84BRCC Conversion Type 
There are two ways to complete RCC—one is automated; the other is not. Both processes 
are described below.  
 
Automated RCC 

1. From the Systems to Convert tab, drag a source to the source server hotspot.  

Note:  Automated RCC requires at least 300MB of free space on the system 
volume of each Source system. 

2. Select a volume from the Source Drives list. 

3. Select a value from the Virtual Machine type dropdown.  

4. Select a Transfer Mode—Block-Based or File-Based. 

5. Select Remote Cold Cloning from the Conversion type dropdown. 
Adjacent to the Conversion type field, a dropdown and spin box display—the Run 
At field.  
 

 
6. Select a date from the dropdown and a time from the spinbox. 

7. From the Target dropdown, select a value. 

8. Enter a path in the Target Folder field or click Browse to locate a folder. Select it 
and click OK. 
 
Note: If you select a folder that begins or ends with a whitespace, an error 
message will display. 
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9. If you want to base this job on an existing task profile, select it from the Use 
Profile for Conversion dropdown. Click Apply. 

10. Click Save. 

 
 
Non-Automated RCC 
When you add a source system for Non-Automated RCC (by boot CD or by PXE), it will 
display in the tree of the Network Browser pane under a branch called Cold cloning ready 
after you reboot. You must select the source and target from this list of servers. Also, you 
must select Manual or Single Conversion as the conversion type. 
 

 
 

11. From the Cold cloning ready (under VistaPE) list in the Network Browser pane, 
drag a source to the source server hotspot.  
 

 
 

12. Select a volume from the Source Drives list. 

13. Select a value from the Virtual Machine type dropdown.  

14. Select a Transfer Mode—Block-Based or File-Based. 

15. Select either Manual or Single Conversion from the Conversion type dropdown. 
Adjacent to the Conversion type field, a dropdown and spin box display—the Run 
At field.  
 

 
16. Select a date from the dropdown and a time from the spinbox. 

17. From the Target dropdown, select a value. 
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18. Enter a path in the Target Folder field or click Browse to locate a folder. Select it 
and click OK. 
 
Note: If you select a folder that begins or ends with a whitespace, an error 
message will display. 

19. If you want to base this job on an existing task profile, select it from the Use 
Profile for Conversion dropdown. Click Apply. 

20. Click Save. 
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85BSynchronized Cutover Conversion Type 
To minimize the cutover window, synchronized cutover completes a full conversion as 
the source continues to run. Synchronization takes place continuously until the final 
commit occurs during the cutover window. In other words, vConverter completes an 
initial conversion. Then, at intervals that you schedule, vConverter determines which files 
have changed and synchronizes only those files. During the final synchronization, 
vConverter captures the remaining changes and places them on the target. This allows for 
a narrow cutover window and fast transition from physical to virtual. 

 

 
Note: To select a profile from the Use Profile for Conversion dropdown, you must first 
create a task profile. See the instructions for doing this in Chapter 3. 
 

1. From the Systems to Convert view on the Network Browser pane, drag a source 
to the source server hotspot. 

2. Select a volume from the Source Drives list. 

3. Select a value from the Virtual Machine type dropdown.  

4. Enter a value in the VM name field.  

5. Select a Transfer Mode—Block-Based or File-Based. 

6. Select Synchronized Cutover from the Conversion Type dropdown. 
Adjacent to the Conversion type field, several dropdowns and spin boxes 
display—Initial Synchronization At, Synchronization Interval, and Final 
Synchronization At fields. 
 

 
7. Select values from the synchronization dropdowns and spinboxes. 

8. Select a location from the Target dropdown. 

9. Enter a value in the Target Folder field or click Browse to search for one. 
 
Note: If you select a folder that begins or ends with a whitespace, an error 
message will display. 
 

10. If you have configured one, select a profile from the Use Profile for Conversion 
dropdown. Click Apply. 



 

vConverter v4.1  Chapter 4 Using vConverter  146  
 

11. Click Save.  
 
Note: A prompt might display, asking you to create a network share.  

 

86BContinuous Protection Conversion Type 
With continuous protection, a virtual copy of a working physical system is made. The 
source server is only touched by the reads being done. A copy of the source server is 
made. Replication is performed at user-defined intervals at the target. These intervals are 
set to keep the source and target perpetually in sync. 

 

 
vConverter collects filename and attribute information as well as date and time of last 
update for all files and directories. The data is compared and the new data is updated. The 
new data is replicated and saved in a new database that is recreated continuously. Since 
each synchronization completes with OS kernel migration, the data in the target image 
continues to update. This means that the database does not match actual state at any given 
time.  
 
Notes: To use Continuous Protection, you must have MS VSS installed. To select a 
profile from the Use Profile for Conversion dropdown, you must first create a task 
profile. See the instructions for doing this in Chapter 3. 
 

1. From the Systems to Convert view on the Network Browser pane, drag a source 
to the source server hotspot. 

2. Select a volume from the Source Drives list. 

3. Select a value from the Virtual Machine type dropdown.  

4. Select a Transfer Mode—Block-Based or File-Based. 

5. Select Continuous Protection from the Conversion Type dropdown.  
Adjacent to the Conversion type field, dropdowns and spin boxes display—Initial 
Synchronization At and Synchronization Interval fields. 
 

 
6. Select values from the dropdowns and spinboxes. 

7. Select a location from the Target dropdown. 

Note: The Target value can be changed between protection passes if the VM 
needs to be moved. 

The Source 
System is powered 

on and running

Conversion to VM is 
performed in hot 

mode, either file-based 
on sector-based

Subsequent 
Synchronizations are 

performed in hot mode, 
only file-based
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8. Enter a value in the Target Folder field or click Browse to search for one. 
 
Note: If you select a folder that begins or ends with a whitespace, an error 
message will display. 
 

9. If you have configured one, select a profile from the Use Profile for Conversion 
dropdown. Click Apply. 

10. Click Save.  
 
Note: A prompt might display, asking you to create a network share.  

 

87BDifferent Destinations Cutover Conversion Type 
1. From the Systems to Convert view on the Network Browser pane, drag a source 

to the source server hotspot. 

2. Select a volume from the Source Drives list. 

3. Select a value from the Virtual Machine type dropdown.  

4. Select a Transfer Mode—Block-Based or File-Based. 

5. Select Different Destinations Cutover from the Conversion Type dropdown. 
Several dropdowns and spinboxes display. 
 

 
6. Select a date and time for initial synchronization. Select numeric and time values 

for the interval. 

7. Select a location from the Target dropdown. 

8. Enter a value in the Target Folder field or click Browse to search for one. 
 
Note: If you select a folder that begins or ends with a whitespace, an error 
message will display. 

9. If you have configured one, select a profile from the Use Profile for Conversion 
dropdown. Click Apply. 

10. Click Save.  
 
Note: A prompt might display, asking you to create a network share.  
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88BCreate and Run Conversion Job (Using the Wizard) 
If you have already defined task and user profiles, you can use them in combination with 
the Conversion Wizard to produce conversion jobs.  

A few things to address before you begin:  

• Confirm that the DNS servers have been set through Control Panel→Network 
Connections. 

• If you intend to resize any volumes during this process, confirm that the Create 
Flat Disk Image option has been enabled through Tools→Preferences→Task 
Properties. On the Wizard’s Step 4 dialog, you can confirm that this setting has 
been saved. 

• If you are converting multiple volumes and want each to be stored as a separate 
image file, confirm that the Create Separate File for Each Volume option is 
enabled through Tools→Preferences→Task Properties. 

• If you want vConverter to skip certain sectors on your hard drive, confirm that the 
Skip Bad Sectors where Possible setting is enabled through 
Tools→Preferences→Task Properties. 

1. In the Toolbar, click the Run Conversion Wizard   icon. 
 

 
 

2. Click Close. 

3. Click Next. 
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4. On the Step 1 dialog, populate these fields: Source server, Username, and 
Password. Click Next. 
 
OR 
 
Click the browse ellipsis, navigate to a server, and double-click it. 
 

 
 

 
 

5. On the Step 2 dialog, select values from the Virtual Machine and Target 
dropdowns. For the target, select Network shared folder unless the VM type is 
VMware ESX Server. 
 
Enter a target folder—a local directory or a network file share. If you click the 
browse ellipsis, click to select a folder.  If you want to set raw device mapping, 
select Use RDM. Select a radio button—Physical or Virtual. Make a selection 
from the dropdown. Then, click OK.  
 



 

vConverter v4.1  Chapter 4 Using vConverter  150  
 

 
 
Note: If you select a folder that begins or ends with a whitespace, an error 
message will display. 
 
Enter a VM name or leave the default (the source server name) as is. 
 

 
 
If the credentials for the target and the source are different, click Set Login and 
enter new credentials for the target. Click OK. Click Next. 

6. On the Step 3 dialog, select the checkbox for the volume that you want to convert. 
You can select multiple volumes. 
 

 
 

7. Click Next. 
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8. On the Step 4 dialog, the Create Virtual Machine checkbox is already selected if 
you are converting directly to an ESX Server. 
 
If you intend to resize any volumes, the Create Flat Disk Image (Non Growable) 
checkbox will be selected and disabled. If it is not, select it.  
 
To configure the VM, click Configure VM. On the VM Options dialog, you can 
define the RAM for the VM and create floppy and CD/DVD drives. Click OK or 
configure up to four NICs. 
 
Each NIC can be configured to individual virtual switches; connected or 
disconnected at power on; and have separate IP addresses. To adjust IP settings, 
click Change IP on any tab. Make updates on the IP Settings dialog and click 
OK. Then, click OK on the VM Options dialog. 
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From the Adapter type dropdown, select IDE, Bus Logic, or LSI Logic. 
 
You can select an alternate HAL type from the dropdown—MACPI 
(Recommended), AACPI, and ACPI are available. 

9. If the OS or extracted SP source files are not located on the source, you can 
specify a location for them now or anytime before the conversion job is run. 
 
Click the browse ellipsis next to the Setup Files Location field. On the Browse for 
Folder window, navigate to the location and click OK. The path will display in 
the Setup Files Location field. On the Step 4 dialog, click Next. 
 

 
 

10. On the Step 5 dialog, click Finish. 
The job is added to the Conversion Tasks pane. 
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11. To schedule the job to run later, click the Edit   icon on the Conversion Tasks 
pane. When prompted to save the task, click Yes. Click Scheduler. 
 

12. Follow the instructions in the Reschedule Conversion Job section below. 
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89BReschedule Conversion Job  
Follow these instructions to reschedule a conversion job to run on another date or at 
another time.  

1. Configure a conversion job to run and save it.  

2. On the Conversion Tasks pane, click Scheduler to access the date and time of 
the job.  
 

 
 

3. Reset the event by double-clicking the job. On the Appointment dialog, adjust the 
date dropdown and time spinbox. Click OK. 
 

 
 
The job is removed from the previously scheduled timeframe and is now 
scheduled to run on the new date at the new time. 
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90BRun a Quick Conversion 
To use the Quick Convert feature, you must have a task profile created to select as the 
template for the quick conversion job. Otherwise, this error message will display when 
you attempt to select the Quick Convert command: 
 

 
 

1. In the Systems to Convert view, right-click a server and select Quick Convert! 
The Quick Convert dialog displays. 
 

 
 

2. To view details about a task, click to highlight the task and then click View Task 
Details. Then, click Close. 
The Task Details dialog displays. 
 

 
 

3. Click to highlight a task and click OK.  
The Set Credentials dialog displays.  

4. Click OK to use the credentials entered for this profile. Or, select the Specify 
credentials manually radio button and enter new credentials and click OK. 



 

 

5 Using vConverter CLI 
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13BvConverter CLI Overview 

The vConverter CLI Tool is both a console C++ application and a DLL library. It 
integrates all the logic necessary for converting source systems. As a caller application, it 
converts a system in a single action—you just call the CLI Tool and provide the 
conversion parameters.  

The tool obtains the input parameters from the command line. Console output (stdout) 
informs the caller application of the status of the current operation being performed by 
the tool. When the operation completes, a result code is returned. This code indicates the 
final state of the conversion.  

The tool can work in both verbose and brief modes. Verbose mode is used mainly for 
testing and debugging. Output messages are in human-readable format. Brief mode is 
used when CLI Tool logging and all output messages are parsed by the caller application. 
This mode makes the parsing process easier and faster.  

The tool gathers and preprocesses all the logs from the vConverter tools. It runs into one 
log file in a brief format that can be analyzed and displayed by the caller application. If 
necessary, more detailed logs can be created for reporting purposes. 
 
vConverter is made up of a group of independent tools, including: 

• Partition Info Tool—Runs first on a source server and provides necessary 
information about boot environment. 

• Capture Tool with Consistency Driver—Captures source disks to output file by 
cluster on a low level. 

• Drive Image Mount Tool—Allows get access to a captured disk; similar to a 
regular system volume. 

• Migration Tool—Performs system kernel migration; works with a mounted 
disk image. 

• ESX Target Server Agent (TSA) is used for directly writing to VMware 
ESX Servers. 

• Windows TSA is used to speed up writing large amounts of data to target 
Windows systems. It is especially effective in capturing flat disk image formats. 

 

91BvConverter Components 
These components are included in vConverter. Some are described in additional 
detail below. 
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• Drive Capture Tool with Consistency Support 

• Windows P2V Migration Tool  

• Drive Image Mount Tool 

• UI Client  

• Command Line Tool  

• Remote Launch Tool 

• Licensing Service* 

• TSA for Windows hosts 

• TSA for VMware ESX Server 

• TSA for XenServer and Virtual Appliances (VAs)* 

• VA for running on VMware ESX Server* 

• VA for running on XenServer* 

• Windows Vista PE boot image (.ISO) for cold conversion and restoring* 

• Windows Vista PE boot image (.wim) for cold conversion and restoring* 

• PXE Service (transfers Vista PE image to target systems via the network)* 

• Hot Driver Install utility (allows installing drivers on Vista PE dynamically)* 

• Conversion Monitor utility (runs on Vista PE and displays capturing status)* 

* These components are not available in CLI package.  

Client System
(Windows XP+)

Source Server
(Windows 2000+)

Drive Capture 
tool

Image 
Consistency 

Driver

Virtual Disk 
Driver

On-site VSS 
(Windows 

2003+)

Licensing 
Service

Migration toolVirtual Disk 
Driver

UI Client CLI Tool

Server Info 
Tool

Target Server
(Windows 2000+)

Target 
Windows 

Server Agent

Target Server
(VMware ESX Server/

XEN Server)
Target ESX/
XEN Server 

Agent

Target Server
(VMware ESX Server/

XEN Server)

Virtual Appliance (Linux 
based)

Target ESX/
XEN Server 

Agent 

Virtual Disk 
Driver

Vista PE 
Boot Image

PXE Service
Remote 

Launch Tool
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136BDrive Capture Tool with Consistency Support 
This component runs on the source server. It reads and transfers disk data to the target 
server. Its built-in Consistency Driver tracks data changes, so there is no need to stop 
applications or start services to prevent disk data from modifying while copying.  

For Windows XP and Windows Server 2003 systems, you can use Volume Shadow 
Service (VSS) instead of the Consistency Driver, to enforce consistency level for VSS-
aware applications such as large databases (MS-SQL server) etc.  

137BMigration Tool 
This tool performs the operations necessary to ensure that the system is bootable and 
functions properly after the move from a physical (or virtual) source to a target virtual 
hardware platform. The Migration Tool runs on the client system and operates mounted 
to GUID volume. It puts necessary SCSI drivers compatible with new hardware HAL file 
and updates the Windows registry on mounted file system. 

The tool performs these post-conversion tasks—installs VMware Tools for target desktop 
VMware versions, schedules running user scripts on migrated systems during first boot, 
and uninstalls required software from migrated systems. 

138BDrive Image Mount Tool 
Using this tool, drive image file content can be seen as a separate disk with read-only or 
read-write access. The Drive Image Mount Tool uses Virtual Disk Driver to mount the 
image. It is used in test or troubleshooting scenarios only. 

139BCLI Tool 
The CLI Tool allows you to run conversion jobs without using GUI. It was developed to 
allow P2V features to be added to third-party software. The tool can be used as part of a 
vConverter installation or as a standalone set of executables. If you select the latter, the 
CLI Tool can be incorporated into any third-party application to provide conversion 
functionality.  

As a standalone executable, the tool uses License Service running at the same host. As a 
set of DLLs compiled for use with appointed third-party executables, the CLI Tool does 
not support native vConverter licensing. Instead, it is bound to a predefined name of 
caller process. That is, if the caller executable name does not match the expected one, the 
tool fails. 

140BRemote Launch Tool 
The Remote Launch Tool runs an executable on a remote Windows system. It requires 
having the administrative credentials for the remote system, and uses Windows 2000 
features to run.  
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141BTSA for Windows Hosts 
TSA for Windows Hosts runs on a target system. The feature improves performance in 
writing disk images compared to writing to Windows shared folders. It is especially 
effective for capturing images in flat format, where initial allocation of disk space can 
take significant time when done over the network.  

The agent opens TCP port 422 and waits for an incoming connection from the Drive 
Capture Tool that runs on the source. Once the connection is established, the agent writes 
received data into the disk image format that you selected.  

The transfer is performed by 64K blocks. If an entire block is filled in by the same byte 
value—for example, it contains zero bytes—the whole block is replaced by a telegram 5 
bytes in length for traffic reduction.  

142BTSA for VMware ESX Server 
TSA for VMware ESX Server is used to create disk images and write data to the images 
residing on VMware ESX Server 3.0.x and 3.5. The feature must be run in COS running 
xinetd daemon. 

The CLI Tool package cannot install the TSA for ESX Server. You must install the agent 
manually or through the GUI by accessing Preferences→ESX Server→Add. 

Warning: TSA for VMware ESX Server uses its own authentication scheme, which 
differs from the one used in COS. 

The default login credentials are: 

Username: root 
Password: vmware 

To change these credentials, you must run a utility that is included in the TSA bundle.  
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92BCommand Line Arguments 
 
Running CLI Tool Executable 
 
CLI Tool executable—vccli.exe—was primarily developed as a CLI utility for users who 
want to automate the conversion process by running it from batch files or who want to 
use it for testing. It is located in the vConverter installation folder. The format of calling 
vccli.exe is: 
vccli.exe <generic CLI Tool command line parameters> 

The CLI Tool executable connects to a local vConverter License Service using a 
customer’s existing serial number, read from the Windows registry, and decreases the 
conversion counter of installed the vConverter package. The executable passes its output 
into a standard console output stream. The CLI Tool executable does not work in auto-
trial mode. It requires proper activation.  

Note: For the CLI Tool executable to run, it must be placed on the same system as the 
license service. 
 
146BRunning CLI Tool DLL 
 
The CLI Tool DLL is the extension library used to incorporate the system conversion 
functionality to third-party products. It is not bound to the internal vConverter license 
engine. Rather, it is bound to the name of main executable file (returned by 
GetModuleFileName() Win32 API call). It fails when the name does not match the initial 
name hardcoded within the DLL in a crypted form. 

These functions are exported by the CLI Tool DLL: 
 

SetCallback(void * pfunc) Sets the callback pointer to receive progress 
notifications. Progress notification string format 
is described below. 

Convert(LPCWSTR Arguments) Kicks off the conversion. Arguments are 
184Hgeneric CLI Tool command line parameters. 

BreakConversion(void) Immediately breaks the currently run 
conversion. 

 

The callback function prototype supplied in SetCallback() is defined as: 
typedef void (__stdcall *PCallback)(LPCWSTR statusMessage); 

statusMessage is a pointer to locally allocated wide char string buffer that contains the 
status string in a brief or full (human-readable) format, depending on passed command 
line parameters. The caller application must copy this string into its local buffer for 
further usage and must not refer to the passed string address after returning from the 
callback function call. 
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147BGeneric CLI Tool Parameters 
 
The CLI Tool—both .EXE and .DLL—requires the following command line: 
<source system name or IP address> <credentials to login to 
the source system> [<target server address>] <target file 
name in UNC format> [<credentials to login to the target 
server>] <capturing parameters> [<extra parameters>] 

The mandatory CLI parameters are:  

• source system name with valid administrative credentials 

• target filename (where the output image data will be written) 

• capturing parameters 

You can specify a login and password for the target server if, for example, the target 
share is not generally accessible, you want to launch Windows TSA there, or you want to 
capture to ESX Servers.  

Some migration parameters can be used to improve performance and reliability. Several 
examples of CLI Tool command line usage follow. 

Example 1: Conversion to Windows Target Folder using Windows TSA and flat VMDK 
File Format 

You have these input parameters for the conversion: 

Name Value 

Source Server Name fileserv 

Source Server User Login admin 

Source Server User Password 123456 

Target Server Name storage 

Target Disk Image Path 185H\\storage\vm\fileserv.vmdk 

Target Server User Login admin 

Target Server User Password 123456 

Volumes to Convert C: D: 

Image format VMware VMDK flat 

Run Windows Server Agent if 
possible 

yes 
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Run CLI Tool with the following command line: 
 
fileserv /su admin /sp 123456 /tserver storage  
186H\\storage\vm\fileserv.vmdk /tu admin /tp 123456 /vm vmware 
/adapter ide /vol c: /vol d: /flat /winsftp 
 

This converts the system fileserv to the image \\storage\vm\fileserv.vmdk into VMware 
IDE disk file format. The volume C: will be put into a primary partition; the volume D: 
will be written as a logical disk in the extended partition. All the files necessary for 
system conversion must be located inside the source system, otherwise the conversion 
will fail. 

To run Windows TSA you must provide the proper target server credentials, even if they 
match those of the source server. In this example, there are two similar credentials—one 
for the source, the other for the target. 

Note: If running Windows TSA fails, the conversion will continue trying to write to the 
target shared folder using the native Windows file write operations.  

 
Example 2: Conversion of a System Passing Setup Folder 

If you convert the same system from example 1, but some files that are necessary for 
conversion are missing from the source. You will have to add this parameter: 

Name Value 

Setup folder location \\install\os\windows2000\sp 

 

The command line is: 
fileserv /su admin /sp 123456 /tserver storage  
187H\\storage\vm\fileserv.vmdk /tu admin /tp 123456 /vm vmware 
/adapter ide /vol c: /vol d: /flat /winsftp /setup 
188H\\install\os\windows2000\sp4 

It performs the same conversion, but the missing files are searched for within this folder:  
189H\\install\os\windows2000\sp4. 

 
Example 3: Conversion of a System to ESX Server Saving Tools Log Files 
 
If you convert the same system from the examples above to ESX Server, these 
parameters apply: 

Name Value 

Source Server Name fileserv 

Source Server User Login admin 

Source Server User Password 123456 
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Name Value 

Target Server Name (IP address) esxserver 

Target Disk Image Path /vmfs/volumes/storage1/C.vmdk 

Target ESX Server Agent User 
Login 

root 

Target ESX Server Agent User 
Password 

vmware 

Volumes to Convert C: D: 

Image format VMware VMDK flat 

Folder to store log files from the 
tools 

C:\logs 

 

The command line is: 
fileserv /su admin /sp 123456 /tu root /tp vmware /tserver  
esxserver: 422 "/vmfs/volumes/storage1/C.vmdk" /vm 
vmwareesx /adapter lsi /vol C: /flat /vo /extlogs "C:\logs" 

It converts the system fileserv to the image /vmfs/volumes/storage1/C.vmdk on the ESX 
Server. The intermediate log files of all vConverter tools are saved in the c:\logs folder. 
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Options Required Description 

Output to 
Windows 
shared 
folders 

Output 
to ESX 
Server 

 
Generic Parameters 
 
/?, /help - Displays brief tool usage instructions. 

<source system name or IP 
address> + 

Specifies the source system name or IP 
address.  

/su <user name> 
+ 

Specifies the user name for the launch 
capturing process on a source system. The 
user must have administrator access rights.  

/sp <password> - Specifies the password for the user supplied 
in /su parameter. 

/tserver <server name or IP 
address[:port]> 

-/+ + 

Specifies the target server and optional port 
number for connecting to the TSA running.  
 
Use this parameter to convert a system to 
ESX Server or a network share folder 
through the Windows TSA.  

<target file name in UNC 
format> + 

Specifies output image filename. UNC 
format - \\computer name\sharename\.. – 
must be used here. ESX Server format -
“/folder/subfolder/../filename.vmdk”.  

/tu <user name> 

- + 

Specifies the user name to get access to a 
target share on a target system, or to connect 
to TSA.  
 
Provide this parameter if the administrative 
credentials are different for the source and 
target systems and the target share does not 
have unrestricted access. For example, use 
this parameter when the source and target 
systems reside in the different domains.  
You must specify this parameter if you are 
writing to ESX Server or a network share 
folder through TSA. 

/tp <password> - + Specifies the password for the user supplied 
in /tu parameter. 

 
Capturing Parameters 
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Options Required Description 

Output to 
Windows 
shared 
folders 

Output 
to ESX 
Server 

/vm  
 vpc| 
 vmware| 
 legacyvmware| 
 virtualiron| 
 vmwareesx + + 

Specifies target VM: 

• vpc—Virtual PC (vhd file) 

• vmware—VMware Workstation 4.x 
and higher, and Server (vdmk file) 

• legacyvmware—older version of 
VMware Workstation 

• virtualiron—Virtual Iron 

• vmwareesx—Vmware ESX 
Server 3.x 

/split 

- - 

Turns on image files splitting. 
For VMware: 

• maximum file size is set to 2Gb  

• produced file type is either 
twoGbMaxExtentSparse or 
twoGbMaxExtentFlat [Error! 
Reference source not found.] 

For Virtual PC: 

• maximum file size is set to 4Gb 

• produced file type is either Dynamic 
Hard Disk Image (Split) or 
FixedHard Disk Image (Split) 
[Error! Reference source not 
found.] 

/flat 

- - 

Forces tool to allocate all space for the image 
at time of creation. In this case, image size 
will match disk size roughly. If not specified, 
a sparse image is created (monolithicSparse, 
twoGbMaxExtentSparse, Dynamic Hard 
Disk Image, Dynamic Hard Disk Image 
(Split)). 

/adapter ide|bus|lsi|adaptec 

+ + 

Defines disk adapter type (* this value is 
applied for both capturing and migration 
steps).  
For VMware, valid values are: 
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Options Required Description 

Output to 
Windows 
shared 
folders 

Output 
to ESX 
Server 

• ide—IDE adapter 

• bus—Bus Logic SCSI adapter 

• lsi—LSI Logic SCSI adapter 

For Microsoft products, valid values are: 

• ide—IDE adapter 

• adaptec—Adaptec SCSI adapter (Can 
be used only in Virtual Server.) 

/vol <name> [/resize 
<size>] 

+ + 

Adds a volume to the list of volumes to 
capture.  
 
<name> - volume name (e.g., C:).  
/resize option allows to specify new size of 
the volume in megabytes (Mb suffix) or 
Gigabytes (Gb suffix).  
 
New volume size must be greater than the 
current volume size. 
 
/vol option can be repeated several times. 
The first volume in the list will be captured 
as a primary partition; the remaining 
volumes will be captured as logical drives 
inside an extended partition. Example: 
/vol c: /resize 20Gb /vol d: /vol e: /resize 
120Mb 
These options specify that c:, d:, and e: 
volumes are to be captured. Volumes c: and 
e: new sizes are 20Gb and 120Mb, 
respectively.  

 
Extra Parameters 
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Options Required Description 

Output to 
Windows 
shared 
folders 

Output 
to ESX 
Server 

/setup <path> 

- - 

Specifies the path to Windows setup files. 
Used when not all files necessary for kernel 
migration are found on source—for instance, 
when the source was optimized before and 
the system file cache was cleaned up 
manually or using a program. 
 
If there is more than one operational system 
to migrate, and it is necessary to specify 
different setup folder locations for each, use 
volsetup instead. 

/volsetup <volume> <path> 

- - 

Indicates the path to Windows setup files for 
the specified source volume. The meaning is 
the same as for setup parameter.  

/mcache <path> - - Specifies the path to store and retrieve 
Migration Cache, which is used to speed up 
the subsequent conversions of the same 
system or systems with the same OS and SP 
installed. In this case, the following kernel 
migrations can use the files used by the first 
migration, and do not scan Setup Folder 
again, which may take a significant amount 
of time. 

/vo - - Turns on verbose (human readable) output 
mode. By default, brief output format is 
used. Can be useful for testing purposes. 

/rr <interval in 
milliseconds> 

- - Refresh rate interval between two progress 
indicator messages (see below).  

/log <filename> - - Explicitly specifies the file name for the brief 
log written by the tool itself. If this 
parameter is not specified, the log is stored in 
the same folder where the tool is located and 
named with the same name as the tool and 
.log extension. 

/extlogs <folder> - - Specifies the folder path where detailed log 
files from the tools must be put. If the 
parameter is not specified, all original 
vConverter tools logs are purged. If this 
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Options Required Description 

Output to 
Windows 
shared 
folders 

Output 
to ESX 
Server 

parameter is specified, the brief tool log is 
also put into this folder. 

/nokernel - - Turns off kernel migration step. Applicable 
only for V2V migrations to the same target 
platform with the same HAL parameters. 
Warning: Otherwise, may cause blue screen. 

/nodisk - - Turns off copying drivers and registry entry 
modifications on the disk adapter migration 
step. Applicable only for V2V migrations to 
the same target platform with the same disk 
adapter type. Warning: Otherwise may cause 
blue screen. 
 
Passing this parameter does not exclude disk 
migration step—several migration activities 
cannot be turned off. 

/installVmTools - Installs VMware tools after first boot of the 
migrated system. 

/autoLogon - Sets logon mode without typing credentials 
on the first boot. For auto logon, the 
credentials from /su /sp command line 
parameters are used. 

/badsectors   
 
 
- 

Defines bad sectors strategy. Valid values 
are: 

• fail—Failed migration process if bad 
sectors are found. 

• skip—Skip all bad sectors. 

 
/winsftp - Use Windows SFTP agent, if set. Required 

/tserver, /tu, tp. 

/novss - Disable VSS usage on supported systems. 
The built-in Consistency Driver is used 
instead. 
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Options Required Description 

Output to 
Windows 
shared 
folders 

Output 
to ESX 
Server 

/byfile - Forces Capture Tool to use by-file capturing 
mode, instead of by-sector by default.  
Must be used only for source systems with 
VSS support enabled—Windows XP and 
higher (Windows Server 2003 is best.). For 
older systems, will cause conversion to fail. 
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93BCLI Tool Exit Codes 
The CLI Tool returns these exit codes: 

Code Description 

0 No error, normal exiting. 

1 Invalid command line. 

10 No more licenses are available. 

11 Internal license error. 

30 Execution is cancelled by the user. 

40 Unexpected or unknown conversion error (need to analyze log files). 

100 Capture Tool: Failed to connect to source system. 

101 Capture Tool: Failed to copy the executable files to a source system. 

102 Capture Tool: Failed to create directory on a source system. 

103 Capture Tool: Failed to open service manager on a source system. 

104 Capture Tool: Failed to create or open service on a source system. 

105 Capture Tool: Failed to start remote service on a source system. 

106 Capture Tool: Failed to query remote service state on a source system. 

107 Capture Tool: Remote service run failed on a source system. 

108 Capture Tool: Remote process is already launched on a source system. 

109 Capture Tool: Remote service logon failure on a source system. 

110 Capture Tool: Unexpected capturing error. 

200 Migration Tool: Bad Setup installation folder. 

201 Migration Tool: Failed to copy system file (DLL) upon migrating. 

202 Migration Tool: Unsupported OS to migrate. 

203 Migration Tool: Failed to mount registry hive.  

204 Migration Tool: Failed to copy driver file. 

205 Migration Tool: Failed to load registry file. 

206 Migration Tool: Failed to uninstall hotfixes. 

207 Migration Tool: Unexpected migration error. 

300 Capture Tool: Failed to get access to a source volume/disk to capture. 
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Code Description 

301 Capture Tool: Failed to create output image file. 

302 Capture Tool: Failed to write to output image file. 

303 Capture Tool: Failed to read from a source volume. 

304 Capture Tool: Failed to extract consistency driver. 

305 Capture Tool: Failed to run consistency driver. 

306 Capture Tool: Failed to open consistency data file. 

307 Capture Tool: Failed to read consistency data file. 

308 Capture Tool: Failed to start inspecting disk changes. 

309 Capture Tool: Failed to run disk driver. 

310 Capture Tool: Failed to mount disk image. 

311 Capture Tool: Failed to unmount disk image. 

312 Capture Tool: Failed to extend the volume. 

313 Capture Tool: License limits are not kept. 

314 Capture Tool: Logoff or shutdown request received. Capture Tool 
execution is finished prematurely. 

315 Capture Tool: Different Virtual Disk driver version is already loaded on 
the system. Need to reboot source system to start capturing. 

316 Capture Tool: Unexpected capture error. 

500 Failed to get partition info from source system. 

501 Failed to get boot disk info from source system. 

502 Failed to load disk driver. 

503 Failed to copy system files on migrated system. 

504 Failed to mount disk image to perform system migration step. 

505 VMware drivers folder is missing or empty—can’t perform disk 
migration step. 
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94BBrief CLI Tool Output Messages 
Brief tool output mode is intended for the further parsing by a caller application. All the 
tool output messages in this mode are represented in the following format:  

<Type Prefix><Variable part>  

Type Prefix is one character with a value from the following set: 

• s—This is a new step message. 

• %—This is a progress indicator message. 

• v—This is a version information message. 
 

Variable part is specific to different types. See the table below for these values. 

Type Prefix Variable part Description 

s N (a decimal 
number) 

A next convert stage encoded by N has just 
begun. 

% NP*10 (a whole 
decimal number 
– the actual 
percent value 
0..100% 
multiplied by 10) 

The execution percent of the current 
operation is specified here.  

v X.X.X.X The version of used vConverter tools is 
shown there. The most significant number is 
on the left side, the less significant is on the 
right.  

 

The converting stages are enumerated in the table below:   

Stage  Optional Description 

1  Determining the OS version of the source system. 

11 Y Preparing to convert the system—searching for the necessary 
files to migrate inside the migration cache folder, system, or 
setup folder. 

20  Launching the Capture Tool on a source system. 

21  Capture Tool prepares to capture the current partition. 

22  Capturing the current source partition. 

23  Applying consistency data for the current source partition. 

24 Y Resizing the captured partitions. Note: Applies only to NTFS 
volumes; FAT32 volumes are resized on the fly. 

30 Y Mounting the captured image to migrate the OS. 
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31 Y Starting kernel migration. 

32 Y Starting disk adapter migration. 

33 Y Checking the setup files folder for current migration activity. 

34 Y Running migration. 

35 Y Dismounting the captured image. 

40 Y Gathering the log files and cleanup temporary data. 

 
Each next message is started from the new line when using the CLI Tool executable. For 
CLI DLL, each next message is delivered in a separate callback function call: 

 
> clitool.exe fileserv /su admin /sp 123456 
190H\\storage\vm\fileserv.vmdk /tu admin /tp 123456 /vm vmware 
/adapter ide /vol c: /setup 191H\\install\os\windows2000\sp4 
 

v2007.1.57.0 
s1 
%0 
%166 
%332 
%498 
%664 
%830 
%1000 
s11 
%0 
%500 
%1000 
s20 
s21 
s22 
%1 
%3 
%4 
%6 
%7 
%8 
%15 
%16 
%17 
%20 
 
.. 
 
%998 
%999 
%1000 
s23 
%7 
%37 
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%229 
 
.. 
 
%992 
%996 
%1000 
s24 
%1000 
s30 
s31 
%1000 
s34 
%900 
%1000 
s32 
%1000 
s34 
s35 
s40 
%0 
%500 
%1000 

> 
 
A conversion result is not displayed in brief mode. The caller application has to analyze 
the exit code of the CLI Tool. If a step is reported as started, but there is no percentage 
message for the step, and the next step is started immediately, then the prior step passed. 
A next progress indicator message is displayed only when the progress value was actually 
changed. The default refresh rate value is 100ms; this value may be changed from the 
command line. 
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143BGUI Features Not Supported by vConverter CLI 
The CLI Tool does not support: 

• Explicit specification of HAL type for kernel migration. The best option is 
automatically applied. 

• Capturing the whole source disk in RAW mode. Each source volume must be 
specified in the command line. 

• Capturing volumes in separate disk images. Through CLI, a single output image 
file is created for all source volumes. 

• Creating VM descriptor files (e.g., .VMX, .VMC). 

• Automatic installation of VMware Tools into a target image. The tool schedules 
the installation on the first run; you must power on the VM to finish installing 
VMware Tools. 

• Installation of VMware Tools for ESX Server. It uses the same version for both 
desktop and server VMware platforms, so running on an ESX VM will be 
displayed with an obsolete VMware Tools version. 

• Installation of ESX TSA. The target server must be configured properly before 
use, either by manual installation or by adding the server. 
 

• Writing to ESX or Xen using VA. 

 

95BCLI Tool DLL Package 
The CLI Tool package includes these files and folders: 

Filename Description 

cli.dll Core Command Line Interface DLL 

invsrl.exe Remote Launch Tool 

invsvd.sys Virtual Disk Image Driver 

invsvd_x64.sys Virtual Disk Image Driver (64bit version) 

invVss51.dll VSS support library for Windows XP 

invVss52.dll VSS support library for Windows Server 2003 

invVss60.dll VSS support library for Windows Vista 

ntfsresize.exe NTFS Resize Utility 

vcarcinfo.exe System Information Tool  

vcct.exe Capture Tool 
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vcmt.exe Migration Tool 

winagent.exe Windows TSA 

.\migration support\VMware Folder contains necessary files for migrating to 
VMware platform. Contains the files listed 
below. 

SYMMPI.INF, SYMMPI.SYS LSI Logic SCSI driver  

VMSCSI.INF, VMSCSI.SYS Bus Logic SCSI driver 

vmtls.cab VMware Tools package for desktop VMware 
target platforms.  

 
 

96BCLI Troubleshooting 
When requesting help troubleshooting an issue, it is important to provide log files of the 
CLI Tool and accompanying vConverter tools. By default, CLI Tool writes its own log 
file, if it has been run as a standalone executable; or by the caller executable, if it has 
been used in a .DLL form. In the last case, the log file name of CLI Tool consists of the 
name of the caller application plus a .log extension. This is the best approach for 
requesting support: 

1. Create a temporary folder. 

2. Supply the full path to this folder in /extlogs parameter while running the 
conversion. 

3. After finishing the conversion, save all of the content of this folder to a zip file 
and email it to Vizioncore Support. 

4. Remove the folder. 
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14BTroubleshooting 

This section contains some suggestions for addressing issues that you might encounter 
while using vConverter.  

 

97BServer IP Address Can’t Be Resolved 
If you have not added a DNS entry to correspond to the IP address that you intend to use 
in vConverter, a message will display when you attempt to install an ESX Server.  
 

 
 
 
Set DNS Servers 

1. To set the DNS entry, access Control Panel→Network Connections.  

2. Right-click the LAN you are using and select Properties.  

3. From the list of items that this connection uses, click to highlight IP Protocol 
(TCP/IP) and click Properties. 
 

 
 

4. Confirm that the Use the following DNS server addresses radio button 
is selected.  
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5. Enter the DNS you intend to use in the Preferred DNS server field.  
 

 
 

6. Click OK. 

7. On the Local Area Connection Properties dialog, click Close. 
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98BManually Install a NIC Device to Work with VistaPE 
1. After VistaPE boots, insert the floppy/CD with the network driver. If the driver is 

on the host’s hard disk, skip this step.  

2. Select Start→Device Installer. 
 

 
 

3. Select the ethernet adapter in <Network adapters> or <UNCKNOWN DEVICE> 
group. Click Install. 
 

 
 

4. Click OK. 
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5. Specify path to the driver.  
 

 
 

6. Click Close. 

7. Select Start→PE Network Configurator. 

Note: If this process fails, then you are using a driver that is incompatible with 
VistaPE. See the Drivers section of this Appendix for a list of compatible drivers. 
 
 

 
99BHot Cloning 
During the hot cloning process, no source machine reboot is necessary. Although it is fine 
to allow all necessary applications to run during this process, it is best to close those that 
are unnecessary and to shut down any extra services that are running. You can use the 
service control feature through Advanced Properties→Migration→Service Manager.  
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100BFailed to Get Remote Resources 
This means that the client cannot contact the source. To resolve this, navigate to 
C:\Program Files\Vizioncore\vConverter\Bin\Support and follow these steps: 

1. Open Machines.txt and remove any entries. 

2. Enter the name of the source that is causing the problem. 

3. Run the file called check.vbs (included in this folder as well). 

• This will generate a WMI.log. If your log reads failed to connect this, it is usually 
a result of permissions or DNS issues. 

• From the client, go to a command prompt and try to ping the source system by 
name. Try pinging by IP address. If you have access to the DNS server for the 
domain, be sure that the machine is registered in the correct DNS domain. If you 
do not have access to the DNS server and are still having problems pinging the 
machine, try to ping the fully qualified domain name (FQDN) For example, if the 
machine is named "SEC06" and it is located in a child domain named "DZ", 
trying to ping the machine by its FQDN "SEC06.DZ". If you can ping the FQDN 
and you cannot access your DNS server, try entering the FQDN into your local 
hosts file. To do so, access Start→Run and type: notepad 
%windir%\system32\drivers\etc\hosts). 

• For hosts enter your machine's IP address; click Tab and enter the FQDN; click 
Tab; and enter the machine name (e.g., 10.10.0.11 sec06.dz sec06). Save the file 
and exit notepad. 

• Go back to a command prompt and ping the machine name and the FQDN. You 
will be able to go to vConverter and complete the conversion. 

 
101BFailure to Create Directory 
If you receive an error message indicating a failure to create a directory on the remote 
host, follow the directions in the Change Login Credentials section in Chapter 3. Input 
the correct credentials and then drag the source to the source server hotspot in the 
Conversion Tasks pane.  
 

102BCreate Flat Disk Image 
Enabling the Create Flat Disk Image option (through the Disks tab on the Advanced 
Properties window) can slow down the conversion process. Select this option only if you 
need it—for example, if you intend to resize volumes using the vConverter Wizard. 
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103BTarget VM Unavailable 
If the target VM is not available during a synchronization, the process will be stopped. 
The next synchronization will occur during the next scheduled timeslot. If the target VM 
is powered on between the synchronizations, all file system changes will be lost except 
for the newly added files. These files are no longer on the source, but they do remain on 
the target image.  

 

104BConversion Job Monitoring 
1. After starting a conversion job, the button below will display. Use it to access the 

Conversion Monitor window, which will provide real-time updates on job 
progress. 
 

 
2. Click OK, and then click Monitor in the bottom right corner of the vConverter 

window. 

3. Next, click Log on the Conversion Monitor window. The log includes text that 
describes the error. 
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15BDrivers 

These tables list all of the drivers that are compatible with VistaPE.  
Manufacturer Device
SiS SiS 900-Based PCI Fast Ethernet Adapter 
SiS SiS 900-Based PCI Fast Ethernet Adapter 
SiS SiS 900 PCI Fast Ethernet Adapter 
SiS SiS 900 PCI Fast Ethernet Adapter 
IBM Integrated 10/100 Ethernet Controller 
IBM Integrated 10/100 Ethernet Controller 
IBM IBM 10/100 EtherJet PCI Adapter 
IBM IBM Netfinity 10/100 Ethernet Adapter 
IBM IBM 10/100 EtherJet Integrated LAN with Alert on LAN 
IBM IBM Netfinity 10/100 Ethernet Security Adapter 2 
IBM IBM 10/100 EtherJet PCI Management Adapter 
IBM IBM 10/100 EtherJet PCI Adapter with Alert on LAN 
IBM IBM 10/100 EtherJet Secure Management Adapter 
IBM IBM Netfinity 10/100 Ethernet Security Adapter 
IBM Intel(R) PRO/100 S Network Connection 
IBM IBM 10/100 Dual Port Server Adapter 
IBM Intel(R) PRO/100 VE Desktop Connection 
IBM IBM iSeries 2892 10/100 Ethernet Port 
IBM Intel(R) PRO/100 VE Network Connection 
IBM IBM 10/100 NetFinity Fault ToleraNT Adapter 
IBM IBM iSeries 10/100 adapter 
SONY SiS 900 PCI Fast Ethernet Adapter 
SONY SiS 900 PCI Fast Ethernet Adapter 
Microsoft Microsoft Tun Miniport Adapter 
Microsoft Microsoft ISATAP Adapter 
Microsoft Microsoft 6to4 Adapter 
Microsoft Microsoft Direct Point-to-point Adapater 
Microsoft Microsoft Loopback Adapter 
Microsoft Microsoft(R) USB Adapter MN-110 
Microsoft Microsoft(R) Notebook Adapter MN-120 
Microsoft Microsoft(R) PCI Adapter MN-130 
Microsoft Bluetooth Device (Personal Area Network) 
Microsoft Bluetooth Device (RFCOMM Protocol TDI) 
Microsoft RAS Async Adapter 
Microsoft Infrared Port 
Microsoft Infrared Modem Port 
Microsoft WAN Miniport (L2TP) 
Microsoft WAN Miniport (PPTP) 
Microsoft WAN Miniport (AppleTalk) 
Microsoft WAN Miniport (Network Monitor) 
Microsoft WAN Miniport (IP) 
Microsoft WAN Miniport (IPv6) 
Microsoft WAN Miniport (IPX) 
Microsoft WAN Miniport (NetBEUI, Dial In) 
Microsoft WAN Miniport (NetBEUI, Dial Out) 
Microsoft WAN Miniport (PPPOE) 
Amertek Amertek C110TX PCI Fast Ethernet Adapter 
VIA Technologies, Inc. VIA Rhine III Compatible Management Adapter 
VIA Technologies, Inc. VIA Rhine III Compatible Fast Ethernet Adapter 
VIA Technologies, Inc. VIA Rhine II Compatible Fast Ethernet Adapter 
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Manufacturer Device
VIA Technologies, Inc. VIA VT86C100A Rhine Compatible Fast Ethernet Adapter 
VIA Technologies, Inc. VIA Rhine III Management Adapter 
VIA Technologies, Inc. VIA Rhine III Management Adapter 
VIA Technologies, Inc. VIA Rhine III Fast Ethernet Adapter 
VIA Technologies, Inc. VIA Rhine III Fast Ethernet Adapter 
VIA Technologies, Inc. VIA Rhine II Fast Ethernet Adapter 
VIA Technologies, Inc. VIA Rhine II Fast Ethernet Adapter 
VIA Technologies, Inc. VIA VT86C100A Rhine Fast Ethernet Adapter 
VIA Technologies, Inc. VIA VT86C100A Rhine Fast Ethernet Adapter 
D-Link D-Link DFE-538TX PCI Fast Ethernet Adapter 
D-Link D-Link DFE-530TX+ PCI Fast Ethernet Adapter (rev.F) 
D-Link D-Link DFE-530TX+ PCI Fast Ethernet Adapter (rev.F) 
D-Link D-Link DFE-520TX PCI Fast Ethernet Adapter 
D-Link D-Link DFE-520TX PCI Fast Ethernet Adapter 
D-Link D-Link DFE-530TX PCI Fast Ethernet Adapter (rev.D) 
D-Link D-Link DFE-530TX PCI Fast Ethernet Adapter (rev.D) 
D-Link D-Link DFE-530TX PCI Fast Ethernet Adapter (rev.C) 
D-Link D-Link DFE-530TX PCI Fast Ethernet Adapter (rev.C) 
D-Link D-Link DFE-530TX PCI Fast Ethernet Adapter (rev.B) 
D-Link D-Link DFE-530TX PCI Fast Ethernet Adapter (rev.B) 
D-Link D-Link DFE-530TX PCI Fast Ethernet Adapter (rev.A) 
D-Link D-Link DFE-530TX PCI Fast Ethernet Adapter (rev.A) 
D-Link Intel(R) PRO/100 VE Adapter 
D-Link D-Link DE-530+ PCI Ethernet Adapter 
D-Link D-Link DFE-500TX PCI Fast Ethernet Adapter (Rev B/C) 
D-Link D-Link DFE-500TX PCI Fast Ethernet Adapter (Rev D) 
D-Link D-Link DFE-500TX PCI Fast Ethernet Adapter (Rev E) 
D-Link D-Link DFE-550TX FAST Ethernet 10/100 Adapter 
D-Link D-Link DFE-580TX 4 Port Server Adapter 
D-Link D-Link DL10050 based 10/100 Adapter 
D-Link D-Link DGE-500SX Giga-Ether Adapter 
D-Link D-Link DGE-550SX Gigabit Ethernet Adapter 
D-Link D-Link DGE-550T Gigabit Ethernet Adapter 
D-Link D-Link DL2000-based Gigabit Ethernet Adapter (generic) 
D-Link D-Link DGE-530T Gigabit Ethernet Adapter 
Corega K.K. corega FEther PCI-TXL Ethernet Adapter 
Corega K.K. corega FEther PCI-TXM Ethernet Adapter 
Corega K.K. corega FastEther II PCI-TX Ethernet Adapter 
corega K.K. corega GEther PCI-T32 
corega K.K. corega FEther USB2-TX 
corega K.K. corega FEther USB-TXS 
corega K.K. corega FEtherII PCC-TXD LAN Card 
ELECOM Laneed LD-10/100AWL Fast Ethernet Adapter 
ELECOM Laneed LD-10/100AL PCI Fast Ethernet Adapter (rev.B) 
ELECOM Laneed LD-10/100AL PCI Fast Ethernet Adapter (rev.A) 
Digitalchina/D-Link Digitalchina/D-Link DFE-530TX PCI Fast Ethernet Adapter (rev.B) 
I-O DATA DEVICE, INC. I-O DATA ET100-PCI-S Fast Ethernet Adapter 
PLANEX COMMUNICATIONS 
INC. 

Planex FNW-9702-T Fast Ethernet Adapter 

PLANEX COMMUNICATIONS 
INC. 

Planex FNW-9700-T Fast Ethernet Adapter 

CNet Technology Inc. CNet 10/100 Mbps PCI Wake On LAN Fast Ethernet Adapter 
CNet Technology Inc. CNet 10/100 Mbps PCI Fast Ethernet Adapter 
EDIMAX EDIMAX EN-9150 SERIES PCI Fast Ethernet Adapter 
GIGA-BYTE TECHNOLOGY CO., GN-FE605 Fast Ethernet Adapter 
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Manufacturer Device
LTD 
GIGA-BYTE TECHNOLOGY CO., 
LTD 

GN-FE605M Management Ethernet Adapter 

The Linksys Group Inc. EtherFast 10/100 Managed Network Adapter 
The Linksys Group Inc. EtherFast 10/100 Managed Network Adapter 
Intel Intel(R) PRO/1000 PT Dual Port Network Connection 
Intel Intel(R) PRO/1000 PT Dual Port Server Connection 
Intel Intel(R) PRO/1000 PT Dual Port Server Adapter 
Intel Intel(R) PRO/1000 PF Dual Port Server Adapter 
Intel Intel(R) PRO/1000 PB Dual Port Server Connection 
Intel Intel(R) PRO/1000 PT Server Adapter 
Intel Intel(R) PRO/1000 PT Network Connection 
Intel Intel(R) PRO/1000 PF Server Adapter 
Intel Intel(R) PRO/1000 PF Network Connection 
Intel Intel(R) PRO/1000 PB Server Connection 
Intel Intel(R) PRO/1000 PM Network Connection 
Intel Intel(R) PRO/1000 PL Network Connection 
Intel Intel(R) PRO/1000 EB Network Connection with I/O Acceleration 
Intel Intel(R) PRO/1000 EB Backplane Connection with I/O Acceleration 
Intel Intel(R) 82566MM Gigabit Platform LAN Connect 
Intel Intel(R) 82566DM Gigabit Platform LAN Connect 
Intel Intel(R) 82566DC Gigabit Platform LAN Connect 
Intel Intel(R) 82562V 10/100 Platform LAN Connect 
Intel Intel(R) 82566MC Gigabit Platform LAN Connect 
Intel Intel(R) PRO/1000 PT Desktop Adapter 
Intel Intel(R) PRO/1000 EB1 Network Connection with I/O Acceleration 
Intel Intel(R) PRO/1000 EB1 Backplane Connection with I/O Acceleration 
Intel Intel(R) PRO/1000 PT Quad Port Server Adapter 
Intel Intel(R) PRO/1000 XT Server Adapter 
Intel Intel(R) PRO/1000 XT Desktop Adapter 
Intel iSeries 1000/100/10 Ethernet Adapter 
Intel Intel(R) PRO/1000 XT Network Connection 
Intel Intel(R) PRO/1000 XF Server Adapter 
Intel iSeries Gigabit Ethernet Adapter 
Intel Intel(R) PRO/1000 XF Network Connection 
Intel Intel(R) 82544GC Based Network Connection 
Intel Intel(R) PRO/1000 T Desktop Adapter 
Intel Intel(R) PRO/1000 T Network Connection 
Intel Intel(R) PRO/1000 MT Desktop Adapter 
Intel Intel(R) PRO/1000 MT Network Connection 
Intel Intel(R) PRO/1000 MT Mobile Connection 
Intel Intel(R) PRO/1000 MT Server Adapter 
Intel Intel(R) PRO/1000 MF Server Adapter 
Intel Intel(R) PRO/1000 MF Server Adapter (LX) 
Intel Intel(R) PRO/1000 MT Dual Port Server Adapter 
Intel Intel(R) PRO/1000 MT Dual Port Network Connection 
Intel Intel(R) PRO/1000 MF Dual Port Server Adapter 
Intel Intel(R) PRO/1000 MF Dual Port Network Connection 
Intel Intel(R) PRO/1000 MT Desktop Connection 
Intel Intel(R) PRO/1000 MT Network Adapter 
Intel Intel(R) PRO/1000 CT Network Connection 
Intel Intel(R) PRO/1000 CT Desktop Connection 
Intel Intel(R) PRO/1000 MT Quad Port Server Adapter 
Intel Intel(R) PRO/1000 MT Quad Port Network Connection 
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Manufacturer Device
Intel Intel(R) PRO/1000 MT Server Connection 
Intel Intel(R) PRO/1000 GT Server Adapter 
Intel Intel(R) PRO/1000 MF Server Adapter(LX) 
Intel Intel(R) PRO/1000 MB Server Connection 
Intel Intel(R) PRO/1000 GT Dual Port Server Adapter 
Intel Intel(R) PRO/1000 MB Dual Port Server Connection 
Intel Intel(R) PRO/1000 GT Desktop Adapter 
Intel Intel(R) PRO/1000 P Dual Port Server Adapter 
Intel Intel(R) PRO/1000 GT Quad Port Server Adapter 
Intel Intel 21140-Based PCI Fast Ethernet Adapter (Emulated) 
Intel Intel(R) PRO/100+ PCI Adapter 
Intel Intel(R) PRO/100+ PCI Adapter 
Intel Intel(R) PRO/100+ PCI Adapter 
Intel Intel(R) PRO/100+ Management Adapter 
Intel Intel(R) PRO/100+ Management Adapter 
Intel Intel(R) PRO/100+ Alert On LAN 2* Adapter 
Intel Intel(R) PRO/100+ Management Adapter with Alert On LAN* 
Intel Intel(R) PRO/100 Desktop Adapter 
Intel Intel(R) PRO/100 Desktop Adapter 
Intel Intel(R) PRO/100 S Management Adapter 
Intel Intel(R) PRO/100 S Management Adapter 
Intel Intel(R) PRO/100 S Advanced Management Adapter 
Intel Intel(R) PRO/100+ Management Adapter with Alert On LAN* GC 
Intel Intel(R) PRO/100 S Desktop Adapter 
Intel Intel(R) PRO/100 S Desktop Adapter 
Intel Intel(R) PRO/100+ Server Adapter (PILA8470B) 
Intel Intel(R) PRO/100 S Server Adapter 
Intel Intel(R) PRO/100 S Server Adapter 
Intel Intel(R) PRO/100+ Dual Port Server Adapter 
Intel Intel(R) PRO/100+ Management Adapter with Alert On LAN* G Server 
Intel Intel(R) PRO/100 Server Adapter 
Intel Intel(R) PRO/100 Server Adapter 
Intel Intel(R) 82559 Fast Ethernet LAN on Motherboard 
Intel Intel(R) 82559 Fast Ethernet LAN On Motherboard 
Intel Intel(R) 82559 Fast Ethernet LOM with Basic Alert on LAN* 
Intel Intel(R) 82559 Fast Ethernet LOM with Alert on LAN 2* 
Intel Intel(R) PRO/100 S Network Connection 
Intel Intel(R) PRO/100 S Network Connection 
Intel Intel(R) PRO/100 Network Connection 
Intel Intel(R) PRO/100 Network Connection 
Intel Intel(R) PRO/100 Network Connection 
Intel Intel(R) PRO/100 M Desktop Adapter 
Intel Intel(R) PRO/100 M Desktop Adapter 
Intel Intel(R) PRO/100 Dual Port Server Adapter 
Intel Intel(R) PRO/100 S Dual Port Server Adapter 
Intel Intel(R) PRO/100 S Dual Port Server Adapter 
Intel Intel(R) PRO/100 M Mobile Network Connection 
Intel Intel(R) PRO/100 VE Desktop Adapter 
Intel Intel(R) PRO/100 VM Desktop Adapter 
Intel Intel(R) PRO/100 VM Desktop Adapter 
Intel Intel(R) PRO/100 VE Network Connection 
Intel Intel(R) PRO/100 VE Network Connection 
Intel Intel(R) PRO/100 VM Network Connection 
Intel Intel(R) PRO/100 VM Network Connection 
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Manufacturer Device
Intel Intel(R) PRO/100 P Mobile Combo Adapter 
Intel Intel(R) PRO/100 P Mobile Adapter 
Intel Intel(R) 82562 based Fast Ethernet Connection 
Intel Intel(R) 82562 based Fast Ethernet Connection 
Intel Intel 21040 Based PCI Ethernet Adapter 
Intel Intel 21041 Based PCI Ethernet Adapter 
Intel Intel 21140 Based PCI Fast Ethernet Adapter 
Intel Intel 21143 Based PCI Fast Ethernet Adapter 
Intel 82562EH based Phoneline Desktop Adapter 
Intel Intel(R) PRO/10+ PCI Adapter 
Intel Intel(R) PRO/100B PCI Adapter (TX) 
Intel Intel(R) PRO/100B PCI Adapter (T4) 
Intel Intel(R) PRO/100 WfM PCI Adapter 
Intel Intel 82557-based Integrated Ethernet PCI (10/100) 
Intel 82557-based Integrated Ethernet with Wake on LAN 
Intel Intel 82558-based Integrated Ethernet 
Intel Intel 82558-based Integrated Ethernet with Wake on LAN 
Intel Intel(R) PRO/100+ Server Adapter 
Intel Intel(R) PRO/100 VE Desktop Connection 
Intel iSeries 2892 10/100 Ethernet Port 
Intel Intel(R) PRO/100 S+ Desktop Adapter 
Intel Intel(R) PRO/100 S+ Server Adapter 
Intel Intel(R) 82559 Fast Ethernet LOM with Alert on LAN* 
Intel Intel(R) 82559 Fast Ethernet LOM with Alert on LAN* 2 
Intel Intel(R) PRO/100 S Mobile LAN on Motherboard 
Intel NetServer 10/100TX PCI LAN Adapter 
Intel Intel 8255x-based Fast Ethernet 
Intel Intel(R) PRO/100 M Mobile Connection 
Intel Intel(R) PRO/100 M Network Connection 
Intel Intel(R) 82598EB Multi-Function Network Device 
Intel Intel(R) 10 Gigabit XF SR Dual Port Server Adapter 
Intel Intel(R) 82598EB 10 Gigabit AF Dual Port Network Connection 
Intel Intel(R) 10 Gigabit XF SR Server Adapter 
Intel Intel(R) 82598EB 10 Gigabit AF Network Connection 
Intel Intel(R) 82598EB 10 Gigabit AT CX4 Network Connection 
Intel Intel(R) Advanced Network Services Virtual Adapter 
Hewlett Packard HP NetServer 10/100TX PCI LAN Adapter 
NEC NEC PC-9821X-B06(PCI) or compatible/Intel 82557-based Ethernet 
NEC NEC PK-UG-X006(PCI) or compatible Fast Ethernet Adapter 
NEC NEC 82559-based Fast Ethernet Adapter 
NEC NEC PC-9821NR-B06 
NEC Intel 21143 Based PCI Fast Ethernet Adapter 
Acer ACER NIC-559A PRO/100+ with WOL 
Acer ACER NIC-559A PRO/100+ with Alert On LAN 2* 
Acer ACER T62L158 PRO/100+ with Alert On LAN 2* 
Acer AcerLan ALN-315 
Fujitsu Siemens Fujitsu Siemens Computers 82558-based Onboard Ethernet with WoL 
Fujitsu Siemens Fujitsu Siemens Computers 82559-based Onboard Ethernet with WoL 
Fujitsu Siemens Fujitsu Siemens Computers 82559-based Onboard Ethernet with WoL and AoL 
Fujitsu Siemens Fujitsu Siemens Computers Server Onboard LAN with Intel 82558 
Fujitsu Siemens Fujitsu Siemens Computers Server Onboard LAN with Intel 82559C 
Toshiba Intel 8255x-based PCI Ethernet Adapter (10/100) 
Toshiba Intel(R) PRO/100 VE Network Connection 
Toshiba Toshiba Fast Ethernet PCI LAN Card 
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Manufacturer Device
Toshiba Toshiba Fast Ethernet Cardbus LAN Card 
Fujitsu Intel 8255x-based PCI Ethernet Adapter (10/100) 
Fujitsu Intel(R) PRO/100 VM Network Connection 
Samsung Intel(R) PRO/100 VE Desktop Adapter 
Samsung Intel(R) PRO/100 VE Network Connection 
Trigem Intel(R) PRO/100 VE Network Connection 
Dell Intel 8255x-based PCI Ethernet Adapter (10/100) 
Atheros Communications Inc. Atheros AR5002G Wireless Network Adapter 
Atheros Communications Inc. Atheros AR5002X Wireless Network Adapter 
Atheros Communications Inc. Atheros AR5004G Wireless Network Adapter 
Atheros Communications Inc. Atheros AR5004X Wireless Network Adapter 
Atheros Communications Inc. Atheros AR5005GS Wireless Network Adapter 
Atheros Communications Inc. Atheros AR5005G Wireless Network Adapter 
Atheros Communications Inc. Atheros AR5006XS Wireless Network Adapter 
Atheros Communications Inc. Atheros AR5006X Wireless Network Adapter 
Atheros Communications Inc. Atheros AR5006EXS Wireless Network Adapter 
Atheros Communications Inc. Atheros AR5006EX Wireless Network Adapter 
Atheros Communications Inc. Atheros AR5006EGS Wireless Network Adapter 
Atheros Communications Inc. Atheros AR5006EG Wireless Network Adapter 
Atheros Communications Inc. Atheros AR5006GS Wireless Network Adapter 
Atheros Communications Inc. Atheros AR5006G Wireless Network Adapter 
Atheros Communications Inc. Atheros Wireless Network Adapter 
Atheros Communications Inc. IEEE 802.11a/g Wireless LAN Adapter (A) 
Atheros Communications Inc. Linksys Wireless-G Notebook Adapter 
Atheros Communications Inc. Linksys Wireless A+G Notebook Adapter 
Atheros Communications Inc. Cisco Aironet 802.11a/b/g Wireless Adapter 
Marvell Marvell Yukon 88E8001/8003/8010 PCI Gigabit Ethernet Controller 
Marvell Marvell Yukon 88E8021 PCI-X IPMI Gigabit Ethernet Controller 
Marvell Marvell Yukon 88E8022 PCI-X IPMI Gigabit Ethernet Controller 
Marvell Marvell Yukon 88E8061 PCI-E IPMI Gigabit Ethernet Controller 
Marvell Marvell Yukon 88E8062 PCI-E IPMI Gigabit Ethernet Controller 
Marvell Marvell Yukon 88E8035 PCI-E Fast Ethernet Controller 
Marvell Marvell Yukon 88E8036 PCI-E Fast Ethernet Controller 
Marvell Marvell Yukon 88E8038 PCI-E Fast Ethernet Controller 
Marvell Marvell Yukon 88E8039 PCI-E Fast Ethernet Controller 
Marvell Marvell Yukon 88EC033 PCI-E Fast Ethernet Controller 
Marvell Marvell Yukon 88E8052 PCI-E ASF Gigabit Ethernet Controller 
Marvell Marvell Yukon 88E8050 PCI-E ASF Gigabit Ethernet Controller 
Marvell Marvell Yukon 88E8053 PCI-E Gigabit Ethernet Controller 
Marvell Gigabit ExpressCard Adapter 
Marvell PLANEX GEX-1000T ExpressCard Gigabit LAN Adapter 
Marvell Marvell Yukon 88E8055 PCI-E Gigabit Ethernet Controller 
Marvell Marvell Yukon 88E8056 PCI-E Gigabit Ethernet Controller 
Marvell Marvell Yukon 88EC036 PCI-E Gigabit Ethernet Controller 
Marvell Marvell Yukon 88EC042 PCI-E Gigabit Ethernet Controller 
Marvell SysKonnect SK-9871 V2.0 Gigabit Ethernet 1000Base-ZX Adapter, PCI64, Fiber 

ZX/SC 
Marvell SysKonnect SK-9861 V2.0 Gigabit Ethernet 1000Base-SX Adapter, PCI64, Fiber 

SX/VF-45 
Marvell SysKonnect SK-9851 V2.0 Gigabit Ethernet 1000Base-SX Adapter, PCI64, Fiber 

SX/MTRJ 
Marvell SysKonnect SK-9843 V2.0 Gigabit Ethernet 1000Base-SX Adapter, PCI64, Fiber 

SX/SC 
Marvell SysKonnect SK-9841 V2.0 Gigabit Ethernet 1000Base-LX Adapter, PCI64, Fiber 

LX/SC 
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Manufacturer Device
Marvell SysKonnect SK-9821 V2.0 Gigabit Ethernet 10/100/1000Base-T Adapter, PCI64, 

Copper RJ-45 
Marvell SysKonnect SK-9521 V2.0 10/100/1000Base-T Adapter, PCI, Copper RJ-45 
Marvell SysKonnect Marvell RDK-8012 10/100/1000Base-T Adapter, PCI, Copper RJ-45 
Marvell SysKonnect Marvell RDK-8011 10/100/1000Base-T Adapter, PCI, Copper RJ-45 
Marvell SysKonnect Marvell RDK-8009 10/100/1000Base-T Adapter, PCI, Copper RJ-45 
Marvell SysKonnect Marvell RDK-8008 10/100/1000Base-T Adapter, PCI, Copper RJ-45 
Marvell SysKonnect Marvell RDK-8007 10/100/1000Base-T Adapter, PCI, Copper RJ-45 
Marvell SysKonnect Marvell RDK-8006 10/100/1000Base-T Adapter, PCI, Copper RJ-45 
Marvell SysKonnect Marvell RDK-8004 10/100/1000Base-T Adapter, PCI, Copper RJ-45 
Marvell SysKonnect Marvell RDK-8003 10/100/1000Base-T Adapter, PCI, Copper RJ-45 
Marvell SysKonnect Marvell RDK-8002 10/100/1000Base-T Adapter, PCI, Copper RJ-45 
Marvell SysKonnect Marvell RDK-8001 10/100/1000Base-T Adapter, PCI, Copper RJ-45 
Marvell SysKonnect SK-9C21 10/100/1000Base-T Adapter, ExpressCard 
Marvell SysKonnect SK-9E21D 10/100/1000Base-T Adapter,PCI-Express, Copper RJ-45 
Marvell SysKonnect SK-9E21 10/100/1000Base-T Server Adapter, PCI-Express, Copper RJ-

45 
Marvell SysKonnect SK-9E22 10/100/1000Base-T Dual Port Server Adapter, PCI-Express, 2 

Copper RJ-45 
Marvell SysKonnect SK-9E81 1000Base-SX Server Adapter,PCI-Express, Fiber SX/LC 
Marvell SysKonnect SK-9E82 1000Base-SX Dual Port Server Adapter, PCI-Express, 2 Fiber 

SX/LC 
Marvell SysKonnect SK-9E91 1000Base-LX Server Adapter,PCI-Express, Fiber LX/LC 
Marvell SysKonnect SK-9E92 1000Base-LX Dual Port Server Adapter, PCI-Express, 2 Fiber 

LX/LC 
Marvell SysKonnect SK-9I22 10/100/1000 Base-T Dual Port Express Module 
Marvell SysKonnect SK-9S21 10/100/1000Base-T Server Adapter, PCI-X, Copper RJ-45 
Marvell SysKonnect SK-9S22 10/100/1000Base-T Dual Port Server Adapter, PCI-X, 2 

Copper RJ-45 
Marvell SysKonnect SK-9S81 1000Base-SX Server Adapter,PCI-X, Fiber SX/LC 
Marvell SysKonnect SK-9S82 1000Base-SX Dual Port Server Adapter, PCI-X, 2 Fiber SX/LC 
Marvell SysKonnect SK-9S91 1000Base-LX Server Adapter,PCI-X, Fiber LX/LC 
Marvell SysKonnect SK-9S92 1000Base-LX Dual Port Server Adapter, PCI-X, 2 Fiber LX/LC 
Marvell SysKonnect SK-9P22 10/100/1000 Base-T Dual Port PMC card 
Marvell TPMC-GBE-CO 
Marvell SysKonnect SK-9P82 1000 Base-SX Dual Port PMC card 
Marvell TPMC-GBE-FI 
Marvell Generic Marvell Yukon Chipset based Ethernet Controller 
NVIDIA NVIDIA nForce Networking Controller 
Realtek Semiconductor Corp. Realtek RTL8139/810x Family Fast Ethernet NIC 
Realtek Semiconductor Corp. Realtek RTL8139/810x Family Fast Ethernet NIC 
Realtek Semiconductor Corp. Realtek RTL8139/810x Family Fast Ethernet NIC 
Realtek Semiconductor Corp. Realtek RTL8139/810x Family Fast Ethernet NIC 
Realtek Semiconductor Corp. Realtek RTL8139C+ Fast Ethernet NIC 
Realtek Semiconductor Corp. Realtek RTL8139C+ Fast Ethernet NIC 
Realtek Semiconductor Corp. Realtek RTL8139C+ Fast Ethernet NIC 
Realtek Semiconductor Corp. (MOBILE ASSIST)Realtek RTL8139/810x Family Fast Ethernet NIC 
Realtek Semiconductor Corp. (MOBILE ASSIST)Realtek RTL8139/810x Family Fast Ethernet NIC 
Realtek Semiconductor Corp. NETGEAR FA311v2 PCI Adapter 
Realtek Semiconductor Corp. D-Link DFE-690TXD CardBus Card 
Realtek Semiconductor Corp. D-Link DFE-538TX 10/100 Adapter 
Realtek Semiconductor Corp. D-Link DFE-530TX+ PCI Adapter 
Realtek Semiconductor Corp. D-Link DFE-528TX PCI Adapter 
Realtek Semiconductor Corp. Realtek RTL8102E Family PCI-E Fast Ethernet NIC 
Realtek Semiconductor Corp. Realtek RTL8168/8111 PCI-E Gigabit Ethernet NIC 
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Realtek Semiconductor Corp. Realtek RTL8168C(P)/8111C(P) PCI-E Gigabit Ethernet NIC 
Realtek Semiconductor Corp. Realtek RTL8169/8110 Family Gigabit Ethernet NIC 
Realtek Semiconductor Corp. Realtek RTL8169/8110 Family Gigabit Ethernet NIC 
Broadcom 3Com Dual Port 1000-SX PCI-X Server NIC 
Broadcom 3Com Dual Port 10/100/1000 PCI-X Server NIC 
Broadcom 3Com Quad Port 10/100/1000 PCI-X Server NIC 
Broadcom Broadcom NetXtreme Gigabit Ethernet 
Broadcom Broadcom NetXtreme Gigabit Ethernet 
Broadcom Broadcom NetXtreme Gigabit Fiber 
Broadcom Broadcom NetXtreme Gigabit Fiber 
Broadcom Broadcom 570x 10/100 Integrated Controller 
Broadcom Broadcom NetXtreme FE-A 
Broadcom Broadcom NetXtreme FE-B 
Broadcom Broadcom NetXtreme 57xx Gigabit Controller 
Broadcom Broadcom NetXtreme Fast Ethernet 
Broadcom Embedded Broadcom NetXtreme 5721 PCI-E Gigabit NIC 
Broadcom Broadcom NetLink (TM) Gigabit Ethernet 
Broadcom Broadcom NetLink (TM) Fast Ethernet 
Broadcom Broadcom 570x Gigabit Integrated Controller 
Broadcom Broadcom 440x 10/100 Integrated Controller 
Broadcom Broadcom 440x 10/100 Integrated Controller 
Broadcom ASUSTeK/Broadcom 440x 10/100 Integrated Controller 
Broadcom ASUSTeK/Broadcom 440x 10/100 Integrated Controller 
Broadcom MSI/Broadcom 440x 10/100 Integrated Controller 
Broadcom MSI/Broadcom 440x 10/100 Integrated Controller 
Broadcom Broadcom 802.11g Network Adapter 
Broadcom Broadcom 802.11a Network Adapter 
Broadcom Broadcom 802.11 Multiband Network Adapter 
Broadcom Broadcom 802.11n Network Adapter 
Broadcom U.S. Robotics Wireless 802.11g PC Card Adapter 
Broadcom U.S. Robotics Wireless 802.11g PCI Adapter 
Broadcom USRobotics Wireless Nd1 PC Card (Default) 
Broadcom USRobotics Wireless Nd1 PCI Adapter (Default) 
Broadcom Linksys Wireless-G Notebook Adapter with SpeedBooster 
Broadcom Linksys Wireless-G Notebook Adapter WPC54G V3 
Broadcom Linksys Wireless-N Notebook Adapter WPC300N 
Broadcom RangeMax Next Wireless Notebook Adapter 
Broadcom RangeMax Next Wireless PCI Adapter 
Broadcom Microsoft Wireless Notebook Adapter MN-720 
Broadcom Microsoft Wireless Notebook Adapter MN-730 
Realtek Realtek RTL8169/8110 Family PCI Gigabit Ethernet NIC (NDIS 6.0) 
Realtek Realtek RTL8168/8111 Family PCI-E Gigabit Ethernet NIC (NDIS 6.0) 
Realtek Realtek RTL8101 Family PCI-E Fast Ethernet NIC (NDIS 6.0) 
Realtek Realtek RTL8029 PCI Ethernet NIC 
Realtek Realtek RTL8150 USB 10/100 Fast Ethernet Adapter 
VIA Networking Technologies 
Inc 

VIA Networking Velocity Family Gigabit Ethernet Adapter 

ULi Electronics Inc. ULi M526X Ethernet Controller 
ULi Electronics Inc. ULi PCI Fast Ethernet Controller 
3Com 3Com EtherLink 10/100 PCI For Complete PC Management NIC (3C905C-TX) 
3Com 3Com 10/100 Mini PCI Ethernet Adapter 
3Com 3Com EtherLink 10/100 PCI Combo NIC (3C905B-COMBO) 
3Com 3Com EtherLink 100 PCI Fiber NIC (3C905B-FX) 
3Com 3Com EtherLink 10/100 PCI TX NIC (3C905B-TX) 
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3Com 3Com EtherLink PCI Fiber NIC (3C900B-FL) 
3Com 3Com EtherLink PCI TPO NIC (3C900B-TPO) 
3Com 3Com EtherLink PCI Combo NIC (3C900B-COMBO) 
3Com 3Com EtherLink PCI TPC NIC (3C900B-TPC) 
3Com 3Com 3C920B-EMB Integrated Fast Ethernet Controller 
3Com 3Com 3C920B-EMB-WNM Integrated Fast Ethernet Controller 
3Com 3Com 3C920 Integrated Fast Ethernet Controller (3C905C-TX Compatible) 
3Com 3Com 3C918 Integrated Fast Ethernet Controller (3C905B-TX Compatible) 
3Com 3Com EtherLink 10/100 PCI NIC (3C905-TX) 
3Com 3Com EtherLink 10/100 PCI T4 NIC (3C905-T4) 
3Com 3Com EtherLink PCI TPO NIC (3C900-TPO) 
3Com 3Com EtherLink PCI Combo  NIC (3C900-COMBO) 
3Com 3Com Gigabit Ethernet Server NIC (SX/TX) 
3Com IBM eServer iSeries Gigabit Ethernet Adapter 
3Com 3Com Gigabit LOM (3C940) 
3Com 3Com Gigabit NIC (3C2000) 
3Com 3Com Gigabit NIC 
3Com 3Com 10/100 PCI NIC w/3XP (3CR990-TX-95) 
3Com 3Com 10/100 PCI NIC w/3XP (3CR990-TX-97) 
3Com 3Com 10/100 Secure NIC (3CR990B-97) 
3Com 3Com 100 Secure Fiber NIC (3CR990B-FX-97) 
3Com 3Com 10/100 Secure Server NIC (3CR990B-97) 
3Com 3Com 100 Secure Fiber NIC (3CR990-FX-97) 
3Com 3Com 10/100 PCI Server NIC w/3XP (3CR990SVR95) 
3Com 3Com 10/100 PCI Server NIC w/3XP (3CR990SVR97) 
3Com 3Com 3C2000-T Gigabit Adapter 
3Com 3Com 3C940 Gigabit LOM Ethernet Adapter 
3Com Corporation. 3Com 3C910 Integrated Fast Ethernet Controller (3CSOHO100B-TX Compatible) 
3Com Corporation. 3Com OfficeConnect 10/100 Network Interface Card (3CSOHO100B-TX) 
Accton Accton EN1207D Series PCI Fast Ethernet Adapter 
Accton Integrated 10/100 Ethernet Adapter 
Accton Accton EN2242A Series Mini-PCI Fast Ethernet Adapter 
Accton Accton EN1208 PCI Ethernet Adapter 
Accton Accton EN2212 PCMCIA Ethernet Adapter 
Accton Accton EN2216/2316 PCMCIA Ethernet Adapter 
Accton Accton Cheetah PCI Fast Ethernet Adapter 
Accton Accton EN1207-TX PCI Fast Ethernet Adapter 
Accton Accton Cardbus Fast Ethernet Adapter 
Accton Accton EN1207F Series PCI Fast Ethernet Adapter 
Accton Accton EN1207F Series PCI Fast Ethernet Adapter 
Accton Accton LM1247 Series PCI Fast Ethernet Adapter 
Accton Accton LM1247 Series PCI Fast Ethernet Adapter 
Accton Accton LM2247 Series Mini-PCI Fast Ethernet Adapter 
Accton Accton LM2247 Series Mini-PCI Fast Ethernet Adapter 
Accton Accton LM2247(A) Series Mini-PCI Fast Ethernet Adapter 
Accton Accton LM2247(A) Series Mini-PCI Fast Ethernet Adapter 
Accton Accton EN2220A Fast Ethernet Cardbus PC Card 
Accton Accton EN2220A Fast Ethernet Cardbus PC Card 
Accton Accton EN2242 Series MiniPCI Fast Ethernet Adapter 
Accton Accton EN2242 Series MiniPCI Fast Ethernet Adapter 
Accton Accton EN2320 Fast Ethernet Cardbus PC Card 
Accton Accton EN2320 Fast Ethernet Cardbus PC Card 
Accton Accton CheetahPower Enhanced 10/100 Adapter AC-EN3207 
Accton Technology Corp. Accton EN1407T Giga-bit Ethernet Adapter 
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Accton Technology Corp. Accton EN1408T Giga-bit Ethernet Adapter 
ASIX ASIX AX88772 USB2.0 to Fast Ethernet Adapter 
ASIX ASIX AX88178 USB2.0 to Gigabit Ethernet Adapter 
ASIX ASIX AX88180 PCI Giga Ethernet Adapter(V3) 
ASIX ASIX AX88180 PCI Giga Ethernet Adapter(PLX) 
Addtron Addtron AEF-380TXD PCI Fast Ethernet Adapter 
Allied Telesyn Allied Telesyn AT-2800Tx Fast Ethernet Adapter 
Cabletron Cabletron DE500A PCI Fast Ethernet Adapter 
Cabletron Cabletron DE500B PCI Fast Ethernet Adapter 
Compex Compex FreedomLINE PCI Fast Ethernet Adapter 
Eagle by Microdyne Eagle by Microdyne PCI Fast EtherMAX 
Kingston Kingston EtheRx KNE100TX PCI Fast Ethernet Adapter 
Linksys Linksys EtherFast 10/100 CardBus PC Card (PCMPC200) 
Linksys Linksys EG1032 v2 Instant Gigabit Network Adapter 
Linksys Linksys HomeLink 10M Integrated PC Card 
Linksys Linksys Phoneline 10M Network Card 
Linksys Linksys USB 2.0 10/100 Adapter 
NCR NCR 21140 PCI Fast Ethernet Adapter 
Netgear NETGEAR FA310TX Fast Ethernet Adapter (DC21x4) 
Netgear Netgear 10/100Mbps CardBus Mobile Adapter 
Netgear Lite-On Communications Compatable PCI Fast Ethernet Adapter 
Netgear NETGEAR FA310TX Fast Ethernet Adapter (NGRPCI) 
NETGEAR NETGEAR FA330/FA331 PCI Adapter 
NETGEAR NETGEAR FA410TX Fast Ethernet PC Card 
NETGEAR NETGEAR FA411 PCMCIA Mobile Adapter 
NETGEAR NETGEAR GA302T Gigabit Adapter 
Netgear NETGEAR GA620 Gigabit Ethernet Card 
Netgear NETGEAR GA620T 10/100/1000 Ethernet Card 
NETGEAR NETGEAR GA621 Gigabit Fiber Adapter 
NETGEAR NETGEAR FA311/312 PCI Adapter 
Netgear NETGEAR GA311 Gigabit Adapter 
NETGEAR NETGEAR GA311 Gigabit Adapter 
Racore Racore Cardbus Fast Ethernet Adapter 
SMC SMC Extreme Cardbus Fast Ethernet Adapter 
SMC SMC9332BDT EtherPower 10/100 
SMC SMC9332BVT EtherPower T4 10/100 
SMC SMC9334BDT EtherPower 10/100 (one port) 
SMC SMC EZ CardBus 10/100 Fast Ethernet Adapter (SMC8034) 
SMC SMC EZ Card 10/100 (SMC1255TX) 
SMC SMC EZ CardBus-II 10/100 PC Card (SMC8034) 
SMC SMC EZ CardBus-II 10/100 PC Card (SMC8036) 
SMC SMC Compact USB to Ethernet converter 
SMC EZ Connect USB/Ethernet Series Converter 
SMC EZ Connect USB to Dual Speed Ethernet Converter 
SMC SMC EZ Card 10/100 (SMC1244TX V2) 
SMC SMC EZ Card 1000 (SMC9452TX V.2) 
SMC SMC 10/100 PC Card 
SMC SMC EZ Card 10/100 PCI (SMC1211 Series) 
SMC SMC 10/100 PC Card (SMC8041 V.2) 
SMC SMC EZ CardBus-II 10/100 PC Card 
TDK TDK Netflyer Cardbus Fast Ethernet Adapter 
CHEETAH CHEETAH ETHERCARD EN2228 
ASIX Electronics ASIX AX88140 Based PCI Fast Ethernet Adapter 
ASIX Electronics ASIX AX8814X Based PCI Fast Ethernet Adapter 
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ASIX Electronics CNet PRO110 PCI Fast Ethernet Adapter 
ASIX Electronics ASIX AX88190 Based PCMCIA Fast Ethernet Adapter 
ASIX Electronics ASIX AX88796B Based ISA Ethernet Adapter 
PCMCIA Technology Inc. PCMCIA 10/100 Ethernet Card 
PCMCIA Technology Inc. PCMCIA 10Mbps Ethernet Card 
  %MTD800.DeviceDesc% 
  100/10M Ethernet PCI Adapter 
  %MTD891.DeviceDesc% 
Sundance Sundance ST201 based PCI Fast Ethernet Adapter 
ADMtek Incorporated ADMtek AN983 based ethernet adapter 
ADMtek Incorporated ADMtek AN983 10/100Mbps PCI Adapter 
ADMtek Incorporated ADMtek ADM9510 10/100Mbps Fast Ethernet Adapter 
ADMtek Incorporated ADMtek AN985 10/100Mbps Fast Ethernet Adapter 
ADMtek Incorporated ADMtek ADM9511 10/100Mbps Fast Ethernet Adapter 
ADMtek Incorporated ADMtek ADM9513 10/100Mbps Fast Ethernet Adapter 
ADMtek Incorporated ADMtek AN986 USB To Fast Ethernet Adapter 
ADMtek Incorporated ADMtek ADM8511 USB To Fast Ethernet Adapter 
ADMtek Incorporated ADMtek ADM8513 USB To Fast Ethernet Adapter 
ADMtek Incorporated ADMtek AN986 USB 10/100 MAC 
AmbiCom AmbiCom EZPort Fast Ethernet CardBus PC Card(CB100-EZ) 
Conceptronic Conceptronic CONSP100TU USB 10/100 Adapter 
D-Link Corporation. D-Link DGE-500T Gigabit Adapter 
Hewlett-Packard Company HP NC3120 Fast Ethernet NIC 
Hewlett-Packard Company HP NC3161 Fast Ethernet NIC 
Hewlett-Packard Company HP NC3160 Fast Ethernet NIC 
Hewlett-Packard Company HP NC3122 Fast Ethernet NIC 
Hewlett-Packard Company HP NC3131 Fast Ethernet NIC 
Hewlett-Packard Company HP NC3132 Fast Ethernet Module 
Hewlett-Packard Company HP NC3133 Fast Ethernet Module 
Hewlett-Packard Company HP NC3163 Fast Ethernet NIC 
Hewlett-Packard Company HP NC3162 Fast Ethernet NIC 
Hewlett-Packard Company HP NC3123 Fast Ethernet NIC 
Hewlett-Packard Company HP NC3134 Fast Ethernet NIC 
Hewlett-Packard Company HP NC3135 Fast Ethernet Upgrade Module 
Altima Altima 1000 Gigabit Ethernet  (Copper) 
Altima Altima 1001 Gigabit Ethernet  (IntegratedCopper) 
Altima Altima 1002 Gigabit Ethernet  (IntegratedCopper) 
Altima Altima 1003 Gigabit Ethernet  (IntegratedCopper) 
Altima Altima 1000 Gigabit Ethernet  (Fibre) 
Atheros Atheros L1 Gigabit Ethernet 10/100/1000Base-T Controller 
Atheros Atheros L2 Fast Ethernet 10/100 Base-T Controller 
Atheros Atheros L2 Fast Ethernet 10/100 Base-T Controller 
Atheros Atheros L2 Fast Ethernet 10/100Base-T Controller 
Nobrand Nobrand PCI 10/100/1000 Gigabit Ethernet Adapter, PCI 32bit, Copper RJ-45 
AMD Inc. AMD PCNET Family Ethernet Adapter (PCI) 
Allied Allied Telesyn AT-2700TX PCI 10/100 Ethernet Adapter 
Allied Allied Telesyn AT-2700FX PCI 100Mb Ethernet Adapter 
Allied Allied Telesyn AT-2450v3 PCI Ethernet Adapter 
HP HP Ethernet with LAN remote power adapter 
Belkin Belkin Gigabit Desktop Card 
Belkin F5D5000, PCI Card/Desktop Network PCI Card 
IC Plus Corp. IC Plus IP100 10/100 Fast Ethernet Adapter 
IC Plus Corp. IC Plus IP1000 Family Gigabit Ethernet Adapter 
Advanced Micro Devices (AMD) AMD PCnet-Home Based Adapter 
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Diamond Multimedia Diamond Multimedia Home Network Adapter 
D-Link Corp. D-Link DFE-690TXD CardBus PC Card 
D-Link Corp. D-Link DGE-528T Gigabit Ethernet Adapter 
Linksys Group Inc. Linksys EG1032/EG1064 Instant Gigabit Network Adapter 
LinkSys Group Inc. Linksys LNE100TX(v5) Fast Ethernet Adapter 
MELCO INC. BUFFALO LGY-PCI-TXC Fast Ethernet Adapter 
MXIC Macronix MX987xx Family Fast Ethernet Adapter 
MXIC Macronix MX987xx Family Fast Ethernet Adapter (ACPI) 
MXIC Macronix MX987xx Family Fast Ethernet Adapter (CardBus) 
D-Link Corporation D-Link DUB-E100 USB 2.0 Fast Ethernet Adapter 
D-Link Corporation D-Link DFE-530TX+ PCI Adapter 
DAVICOM Semiconductor, Inc. DAVICOM 10/100 Low Power PCI Fast Ethernet Adapter  
DAVICOM Semiconductor, Inc. DAVICOM Fiber PCI Fast Ethernet Adapter             
DAVICOM Semiconductor, Inc. DAVICOM Fiber/TP PCI Fast Ethernet Adapter          
DAVICOM Semiconductor, Inc. 10/100 PCI Ethernet Adapter                         
DAVICOM Semiconductor, Inc. DAVICOM 9009 PCI Fast Ethernet Adapter              
DAVICOM Semiconductor, Inc. DAVICOM DM-9102A PCI Fast Ethernet Adapter  
DAVICOM Semiconductor, Inc. DAVICOM 9102/A PCI Fast Ethernet Adapter  
DAVICOM Semiconductor, Inc. DAVICOM 1/10/100 PCI Fast Ethernet Adapter  
DAVICOM Semiconductor, Inc. DAVICOM LongRun/10/100 PCI Fast Ethernet Adapter  
DAVICOM Semiconductor, Inc. DAVICOM PCI HomeRun Adapter  
DAVICOM Semiconductor, Inc. DAVICOM PCI LongRun Adapter  
DAVICOM Semiconductor, Inc. DAVICOM 9102A Half Based Switching Adapter  
DAVICOM Semiconductor, Inc. DAVICOM 9102A Full Based Switching Adapter  
DAVICOM Semiconductor, Inc. DAVICOM 10 Base-T PCI Ethernet Adapter  
DAVICOM Semiconductor, Inc. 10/100 PCI Fast Ethernet Based Adapter  
DAVICOM Semiconductor, Inc. DM9601 USB To Fast Ethernet Adapter 
Madge Smart MK4 PCI Adapter 
Madge Madge Smart 100/16/4 PCI-HS Ringnode 
Madge Madge Smart 16/4 PCI Ringnode Mk3 
Madge Madge Presto PCI 2000 
Madge Madge Presto PCI Plus 
Madge Madge Presto PCI 
Madge Smart 16/4 CardBus Mk2 
Madge Madge 16/4 CardBus Adapter 
Madge Smart 16/4 PCMCIA MK2 
Madge Madge Smart 16/4 PCMCIA Ringnode 
Madge Madge Smart 16/4 PCI Ringnode Mk2 
Olicom Olicom RapidFire 3540 HSTR 100/16/4 PCI Adapter 
Olicom Olicom RapidFire 3139 Token-Ring 16/4 PCI Adapter 
Olicom RapidFire 3140 16/4 TR PCI Adapter 
Olicom RapidFire 3140V2 16/4 TR PCI Adapter 
Olicom RapidFire 3141 16/4 TR PCI Fiber Adapter 
Olicom Olicom Token-Ring PCI/II 16/4 Adapter (OC-3137) 
Olicom Olicom GoCard 3250 Token-Ring 16/4 CardBus PC Card 
Olicom GoCard Token-Ring C30 PC Card 
CNet Technology, Inc.  CNet PRO200WL PCI Fast Ethernet Adapter            
CNet Technology, Inc.  CNet PRO200 PCI Fast Ethernet Adapter            
Archtek Telecom Co.    10/100 Mbps PCI Ethernet Adapter 
NETGEAR Incorporated NETGEAR FA101 USB Fast Ethernet Adapter 
NETGEAR Incorporated NETGEAR FA120 USB 2.0 Fast Ethernet Adapter 
Network Everywhere Network Everywhere Fast Ethernet Adapter(NC100) 
Network Everywhere Network Everywhere Fast Ethernet Adapter(NC100 v2) 
Network Everywhere %AN985.DeviceDesc% 
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Network Everywhere PCI 10/100 Fast Ethernet Adapter(DEC21140) 
Network Everywhere PCI 10/100 Fast Ethernet Adapter(DEC21143) 
PC Card Series Products PCMCIA Fast Ethernet Card 
PC Card Series Products PCMCIA Ethernet Card 
CardBus CardBus Fast Ethernet 10/100 Adapter 
CardBus CardBus Fast Ethernet PC Card Adapter manual load 
CardBus Fast Ethernet CardBus PC Card 
CARDBUSs CardBus 10/100 Fast Ethernet PC Card 
CARDBUSs CardBus Fast Ethernet Attached Port PC Card 
CARDBUSs U.S. Robotics Cardbus 10/100 Ethernet PC Card 
SMC Networks SMC EZ Networking Compact 10/100 USB 2.0 Adapter 
National Datacomm 
Corporation 

NDC ND5100 Ethernet PC Card 

smartBridges smartNIC HOT-SYNC(tm) Network Adapter 
smartBridges smartNIC2 PnP Network Adapter 
SURECOM Technology Corp. SURECOM EP-320G-TX 10/100/1000M Gigabit Ethernet Copper PCI Adapter 
SURECOM Technology Corp. SURECOM EtherPerfect-427 Lan Card 
SURECOM Technology Corp. SURECOM EP-427X 100/10M PCMCIA Adapter 
SURECOM Technology Corp. SURECOM EP-427X 16bit 100/10M Couplerless PCMCIA Adapter 
SURECOM Technology Corp. SURECOM EP-428X 32-bit 100/10M CardBus PC Card 
SURECOM Technology Corp. SURECOM EP-428X 32-bit 100/10M CardBus PC Card 
SURECOM Technology Corp. SURECOM EP-325 PCI Ethernet Adapter 
SURECOM Technology Corp. SURECOM EP-320X-R 100/10M PCI Adapter 
SURECOM Technology Corp. %MTD800.DeviceDesc% 
SURECOM Technology Corp. SURECOM EP-320X-S 100/10M Ethernet PCI Adapter 
SURECOM Technology Corp. %MTD891.DeviceDesc% 
SURECOM EP-320G-TX1/TXL SURECOM 32bit PCI Gigabit Ethernet Adapter 
SURECOM SURECOM EP-312 ISA PnP Ethernet Adapter 
Surecom SURECOM EP-9321-g/g1 802.11g 54M WLAN PCI Adapter 
Surecom SURECOM EP-9428-g 802.11g 54M WLAN CardBus Adapter 
TRENDware Corp. TEG-PCBUSR Gigabit PC Card 
Silicon Integrated Systems 
Corp. 

SiS191 1000/100/10 Ethernet Device 

Silicon Integrated Systems 
Corp. 

SiS190 100/10 Ethernet Device 

Silicon Integrated Systems 
Corp. 

SiS191 100/10 Ethernet Device 

Silicon Integrated Systems 
Corp. 

SiS191 Ethernet Device 

SMC Networks, Inc. SMC EZ Card 10/100 (SMC1255TX) 
SMC Networks, Inc. SMC EZ Card 10/100 (SMC1255TX-PF) 
U.S. ROBOTICS CORPORATION U.S. Robotics 10/100 PCI NIC TX 
U.S. ROBOTICS CORPORATION U.S. Robotics 10/100 PCI NIC TX 
National Semiconductor Corp. National Semiconductor Corp. DP83815/816 10/100 MacPhyter PCI Adapter 
National Semiconductor Corp. SOHOware NSA100 10/100 PCI Network Adapter 
National Semiconductor Corp. EDIMAX EN-9140 10/100 Fast Ethernet NIC Family 
National Semiconductor Corp. CNPower200WL 10/100Mbps PCI Fast Ethernet Wake-On-LAN Adapter 
National Semiconductor Corp. CNPower200 10/100Mbps PCI Fast Ethernet Adapter 
National Semiconductor Corp. National Semiconductor DP83820 Copper Gigabit Adapter 
National Semiconductor Corp. National Semiconductor DP83820 Fiber Gigabit Adapter 
National Semiconductor Corp. Accton EN1407T Giga-bit Ethernet Adapter 
National Semiconductor Corp. Accton EN1408T Giga-bit Ethernet Adapter 
Xircom Xircom CardBus Ethernet 10/100 
Xircom Xircom CardBus Ethernet II 10/100 
Xircom Xircom CardBus Ethernet 100 + Modem 56 (Ethernet Interface) 
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Xircom Xircom RealPort2 CardBus Ethernet 10/100 
Xircom Xircom RealPort2 CardBus Ethernet 10/100+Modem 56 (Ethernet Interface) 
Xircom Xircom CardBus Ethernet 10/100 Adapter manual load 
Xircom Network of Xircom CreditCard Ethernet 10/100 + Modem 56 
SMC Networks, Inc SMC TigerCard 1000 
U.S. Robotics U.S. Robotics 10/100 PCMCIA NIC TX 
U.S. Robotics U.S. Robotics 10/100/1000 PCI NIC 
ZyXEL Communications Corp Prestige USB Adapter 
PCI Ethernet Adapter 
Manufacturer 

PCI Ethernet Adapter 

VIA Networking Technologies, 
Inc. 

VIA Networking Velocity-Family Giga-bit Ethernet Adapter 

Realtek Semiconductor Corp Realtek 8180 Extensible 802.11b Wireless Device 
Realtek Semiconductor Corp Realtek 8185 Extensible Wireless Device 
Realtek Semiconductor Corp Realtek 8185 Extensible 802.11b/g Wireless Device 
Realtek Semiconductor Corp Realtek 8185 Extensible 802.11a/b/g Wireless Device 
 
 
 

Manufacturer Device
Adaptec Adaptec ASC-48300 SAS/SATA Host Adapter 
Adaptec Adaptec ASC-48300 SAS Host Adapter 
Adaptec Adaptec AIC-9410w SAS Controller 
Adaptec Adaptec AIC-9410w SAS/SATA Controller 
Adaptec Adaptec AIC-9405 SAS/SATA Controller 
Adaptec Adaptec ASC-44300 SAS/SATA Controller 
Adaptec Adaptec ASC-58300 SAS/SATA Controller 
Adaptec Adaptec AIC-7899 Ultra160 PCI SCSI Card 
Adaptec Adaptec SCSI Card 39160 - Ultra160 SCSI (Generic) 
Adaptec Adaptec AIC-7892 Ultra160 PCI SCSI Card 
Adaptec Adaptec SCSI Card 29160 - Ultra160 SCSI (Generic) 
Adaptec Adaptec SCSI Card 19160 - Ultra160 SCSI (Generic) 
Adaptec Adaptec SCSI Card 39160 - Ultra160 SCSI 
Adaptec Compaq 64-bit/66MHz Dual Channel Wide Ultra3 SCSI Adapter 
Adaptec Adaptec SCSI Card 29160 - Ultra160 SCSI 
Adaptec Compaq 64-bit/66MHz Wide Ultra3 SCSI Adapter 
Adaptec Adaptec SCSI Card 29160N - Ultra160 SCSI 
Adaptec Adaptec SCSI Card 29160LP - Ultra160 SCSI 
Adaptec Adaptec SCSI Card 19160 - Ultra160 SCSI 
Adaptec Adaptec 2915/2930LP PCI SCSI Controller 
Adaptec Adaptec Serial ATA HostRAID  
Adaptec Adaptec SCSI RAID 2200S Controller 
Adaptec Adaptec SCSI RAID 2120S Controller 
Adaptec Adaptec SCSI RAID 2020ZCR Controller 
Adaptec Adaptec SATA RAID 2020SA Controller 
Adaptec Adaptec SCSI RAID 2025ZCR Controller 
Adaptec Adaptec SATA RAID 2025SA Controller 
Adaptec Adaptec SATA RAID 2410SA Controller 
Adaptec Adaptec SATA RAID 2810SA Controller 
Adaptec Adaptec SATA RAID 21610SA Controller 
Adaptec Adaptec SCSI RAID 2230S Controller 
Adaptec Adaptec SCSI RAID 2130S Controller 
Adaptec Adaptec SATA RAID 2610SA Controller 
Adaptec ICP SCSI RAID ICP9024R0 Controller 
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Manufacturer Device
Adaptec ICP SCSI RAID ICP9014R0 Controller 
Adaptec Adaptec AIC-7870 PCI SCSI Controller (Emulated) 
Adaptec Adaptec 39320-based Ultra320 SCSI 
Adaptec Adaptec 29320-based Ultra320 SCSI 
Adaptec Adaptec AIC-7902B - Ultra320 SCSI 
Adaptec Adaptec AIC-7901-based Ultra320 SCSI 
Adaptec Adaptec AIC-7902-based Ultra320 SCSI 
Adaptec Adaptec AIC-7901 - Ultra320 SCSI 
Adaptec Adaptec SCSI Card 29320A - Ultra320 SCSI 
Adaptec Adaptec SCSI Card 29320LP - Ultra320 SCSI 
Adaptec Adaptec SCSI Card 39320 - Ultra320 SCSI 
Adaptec Adaptec SCSI Card 39320A - Ultra320 SCSI 
Adaptec Adaptec SCSI Card 29320ALP - Ultra320 SCSI 
Adaptec IBM ServeRAID 8i Controller 
Adaptec Adaptec SAS RAID 4800SAS Controller 
Adaptec Adaptec SAS RAID 4805SAS Controller 
Adaptec ICP SAS RAID ICP9085LI Controller 
Adaptec ICP SAS RAID ICP5085BR Controller 
Adaptec Adaptec SATA RAID AAR-2420SA Controller 
Adaptec Adaptec SATA RAID AAR-2620SA Controller 
Adaptec Adaptec SATA RAID AAR-2820SA Controller 
Adaptec ICP SATA RAID ICP9047MA Controller 
Adaptec ICP SATA RAID ICP9067MA Controller 
Adaptec ICP SATA RAID ICP9087MA Controller 
Adaptec IBM ServeRAID 8k/8k-l Controller 
Adaptec IBM ServeRAID 8s Controller 
Adaptec Adaptec SAS RAID 4000SAS Controller 
Adaptec Adaptec SAS RAID 3800SAS Controller 
Adaptec ICP SAS RAID ICP5445AU Controller 
Adaptec Adaptec SAS RAID 1800SAS Controller 
Adaptec Adaptec SAS RAID 3805SAS Controller 
Adaptec ICP SAS RAID ICP5085AU Controller 
Adaptec Adaptec SAS RAID 2400SAS Controller 
Adaptec ICP SAS RAID ICP5045AL Controller 
Adaptec Adaptec SAS RAID 3400SAS Controller 
Adaptec ICP SAS RAID ICP5045AU Controller 
Promise Technology Windows Promise SATAII150 TX2plus (tm) IDE Controller 
Promise Technology Windows Promise SATAII150 TX4 (tm) IDE Controller 
Promise Technology Windows Promise SATA300 TX2plus (tm) IDE Controller 
Promise Technology Windows Promise SATA300 TX4 (tm) IDE Controller 
Promise Technology Promise SATA Console SCSI Processor 
Promise Technology Windows Promise SATA150 TX2plus (tm) IDE Controller 
Promise Technology Windows Promise SATA150 TX4 (tm) IDE Controller 
Promise Technology %Promise_Sata_ControllerDesc% 
ULi Electronics Inc. ULi SATA/RAID Controller (M1573) 
ULi Electronics Inc. ULi SATA II/RAID Controller (M1575/M1697) 
DELL DELL PERC 5/E Adapter RAID Controller 
DELL DELL PERC 5/i Adapter RAID Controller 
DELL DELL PERC 5/i Integrated RAID Controller 
DELL DELL PERC 6/E Adapter RAID Controller 
DELL DELL PERC 6/i Adapter RAID Controller 
DELL DELL PERC 6/i Integrated RAID Controller 
DELL DELL CERC 6/i Adapter RAID Controller 
DELL DELL CERC 6/i Integrated RAID Controller 
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DELL DELL PERC 3/QC RAID Controller 
DELL DELL PERC 3/DC & PERC 3/DCL RAID Controller 
DELL DELL PERC 3/SC RAID Controller 
DELL DELL PERC 4/Di RAID Controller 
DELL DELL PERC 4/DC RAID Controller 
DELL DELL PERC 4/SC RAID Controller 
DELL DELL CERC ATA100/4ch RAID Controller 
DELL DELL PERC 4e/Si RAID Controller 
DELL DELL PERC 4e/Di RAID Controller 
DELL DELL PERC 4e/DC RAID Controller 
Dell Dell SAS 5/E Adapter 
Dell Dell SAS 5/i Adapter 
Dell Dell SAS 5/i Integrated 
Dell Dell SAS 5/iR Integrated D/C 
Dell Dell SAS 5/iR Integrated Emb 
Dell Dell SAS 5/iR Adapter 
Dell Dell SAS 6/iR Adapter 
Dell Dell SAS 6/iR Integrated 
Dell Dell SAS 6/i Integrated 
Dell Dell PERC 4/im RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SAS 8408E RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SAS 8480E RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SAS 8344ELP RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SAS 8308ELP RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SATA 300-8ELP RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SATA 300-4ELP RAID Controller 
LSI Logic Corp.,  LSI Logic MegaRAID SATA 300-12E  RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SAS 84016E RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SAS 8300XLP RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SAS 8888ELP RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SAS 8708ELP RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SAS 8884E RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SAS 8708E RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SATA 350-8ELP RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SATA 350-4ELP RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SAS PCI ExpressT ROMB 
LSI Logic Corp., Intel(R) RAID Controller SRCSAS18E 
LSI Logic Corp., Intel(R) RAID Controller SRCSAS144E 
LSI Logic Corp., Intel(R) RAID Controller SROMBSAS18E 
LSI Logic Corp., Integrated Intel(R) RAID Controller SROMBSAS28E 
LSI Logic Corp., MegaRAID SCSI 320-0X RAID Controller 
LSI Logic Corp., MegaRAID SCSI 320-0X RAID Controller 
LSI Logic Corp., MegaRAID SCSI 320-2E RAID Controller 
LSI Logic Corp., MegaRAID SCSI 320-2E RAID Controller 
LSI Logic Corp., MegaRAID SCSI 320-0 RAID Controller 
LSI Logic Corp., MegaRAID SCSI 320-0 RAID Controller 
LSI Logic Corp., MegaRAID SCSI 320-2 RAID Controller 
LSI Logic Corp., MegaRAID SCSI 320-2 RAID Controller 
LSI Logic Corp., MegaRAID SCSI 320-1 RAID Controller 
LSI Logic Corp., MegaRAID SCSI 320-1 RAID Controller 
LSI Logic Corp., MegaRAID SCSI 320-4X RAID Controller 
LSI Logic Corp., MegaRAID SCSI 320-4X RAID Controller 
LSI Logic Corp., MegaRAID SCSI 320-2X RAID Controller 
LSI Logic Corp., MegaRAID SCSI 320-2X RAID Controller 
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LSI Logic Corp., MegaRAID SATA 150-6 RAID Controller 
LSI Logic Corp., MegaRAID SATA 150-4 RAID Controller 
LSI Logic Corp., MegaRAID SATA 300-8X RAID Controller 
LSI Logic Corp., MegaRAID SATA 300-8XLP RAID Controller 
LSI Logic Corp., MegaRAID PCI Express(TM) ROMB 
LSI Logic Corp., LSI Logic MegaRAID Enterprise 1200 RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID RAID Controller RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID Enterprise 1300 RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID Enterprise 1400 RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID Express 200 RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID Enterprise 1500 RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID Enterprise 1600 RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID Express 300 RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID Elite 1600 RAID Controller 
LSI Logic Corp., MegaRAID SCSI 320-1E RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID Express 000 RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID Express 500/500LC RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID Enterprise 3000 RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID Elite 1650/1700 RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID Enterprise 1700 RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID i4 IDE RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID i4133 RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SATA 150-6 RAID Controller 
LSI Logic Corp., LSI Logic MegaRAID SATA 150-4 RAID Controller 
IBM LSI Logic MegaRAID SAS PCI ExpressT ROMB 
IBM IBM SystemX MegaRAID SAS 8808E RAID Controller 
IBM IBM SystemX MegaRAID SAS 8884E RAID Controller 
Integrated Technology Express, Inc. ITE IT8212 ATA RAID Controller 
LSI Logic LSI Logic 8600SP PCI SCSI Adapter; 53C860 Device 
LSI Logic LSI Logic 8951U, 8952U PCI SCSI Adapter; 53C895 Device 
LSI Logic LSI Logic 875XS|D, 2280X PCI SCSI Adapter; 53C875, 53C876 Device 
LSI Logic LSI Adapter, SAS 3000 series, 4-port with 1064 
LSI Logic LSI Adapter, SAS 3000 series, 8-port with 1068 
LSI Logic LSI Adapter, SAS 3000 series, 8-port with 1068E 
LSI Logic LSI Adapter, SAS 3000 series, 4-port with 1064E 
LSI Logic LSI Adapter, SAS RAID-on-Chip, 8-port with 1078 
LSI Logic LSI Adapter, Ultra320 SCSI 2000 series, w/1020/1030 
LSI Logic LSI Adapter, Ultra320 SCSI RAID series, w/1035 
LSI Logic LSI Logic Ultra160 PCI SCSI Adapter; 53C1010-33 Device 
LSI Logic LSI Logic Ultra160 PCI SCSI Adapter; 53C1010-66 Device 
LSI Logic LSI Adapter, 2Gb FC, models 44929, G2 with 929 
LSI Logic LSI Adapter, 2Gb FC, models 40919 with 919 
LSI Logic LSI Adapter, 2Gb FC, models 7202,7402 with 929X 
LSI Logic LSI Adapter, 2Gb FC, models 7102 with 919X 
LSI Logic LSI Adapter, 4Gb FC, models 7104,7204,7404 with 949X 
LSI Logic LSI Adapter, 4Gb FC, models 7104,7204,7404 with 949E 
LSI Logic LSI Logic 22910, 21002 PCI SCSI Adapter; 53C896 Device 
LSI Logic LSI Logic 8953U PCI SCSI Adapter; 53C895A Device 
Intel(R) Corporation Intel(R) RAID Controller SRCU42X 
Intel(R) Corporation Intel(R) RAID Controller SRCU42E 
Intel(R) Corporation Intel (R) RAID Controller SRCS16 
Intel(R) Corporation Intel(R) RAID Controller SRCU41L 
Intel(R) Corporation Intel(R) RAID Controller SRCZCRX 
Intel(R) Corporation Intel(R) RAID Controller SRCS28X 
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Intel(R) Corporation Intel(R) RAID Controller SROMBU42E 
VIA Technologies, Inc. VIA VT8251 AHCI RAID Controller 
VIA Technologies, Inc. VIA VT8237 RAID Controller 
VIA Technologies, Inc. VIA VT8237A RAID Controller 
Hewlett-Packard Company Smart Array 5300 Controller 
Hewlett-Packard Company Smart Array 5i 
Hewlett-Packard Company Smart Array 532 Controller 
Hewlett-Packard Company Smart Array 5312 Controller 
Hewlett-Packard Company Smart Array 6i 
Hewlett-Packard Company Smart Array 641 Controller 
Hewlett-Packard Company Smart Array 642 Controller 
Hewlett-Packard Company Smart Array 6400 Controller 
Hewlett-Packard Company Smart Array 6400 U320 EM Controller 
Hewlett-Packard Company Smart Array P600 Controller 
Hewlett-Packard Company Smart Array Controller 
Hewlett-Packard Company Smart Array P400 Controller 
Hewlett-Packard Company Smart Array P800 Controller 
Hewlett-Packard Company Smart Array P400i Controller 
Hewlett-Packard Company Smart Array E200 Controller 
Hewlett-Packard Company Smart Array E200i Controller 
Intel Intel(R) 82801HEM SATA RAID Controller 
Intel Intel(R) 82801HR/HH/HO SATA RAID Controller 
Intel Intel(R) 82801GHM SATA RAID Controller 
Intel Intel(R) 631xESB/632xESB SATA RAID Controller 
Intel Intel(R) 82801GR/GH SATA RAID Controller 
Intel Intel(R) 82801FR SATA RAID Controller 
Intel I2O StorPort Miniport 
Emulex Emulex LPX000 Fibre Channel Storport Driver 
Silicon Integrated Systems Corp SiS 180 RAID Controller 
Silicon Integrated Systems Corp SiS 965/966 182/1182 RAID Controller 
Silicon Integrated Systems Corp. SiS Storport AHCI Controller 
ITE Tech, Inc. ITE IT8211 ATA/ATAPI Controller 
QLogic QLogic Fibre Channel Adapter 
QLogic QLogic iSCSI Adapter 
Broadcom Corporation Broadcom NetXtreme II C-NIC iSCSI Adapter 
Mylex Mylex AcceleRAID 170 Disk Array Controller 
Mylex Mylex AcceleRAID 352 Disk Array Controller 
Mylex Mylex DAC1164P Disk Array Controller 
Mylex Mylex DAC960PG/PJ/PR/PT/PTL1/PRL Series Disk Array Controller 
Mylex Mylex eXtremeRAID 2000 Disk Array Controller 
Mylex Mylex eXtremeRAID 3000 Disk Array Controller 
Mylex Mylex AcceleRAID 160 Disk Array Controller 
LSI Logic Corporation. LSI MegaRAID IDE 100/MAGNIA Z3x0 Controller 
LSI Logic Corporation. Integrated Ultra ATA-100 Dual Channel Controller 
LSI Logic Corporation. Integrated Ultra ATA-100 IDE RAID Controller 
LSI Logic Corporation. LSI Logic MegaRAID IDE 100 Driver For MAGNIA Z500 
LSI Logic Corporation. LSI MegaRAID IDE 133 Controller 
LSI Logic Corporation. LSI MegaRAID Serial ATA Controller 
LSI Logic Corporation. LSI Logic CSB-6 IDE 100 RAID Controller 
LSI Logic Corporation. Intel Embedded Server RAID Technology 
Hewlett Packard HP NetRAID-3Si 
Hewlett Packard Integrated HP NetRAID 
Hewlett Packard HP NetRAID-1Si 
Hewlett Packard HP NetRAID-1M RAID Controller 
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Hewlett Packard HP NetRAID-2M RAID Controller 
Microsoft Microsoft iSCSI Initiator 
ICP vortex ICP RAID Controller 
ICP vortex RAID Controller 
IBM Corporation IBM ServeRAID 4M Controller 
IBM Corporation IBM ServeRAID 4L Controller 
IBM Corporation IBM ServeRAID 5i Controller 
IBM Corporation IBM ServeRAID 4Mx Controller 
IBM Corporation IBM ServeRAID 4Lx Controller 
IBM Corporation IBM ServeRAID 6M Controller 
IBM Corporation IBM ServeRAID 6i Controller 
IBM Corporation IBM ServeRAID 7k Controller 
NVIDIA Corporation NVIDIA nForce4 IntelR Edition Serial ATA Controller 
NVIDIA Corporation NVIDIA nForce4 Serial ATA Controller 
NVIDIA Corporation NVIDIA nForce 430/410 Serial ATA Controller 
NVIDIA Corporation NVIDIA nForce 590/570/550 Serial ATA Controller 
NVIDIA Corporation NVIDIA MCP61 Serial ATA Controller 
NVIDIA Corporation NVIDIA nForce(tm) RAID Class Device 
NVIDIA Corporation NVIDIA nForce(tm) RAID Class Controller 
 
 

Manufacturer Device
(Standard IDE ATA/ATAPI controllers) PCMCIA IDE/ATAPI Controller 
(Standard IDE ATA/ATAPI controllers) IDE Channel 
(Standard IDE ATA/ATAPI controllers) Standard Dual Channel PCI IDE Controller 
I-O DATA DEVICE,INC. CBIDE2-LM DuoATA Card (16Bit Mode) 
ULi Electronics Inc. ULi PCI IDE Controller 
ULi Electronics Inc. ULi M5229 PCI Bus Master IDE Controller 
Appian Technology Appian PCI IDE Controller 
CMD Technology CMD PCI-0640 PCI to IDE Controller 
CMD Technology CMD PCI-0646 Bus Master PCI to IDE Controller 
CMD Technology CMD PCI-0648 Ultra DMA IDE Controller 
CMD Technology CMD PCI-0649 Ultra DMA IDE Controller 
CMD Technology CMD PCI-0646U2 Ultra DMA IDE Controller 
Compaq Compaq PCI IDE Controller 
Intel Intel(R) 82092AA PCI IDE Controller 
Intel Intel(R) 82371FB PCI Bus Master IDE Controller 
Intel Intel(R) 82371SB PCI Bus Master IDE Controller 
Intel Intel(R) 82371AB/EB PCI Bus Master IDE Controller 
Intel Intel(R) 82801AA Bus Master IDE Controller 
Intel Intel(R) 82801AB Bus Master IDE Controller 
Intel Intel(R) 82801BAM Ultra ATA Storage Controller - 244A 
Intel Intel(R) 82801BA Ultra ATA Storage Controller - 244B 
Intel Intel(R) 82801CAM Ultra ATA Storage Controller-248A 
Intel Intel(R) 82801CA Ultra ATA Storage Controller-248B 
Intel Intel(R) 82801DBM Ultra ATA Storage Controller - 24C1 
Intel Intel(R) 82801DBM Ultra ATA Storage Controller - 24CA 
Intel Intel(R) 82801DB Ultra ATA Storage Controller-24CB 
Intel Intel(R) 82801EB Ultra ATA Storage Controllers - 24D1 
Intel Intel(R) 82801EB Ultra ATA Storage Controllers - 24DB 
Intel Intel(R) 6300ESB Ultra ATA Storage Controller - 25A2 
Intel Intel(R) 6300ESB Ultra ATA Storage/SATA Controller - 25A3 
Intel Intel(R) 82801FB Ultra ATA Storage Controllers - 2651 
Intel Intel(R) 82801FB Ultra ATA Storage Controllers - 2652 
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Intel Intel(R) 82801FBM Ultra ATA Storage Controllers - 2653 
Intel Intel(R) 82801FB/FBM Ultra ATA Storage Controllers - 266F 
Intel Intel(R) 82440MX Bus Master IDE Controller 
Intel Intel(R) IA64 Bus Master IDE Controller 
Intel Intel(R) 82801GB/GR/GH (ICH7 Family) Serial ATA Storage Controller - 

27C0 
Intel Intel(R) 82801GBM/GHM (ICH7-M Family) Serial ATA Storage Controller - 

27C4 
Intel Intel(R) 82801G (ICH7 Family) Ultra ATA Storage Controllers - 27DF 
Intel Intel(R) ICH8 4 port Serial ATA Storage Controller - 2820 
Intel Intel(R) ICH8 2 port Serial ATA Storage Controller - 2825 
Intel Intel(R) ICH8M 3 port Serial ATA Storage Controller - 2828 
Intel Intel(R) ICH8M Ultra ATA Storage Controllers - 2850 
PC Technology PC Tech PCI IDE Single or Dual Port Controller 
Silicon Integrated System SiS PCI IDE Controller 
Symphony Labs Symphony PCI IDE Controller 
VIA Technologies, Inc. VIA Bus Master IDE Controller - 0571 
VIA Technologies, Inc. VIA Serial ATA Controller - 3149 
VIA Technologies, Inc. VIA Serial ATA Controller - 3349 
VIA Technologies, Inc. VIA Serial ATA Controller - 5287 
VIA Technologies, Inc. VIA Serial ATA Controller - 0581 
VIA Technologies, Inc. VIA Bus Master IDE Controller - 5324 
VIA Technologies, Inc. VIA Serial ATA Controller - 0591 
VIA Technologies, Inc. VIA Serial ATA Controller - 5337 
VIA Technologies, Inc. VIA Bus Master IDE Controller - 3164 
IBM IBM Microdrive 
Lexar Microsystems Lexar Media Digital Film Card 
SONY Sony Memory Stick 
Standard Microsystems Corp SMSC SLC90E66 PCI Bus Master IDE Controller 
Micron Micron ATA Flash Card 
ServerWorks OSB4 IDE Controller 
ServerWorks CSB5 IDE Controller 
Advanced Micro Devices AMD-756 PCI Bus Master IDE Controller 
Advanced Micro Devices AMD-766 PCI Bus Master IDE Controller 
Advanced Micro Devices AMD-768 PCI Bus Master IDE Controller 
Advanced Micro Devices AMD-8111 PCI Bus Master IDE Controller 
NVIDIA NVIDIA nForce3 250 Serial ATA Controller 
NVIDIA NVIDIA nForce3 250 Parallel ATA Controller 
Standard AHCI 1.0 Serial ATA 
Controller 

Standard AHCI 1.0 Serial ATA Controller 
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16BError Messages 

105BErrors during Installation and Configuration 
 

• This displays when you install a new version of the software over a previous 
version.  
 

 
 

• When you are configuring on the Conversion tab of the Program Preferences 
dialog, this message can display after you select Enable vzBoost and click Install.  
 

 
 

• If you do not populate the Name field on the Task Profile Properties dialog, a 
message displays. 
 

 
 

• After installation is complete, this message might display.  
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• When you click Yes, this message displays.  
 

 
 

• After installation is complete, this message displays to indicate that licensing must 
be activated. If you click Activate, the Activation Wizard opens.  
 

 
 

• This message might display when you click the Install button on the ESX Server 
tab of the Program Preferences dialog. This can occur when insufficient or invalid 
information is entered on the fields of the tab.  
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• This message might display when you enter inconsistent passwords for root and 
then click the Install button on the ESX Server tab of the Program Preferences 
dialog. 
 

 
 

• If you have not confirmed that a DNS entry exists for the IP address that you plan 
to configure through the ESX Server tab on the Program Preferences dialog, this 
message will display. See the Troubleshooting section of the Appendix for 
instructions on entering DNS information.  
 

 
 

• If the Server name or IP field on the Configure SMTP Preferences dialog is blank, 
a message will display when you click the Test Server Connection button.  
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• If the value in the Server name or IP field on the Configure SMTP Preferences 
dialog is invalid, a message will display when you click the Test Server 
Connection button. 
 

 
 

• If the value in the Server name or IP field on the Configure SMTP Preferences 
dialog is valid but unresponsive, a message will display when you click the Test 
Server Connection button.  
 

 
 

• If any of the values in the Server name or IP, Server Port, or Email Address fields 
on the Configure SMTP Preferences dialog are invalid, a message will display 
when you click OK. 
 

 
 

• On the Conversion Tasks pane, if you attempt to save a task without entering a 
target folder, this message will display. 
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• If you click Cancel on the Conversion Tasks pane while you are creating a task, 
this message displays. 
 

 
 

• When you are creating a task using the Create Conversion Task command, you 
populate the fields on the Conversion Tasks pane. If you enter a local path in the 
Target Folder field, this message displays.  
 

 
 

• These messages can display during installation. 
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106BErrors during Activation 
• If you attempt to reuse a serial number that has been used for license activation 

previously, an error message will display.  
 

 

 
107BErrors Adding a Source Server 

• If you enter invalid credentials, you will receive this message. 
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• If the credentials entered do not have logon access to the server, you will receive 
this message.  
 

 
 

• If you right-click a server in the Network Browser pane and select Add to Source, 
this message might display.  
 
 

 
  

108BErrors during Conversion 
• When files that are required for conversion are missing from the source server, 

this message can display. 
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• If you are using the Conversion Wizard to configure a job and you click the 
Cancel button at any point in the process, this message displays.  
 

 
 

• These messages can display at any time during conversion. 
 

 
 

 
 

• If you right-click a server in the Network Browser pane and select Create 
Conversion Task, this message can display. 
 

 
 

• This message can display when you click the Start Conversion icon on the 
Conversion Tasks pane: 
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• When you click Browse on Conversion Tasks pane, this message can display.  
 

 
 

• In All Systems view, when you right-click a server and select Create Conversion 
this error message can display.  
 

 
 

• When you save a conversion job, this message might display.  
 

 
 

• If you try to exit vConverter before you complete the new task creation process, a 
message will display. 
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• If you right-click a server in the Systems to Convert view and select Quick 
Convert, a message will display if you have not created and saved a conversion 
task on which to base the job.  
 

 
 

• If you right-click a server in the Systems to Convert view and select Create 
Conversion Task, a message will display if you have not set a default task profile 
through Tools→Preferences→Task Profiles. 
 

 
 

• This message can display if a server connection is unreliable. 
 

 
 

• This message can display when you click the ESX Server tab when not 
configuring that type of server. 
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• This message can display at any time during the conversion process. 

 

 
 

 


